LICENSE AGREEMENT

IAD Solutions and any applicable sublicensors grant to you a limited, personal, non-exclusive, non-transferable license to use the server software programs and related documentation in this package (collectively referred to as the “Software”) on licensed client processing unit(s). Any attempted sublicense, assignment, rental, sale or other transfer of the Software or the rights or obligations of this Agreement without the prior written consent of IAD Solutions shall be void. The license granted herein will automatically terminate without notice to you if you fail to comply with its terms.

The Software is copyrighted. You may make copies of the software programs only for backup and archival purposes. Unauthorized copying, reverse engineering (except to the extent applicable laws specifically prohibit such restriction), decompiling, disassembling, and creating derivative works of the Software are prohibited. You may print and make copies of the documentation for your use and archival purposes only. Unauthorized printing, copying, and creating derivative works of the documentation are prohibited. Title to the Software is not transferred to you by this license. Ownership and title to the Software and to the actual contents of this package, including the copy of the Software and the media on which it is stored and the associated documentation are retained by IAD Solutions.

LIMITED WARRANTY: LIMITATION OF LIABILITY

IAD Solutions does not warrant that the Software will be free from error or will meet your specific requirements. IAD Solutions disclaims all complete responsibility for decisions made or actions taken based on information obtained using the Software. Any statements made concerning the utility of the Software are not to be construed as unexpressed or implied warranties. Subject to the conditions and limitations on liability stated herein, IAD Solutions warrants for a period of thirty (30) days from the delivery of the first copy of each type of Software, as so delivered, will materially conform to IAD Solutions's then current documentation for such Software. This warranty covers only problems reported to IAD Solutions during the warranty period.

Any violation of IAD Solutions's warranty is your exclusive remedy. IAD Solutions's liability is limited to the repair or replacement of the Software. IAD Solutions is not responsible or liable for any damage to your hardware or software caused by the use of the Software. IAD Solutions shall have no liability for delays or failures beyond its reasonable control.

IAD Solutions does not warrant that the Software will be free from error or will meet your specific requirements. IAD Solutions disclaims all complete responsibility for decisions made or actions taken based on information obtained using the Software. Any statements made concerning the utility of the Software are not to be construed as unexpressed or implied warranties. Subject to the conditions and limitations on liability stated herein, IAD Solutions warrants for a period of thirty (30) days from the delivery of the first copy of each type of Software, as so delivered, will materially conform to IAD Solutions's then current documentation for such Software. This warranty covers only problems reported to IAD Solutions during the warranty period.

Any violation of IAD Solutions's warranty is your exclusive remedy. IAD Solutions's liability is limited to the repair or replacement of the Software. IAD Solutions is not responsible or liable for any damage to your hardware or software caused by the use of the Software. IAD Solutions shall have no liability for delays or failures beyond its reasonable control.

IAD Solutions does not warrant that the Software will be free from error or will meet your specific requirements. IAD Solutions disclaims all complete responsibility for decisions made or actions taken based on information obtained using the Software. Any statements made concerning the utility of the Software are not to be construed as unexpressed or implied warranties. Subject to the conditions and limitations on liability stated herein, IAD Solutions warrants for a period of thirty (30) days from the delivery of the first copy of each type of Software, as so delivered, will materially conform to IAD Solutions's then current documentation for such Software. This warranty covers only problems reported to IAD Solutions during the warranty period.

Any violation of IAD Solutions's warranty is your exclusive remedy. IAD Solutions's liability is limited to the repair or replacement of the Software. IAD Solutions is not responsible or liable for any damage to your hardware or software caused by the use of the Software. IAD Solutions shall have no liability for delays or failures beyond its reasonable control.

IAD Solutions does not warrant that the Software will be free from error or will meet your specific requirements. IAD Solutions disclaims all complete responsibility for decisions made or actions taken based on information obtained using the Software. Any statements made concerning the utility of the Software are not to be construed as unexpressed or implied warranties. Subject to the conditions and limitations on liability stated herein, IAD Solutions warrants for a period of thirty (30) days from the delivery of the first copy of each type of Software, as so delivered, will materially conform to IAD Solutions's then current documentation for such Software. This warranty covers only problems reported to IAD Solutions during the warranty period.

Any violation of IAD Solutions's warranty is your exclusive remedy. IAD Solutions's liability is limited to the repair or replacement of the Software. IAD Solutions is not responsible or liable for any damage to your hardware or software caused by the use of the Software. IAD Solutions shall have no liability for delays or failures beyond its reasonable control.

IAD Solutions does not warrant that the Software will be free from error or will meet your specific requirements. IAD Solutions disclaims all complete responsibility for decisions made or actions taken based on information obtained using the Software. Any statements made concerning the utility of the Software are not to be construed as unexpressed or implied warranties. Subject to the conditions and limitations on liability stated herein, IAD Solutions warrants for a period of thirty (30) days from the delivery of the first copy of each type of Software, as so delivered, will materially conform to IAD Solutions's then current documentation for such Software. This warranty covers only problems reported to IAD Solutions during the warranty period.

Any violation of IAD Solutions's warranty is your exclusive remedy. IAD Solutions's liability is limited to the repair or replacement of the Software. IAD Solutions is not responsible or liable for any damage to your hardware or software caused by the use of the Software. IAD Solutions shall have no liability for delays or failures beyond its reasonable control.

IAD Solutions does not warrant that the Software will be free from error or will meet your specific requirements. IAD Solutions disclaims all complete responsibility for decisions made or actions taken based on information obtained using the Software. Any statements made concerning the utility of the Software are not to be construed as unexpressed or implied warranties. Subject to the conditions and limitations on liability stated herein, IAD Solutions warrants for a period of thirty (30) days from the delivery of the first copy of each type of Software, as so delivered, will materially conform to IAD Solutions's then current documentation for such Software. This warranty covers only problems reported to IAD Solutions during the warranty period.

Any violation of IAD Solutions's warranty is your exclusive remedy. IAD Solutions's liability is limited to the repair or replacement of the Software. IAD Solutions is not responsible or liable for any damage to your hardware or software caused by the use of the Software. IAD Solutions shall have no liability for delays or failures beyond its reasonable control.

IAD Solutions does not warrant that the Software will be free from error or will meet your specific requirements. IAD Solutions disclaims all complete responsibility for decisions made or actions taken based on information obtained using the Software. Any statements made concerning the utility of the Software are not to be construed as unexpressed or implied warranties. Subject to the conditions and limitations on liability stated herein, IAD Solutions warrants for a period of thirty (30) days from the delivery of the first copy of each type of Software, as so delivered, will materially conform to IAD Solutions's then current documentation for such Software. This warranty covers only problems reported to IAD Solutions during the warranty period.

Any violation of IAD Solutions's warranty is your exclusive remedy. IAD Solutions's liability is limited to the repair or replacement of the Software. IAD Solutions is not responsible or liable for any damage to your hardware or software caused by the use of the Software. IAD Solutions shall have no liability for delays or failures beyond its reasonable control.

IAD Solutions does not warrant that the Software will be free from error or will meet your specific requirements. IAD Solutions disclaims all complete responsibility for decisions made or actions taken based on information obtained using the Software. Any statements made concerning the utility of the Software are not to be construed as unexpressed or implied warranties. Subject to the conditions and limitations on liability stated herein, IAD Solutions warrants for a period of thirty (30) days from the delivery of the first copy of each type of Software, as so delivered, will materially conform to IAD Solutions's then current documentation for such Software. This warranty covers only problems reported to IAD Solutions during the warranty period.

Any violation of IAD Solutions's warranty is your exclusive remedy. IAD Solutions's liability is limited to the repair or replacement of the Software. IAD Solutions is not responsible or liable for any damage to your hardware or software caused by the use of the Software. IAD Solutions shall have no liability for delays or failures beyond its reasonable control.
Contents

Section 1: Audit Leverage Overview

1. Audit Leverage Overview .................................................. 15
   Overview of Functionality ................................................. 15
   Architecture ..................................................................... 16
   Synchronization .................................................................. 18
   Audit Leverage Field Types ............................................ 19

2. Starting Audit Leverage ....................................................... 21
   Logging In ......................................................................... 21
   Database and Modem Detection ....................................... 23
     Active Modem Detected .................................................. 23
     No Modem Detected ....................................................... 25
     No Master Network Database Detected ....................... 26
   Synchronizing .................................................................. 27
   Choosing a Database ........................................................ 29
   The Main Audit Leverage Screen ...................................... 29

3. The Sign-Offs Tab and Record-Level Security ..................... 31
   Sign-Offs ........................................................................ 31
   Sign-Off Options and Effects ......................................... 33
   Sign-Off Rules .................................................................. 34
   Differences in High Security Mode ................................. 34

Section 2: Module A: Risk Assessment and Annual Audit Planning

4. Module A Overview ............................................................ 39

5. Planning Your Audit Universe ............................................. 41
   Defining Entities ................................................................ 42
   Defining Entities in Audit Leverage ................................ 43
   Reporting and Data Analysis Considerations .................. 46
   Establishing Your Department’s Conventions .................. 46

6. Setting Up a Risk Assessment ............................................. 49
   Risk Assessment Overview .............................................. 49
   Defining Risk Assessment Information ......................... 50
      Entity Types ................................................................. 51
### Section 3: Module B: Project Management and Timekeeping

#### 9. Module B Overview .................................................. 95
10. Planning Projects and Budgets ................................. 97
   Defining Projects and Budgets .................................. 98
   Defining Projects and Budgets in Audit Leverage ............. 100
      Projects .................................................. 100
      Budgets ................................................. 101
   Project and Program Sign-Offs ................................ 103
   Engagement Letters ........................................... 104
   Reporting and Data Analysis Considerations ................... 105
   Establishing Your Department’s Conventions ................... 106

11. Creating An Audit Project .................................... 109
   The Project Set-up Screen ...................................... 110
      Entering Information in the Tabs ............................ 112
   The Main Tab ............................................... 112
      Creating An Engagement Letter ............................. 116
   The Staffing Tab ............................................. 120
   The Sign-Offs Tab ............................................ 122
   The Program Set-up Tab ....................................... 124
      The Program Tab .......................................... 125
      The Details Tab .......................................... 129
      The Sign-Offs Tab ......................................... 131
   The Milestones Tab ............................................ 133
   The Background Tab ........................................... 135
   The Objective Tab ............................................ 136
   The Scope Tab ................................................ 137
   The Branches Visited Tab ..................................... 139
   Updating Projects ............................................. 140
      The Main Tab .............................................. 140
      The Milestones Tab ....................................... 140
      The Branches Visited Tab ................................ 141
      The Program Set-up Tab ................................ 141
   Closing Projects .............................................. 141

12. Working With Search Your Database ......................... 143
   The Search Your Database Screen .............................. 143
   Common Features Across All Tabs .............................. 144
      Entering Data in the Search Parameter Fields ............... 145
      Adding an OR Search for Blank Entries ...................... 146
      Incorporating Search Criteria on Previous Tabs ............ 146
      Limiting Scrolling List Box Entries ......................... 147
      The By Tab Option .......................................... 147
      Other Options .............................................. 148
22. Generating the Audit Report ............................................. 301
   Creating a Cover Memo .............................................. 301
   Modifying an Existing Cover Memo ............................... 306
   Printing and Exporting the Audit Report ....................... 308
   Customizing the Audit Report Cover Memo .................... 309

23. Review Notes .............................................................. 311
   The Review Notes Screen ........................................... 311
   The Review Note Process .......................................... 313
   Viewing and Tracking Options .................................... 317
      Search for Review Notes with the Filter Fields ............. 317
      Searching for Review Notes in the Project Status Query . 318
      Perform Other Functions ....................................... 318

Section 5: Module D: Reporting, Searching, and Analysis

24. Module D Overview ..................................................... 323
   Audit Director’s Summary Report ................................. 324

Section 6: Module E: Audit Follow-Up

25. Module E Overview ..................................................... 329

Section 7: Module F: Human Resources

26. Module F Overview ..................................................... 333
   Audit Staff List ....................................................... 334

Section 8: Module G: Table Settings

27. Module G: Table Settings ............................................. 339
   Overview .............................................................. 339
   Understanding Module G Lookup Tables ....................... 341
   Creating Entries in the Module G Lookup Tables ............. 341
      Entry Creation Example ....................................... 342
      Viewing Modified Values .................................... 345

Section 9: Appendices and Glossary

A. Conflicts, Errors and Synchronization ............................ 349
   Conflicts ............................................................ 350
   Access 97 ........................................................... 350
   Access 2000 ......................................................... 350
   Errors .............................................................. 350
Conflict and Error Resolution .................................................. 351
Conflict Resolution - Access 97 ................................................. 353
Error Resolution - Access 97 ..................................................... 355
Conflict Resolution - Access 2000 ............................................. 360
Synchronizing after Removing Conflicts and Errors .................... 364

B. Module G Lookup Tables .................................................. 367

The Purpose of Lookup Tables ................................................. 367
Module A: Annual Audit Planning .............................................. 369
Module B: Staffing, Scheduling, and Time Tracking ...................... 377
Module C: Workpapers .......................................................... 379
Module D: Audit Findings ....................................................... 383
Module E: Audit Follow-up ...................................................... 385
Module F: Human Resources .................................................... 386

C. Appendix - Module A, B & C Fields .................................... 391

Module A - Fields on the Auditable Entity Profile Screen ............... 391
The Top Area of the Entity Screen ........................................... 391
Required Fields ................................................................. 391
The Main Tab ................................................................. 391
Main Tab Scrolling List Boxes ............................................... 392
Main Tab Text Boxes ......................................................... 394
Main Tab Checkboxes ....................................................... 394
The Comments Tab ............................................................ 394
Comments Tab Text Boxes .................................................. 395
The Attachments Tab ........................................................... 395
Attachments Tab Doclink Fields ............................................. 396
Attachment Tab Text Boxes .................................................. 397
The History Tab ............................................................... 397
The Miscellaneous Tab ....................................................... 398
Miscellaneous Tab Scrolling List Boxes .................................. 398
Miscellaneous Tab Text Boxes .............................................. 398

Module B - Fields on the Project Set-up Screen ......................... 399
The Main Tab ................................................................. 399
Required Fields ............................................................... 400
Main Tab Scrolling List Boxes ............................................... 400
Main Tab Text Boxes ......................................................... 401
Main Tab Attachment Fields ................................................ 401
The Staffing Tab ............................................................. 401
Staffing Tab Scrolling List Boxes .......................................... 402
Staffing Tab Text Boxes ..................................................... 402
The Sign-offs Tab ............................................................ 403
Sign-off Tab Scrolling List Boxes ......................................... 403
Sign-offs Tab Text Boxes .................................................. 403
Required Fields .............................................. 423
The Main Tab ............................................... 423
   Main Tab Text Fields .................................. 424
   Main Tab Scrolling List Boxes ..................... 425
   Main Tab Checkboxes ................................ 425
   Main Tab Doclink Fields ............................. 425
Sign-Offs Tab ............................................. 426
   Sign-offs Tab Scrolling List Boxes ............... 426
   Sign-offs Tab Text Boxes ............................ 426
Background Tab .......................................... 427
Criteria & Risk Tab ...................................... 427
   Criteria & Risk Tab Scrolling List Boxes ...... 428
   Criteria & Risk Tab Text Boxes .................. 428
Finding (report wording) Tab and Recommendation Tab 428
Management Responses Tab ........................... 429
   Management Response Tab Scrolling List Boxes 429
   Management Response Tab Text Boxes .......... 430
   Management Response Tab Doclink Fields ...... 430
Synopsis Tab ............................................... 430
   Synopsis Tab Text Fields ........................... 431
Module C - Fields on the Review Notes Screen ........... 431
   Scrolling List Boxes ............................... 432
   Text Boxes .......................................... 433
   Sign-Offs ............................................ 433
Glossary .................................................... 435
Section 1

Audit Leverage Overview
Audit Leverage Overview

Audit Leverage is an auditing software tool designed to automate and centralize all of the activities that take place during the audit process. It is based in Microsoft® Access and uses Microsoft Access’s database structure to store large amounts of data for all of your audits, both current and historical. Forms, reports, and findings are all included in the Audit Leverage package.

This chapter describes some basic architectural and operation aspects of Audit Leverage that you should be aware of before using the application. This chapter contains the following sections:

• “Overview of Functionality”
• “Architecture”
• “Synchronization”
• “Audit Leverage Field Types”

Overview of Functionality

Audit Leverage is a comprehensive application for internal auditors based in Microsoft Access. Audit Leverage allows you to plan, perform, and document the entire audit process using one application. Features include:

• Automated workpapers, including online, tailored audit programs and hyperlinks to attachments prepared in Excel, Word, ACL, flowcharting software, scanned images, and more
• Staffing and scheduling, including visual tools to assist in scheduling
• Timekeeping
• Budget-to-actual time comparisons measured in hours, days, or weeks
Audit Leverage Overview

- Entity Risk Assessment
- Annual Audit Planning & Budgeting
- Database searches of your audit findings
- Audit Committee reporting and statistical summaries of audit activities and recommendations
- Automated follow-up log
- Security administration
- Remote replication capability, allowing remote auditors to work offline and then dial-in to synchronize their version of the database with the master server’s version

Architecture

A typical Audit Leverage installation has two components: a front-end database (front-end) and a back-end database (back-end). The front-end is the component that the user can see. It contains the user interface, and the program logic components that handle the applications operation. No audit information is stored in the front-end; rather, the audit department data is stored in the back-end. Data storage is the sole purpose of the back-end.

Typically the back-end is stored on a server which is accessible through a network usually referred to as the master network database. When you are using Audit Leverage and entering and modifying data, the front-end “talks” to the master network database using this network connection. However, audit work is often performed in locations where you cannot access the primary back-end via the network. Therefore, local back-end copies can be created on your local machine—either a desktop or laptop PC. These copies are referred to as replicas. Sometimes, the local replica is called the “RepBE” an abbreviated form of “Replicated back-end.” See Figure 1.
When the Audit Leverage front-end has an active network connection, you have two choices:

- **Work online**—Connect via the front-end on your local machine to the master network database on the network.
- **Work offline**—Connect via the front-end on your local machine to the local replica on your local machine.
Synchronization

If you are not working with a direct connection to the master network database, you must periodically synchronize the data between the local back-end and the master network database. This is accomplished by reconnecting to the network using a LAN connection, and choosing the **Synchronize Direct** option from the Audit Leverage Welcome Screen. The **Synchronize Direct** option should *never* be used over a wide area network (WAN) or dial-up connection.

**Note:**
Audit Leverage is configured to automatically synchronize with the master network database daily upon the user's first login to the network. If an Audit Leverage user connects to the network on a
Audit Leverage Field Types

daily basis, automatic daily synchronizations take place without manually initiating it.

Audit Leverage Field Types

Throughout Audit Leverage there are a number of field types referred to during instruction procedures. This section covers the various field types that are referenced in the instructions.

• **Required fields**—These fields are marked by an asterisk.

• **Scrolling list boxes**—These fields require you to select a value from a list which appears when the arrow is clicked.

Note:
Typically, the values in scrolling list boxes must be pre-set in Module G.

• **Text boxes**—In these fields, you can type any value directly into the field. In some cases, the actual field size may be larger than that displayed on the screen. In these cases, a vertical scroll bar appears on the right side of the box. Pressing the Shift and F2 keys on your keyboard displays an enlarged view of the text box. Departments may want to establish conventions to make entries in certain fields consistent.

<table>
<thead>
<tr>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processes for: Helping to ensure timely &amp; accurate payment of amounts owed: Limiting payments to approved vendors only; Taking discounts; Recording liabilities accurately; petty cash disbursements and management; review executive T&amp;E's and peras in years in which T&amp;E Audit is not performed. (Include 21(a) $100 million review until December 2000.)</td>
</tr>
</tbody>
</table>

• **Checkboxes**—In these fields, a check indicates that the attribute is applicable or true.

• **Doclink or attached file**—In these fields you can insert linked or embedded files via the Insert > Object menu. Departments may want to establish conventions regarding whether to link or embed files. For more information
Audit Leverage Overview

on linking versus embedding, see “Working with Attachments - Embedding vs. Linking” in Chapter 19: “Working With the Audit Program Collection”.

- **Display fields**—These fields display data in a non-editable form for informational purposes

```
<table>
<thead>
<tr>
<th>Subcycle</th>
<th>Task</th>
<th>Program Template Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>N/A</td>
<td>Overview</td>
</tr>
</tbody>
</table>
```
Starting Audit Leverage

When you start Audit Leverage, you must login. Then the software prompts you for some current setting information which is used to determine which database to use. If a network database is detected, Audit Leverage also gives you the option of synchronizing the local replica with the master network database. Once you have completed these steps, Audit Leverage starts, and the main Audit Leverage screen appears.

This chapter describes the options available and the steps required to start Audit Leverage. This chapter contains the following sections:

- “Logging In”
- “Database and Modem Detection”
- “Synchronizing”
- “Choosing a Database”
- “The Main Audit Leverage Screen”

Logging In

The first step in starting Audit Leverage is to log into the system.

How to Log In

To log in, perform the following steps:

1. Start Audit Leverage by selecting Audit Leverage from the start menu, or by double-clicking on the shortcut icon on your desktop.
Starting Audit Leverage

The Logon dialog box appears, as shown in Figure 3.

![Logon Dialog Box]

**Figure 3: Logon Dialog Box**

2. In the **Name:** field, enter your user name, exactly as it was entered in the User Security File.

3. In the **Password:** field, enter your password, exactly as it was entered in the User Security File.

4. Click **OK**.

If you have not logged in on this machine before, or someone else has logged in using a different account on this machine since you last logged in, the Password Verification screen appears, as shown in Figure 4.
5. In the **Name**: field, enter your user name, exactly as it was entered in the Logon dialog box.

6. In the **Password**: field, enter your password, exactly as it was entered in the Logon dialog box.

7. Click **Continue**.

**Note:**
If one user always uses the same machine and is the only user of that machine, you typically do not see this screen.

**Database and Modem Detection**

Once you have logged in, Audit Leverage attempts to detect if you have an active modem on your machine and also to detect the presence of the master network database.

**Active Modem Detected**

If you have an active modem—either through dial-up, cable, or DSL, Audit Leverage prompts you to verify that you are not connected through a dial-up connection before allowing you to connect to the master network database.
Starting Audit Leverage

Although it is possible to perform transactions when connected through a dial-up modem, IAD Solutions strongly recommends that you do not attempt to synchronize your local replica with the master network database using direct synchronization while connected using a dial-up connection. Attempting direct synchronization over a dial-up modem may result in database corruption.

If you are starting Audit Leverage while connected to any kind of modem, Audit Leverage senses the modem connection, and displays the screen shown in Figure 5.

![Figure 5: Opening Options Screen with Modem Detected](image)

If you have connected through a dial-up connection, leave the checkbox deselected and continue with the steps described in the “Choosing a Database” section. If you are not connected through a dial-up modem, select the **I am not connecting to the network through Dial-up** checkbox.

If you select the checkbox, the **Connect to network database** selection and the **Browse** button become active, and the last known master network database is listed. Also, if synchronization is necessary, a message and button appear below the frame to allow you to synchronize, as described in the “Synchronizing” section. See Figure 6.
Database and Modem Detection

If you want to synchronize your local replica with the master network database, continue with the steps described in the “Synchronizing” section continue with the steps described in the “Choosing a Database” section.

**No Modem Detected**

If no active modem is detected on your machine, Audit Leverage assumes that you are on a network LAN and attempts to locate the master network database. If one is found the Opening Options screen appears, as shown in Figure 7.

---

**Figure 6: Opening Options Screen with Modem Detected**

If you want to synchronize your local replica with the master network database, continue with the steps described in the “Synchronizing” section continue with the steps described in the “Choosing a Database” section.

**No Modem Detected**

If no active modem is detected on your machine, Audit Leverage assumes that you are on a network LAN and attempts to locate the master network database. If one is found the Opening Options screen appears, as shown in Figure 7.
Starting Audit Leverage

Figure 7: Audit Leverage Opening Options Screen

If you want to synchronize your local replica with the master network database, continue with the steps described in the “Synchronizing” section continue with the steps described in the “Choosing a Database” section.

No Master Network Database Detected

If no active modem is detected on your machine, and Audit Leverage cannot locate the master network database, the Opening Options screen appears, as shown in Figure 8.
If no master network database is found, you cannot synchronize, since you have access only to the local replica. Continue with the steps described in the "Choosing a Database" section.

**Synchronizing**

If the master network database is detected, depending on your administration settings, Audit Leverage may prompt you to determine if you want to synchronize your databases, or may perform the synchronization automatically.

**How to Synchronize at Startup**

If it is necessary to manually synchronize your databases at startup, perform the following steps:

1. Ensure that you have a valid local replica and master network database available.

   If you have a valid local replica and master network database available, both radio buttons are active, similar to that shown in Figure 9.
Starting Audit Leverage

Figure 9: Audit Leverage Opening Options Screen

Note that Audit Leverage displays the number of days since you last performed a synchronization.

Note:

If your master network database is not detected, or if Audit Leverage synchronizes the databases automatically, continue with the steps described in “Choosing a Database”.

2. If you want to synchronize your databases, click on the Direct button.

Audit Leverage synchronizes the databases. When it has completed the process, a message box displaying the number of conflicts, if any, appears.

3. Click OK.

Important:

If your department has purchased Indirect Synchronization, an Indirect button also appears on the screen. If you have both choices, consult your Audit Leverage Administrator for instructions on when to use each type of synchronization.

4. Continue with the steps described in “Choosing a Database”.

28
Choosing a Database

Once Audit Leverage had determined which databases are available, you can then select the database you want to use, either the local replica or the master network database.

How to Choose a Database

To choose your database, perform the following steps:

1. If necessary, click on the **Browse** button to select a new master network database.

   **Note:**
   
   Audit Leverage defaults to displaying the path and name of the last master network database that was used. Typically you do not need to change this setting.

2. Select either the **Connect to local replica** or **Connect to network database** radio button.

3. Click **Continue**.

   If necessary, Audit Leverage relinks the tables, and then opens the software using the specified database.

The Main Audit Leverage Screen

Once Audit Leverage has started up, the main Audit Leverage screen appears, as shown in Figure 10.
Starting Audit Leverage

**Figure 10: Main Audit Leverage Screen**

From this screen you can navigate to the various modules within Audit Leverage. This screen also contains a set of tabs where, if you have the proper permissions, you can view and modify various administrative data for Audit Leverage as well as viewing general information about the application.
The Sign-Offs Tab and Record-Level Security

In Audit Leverage, many screens contain a **Sign-Offs** tab. Preparers of audit work and their reviewers are designated by selecting names in the preparer and reviewer scrolling list boxes on these tabs. Auditors indicate the completion of their work or review by clicking the sign-off button. Applying sign-offs serves two purposes: it indicates completion of auditor or reviewer work, and it applies record-level security.

Audit Leverage offers two security modes: low and high. On the Audit Leverage Administration screen, users with administrator rights can select the desired security mode. Audit data security differs depending upon your department’s choice of the high security or low security options.

The following sections explain sign-offs and the security implications under low security mode. For an explanation of security implications in high security mode, see "Differences in High Security Mode". This chapter contains the following sections:

- “Sign-Offs”
- “Sign-Off Options and Effects”
- “Sign-Off Rules”
- “Differences in High Security Mode”

**Sign-Offs**

A sign-off is an indication by an auditor that he has completed or reviewed audit work. It is also a way to invoke security on audit data by making it read-only to
users. Sign-offs are optional. If preparer sign-offs are used, up to 3 people can review the preparer’s work.

**How to Apply a Sign-off**

To apply a sign-off, perform the following steps:

1. Click the **Sign-Offs** tab.
   
   The screen view changes to display the tab’s fields, as shown in Figure 11.

2. In the **Auditor** scrolling list box above the preparer or reviewer sign-off button corresponding to your role, select your name.

   If you are designating yourself as a preparer, and you plan to have other auditors reviewing your work, select their names in the reviewer fields before applying your own sign-off.

3. Click the **Sign-off Button** directly below your name.

   **Note:**
   
   You can only sign off if the selected name matches the name of the logged-in user. If the auditor name selected does not correspond to your log-in name, Audit Leverage displays an information box explaining that you must first put your name in the preparer or reviewer auditor field in order to proceed with a sign-off.

4. Two information messages appear. Read the messages and click **OK** on each of them.

   Audit Leverage places the current date in the **Sign-off Date** field, and the user’s log-in name in the **Electronic Signature** field. Data becomes read-only to all users except any reviewers who have not yet signed off. The **Sign-Offs** tab fields become read-only to the signing user, as shown in Figure 12.
Sign-Off Options and Effects

Figure 12: Sign-Offs with Preparer Sign-Off Applied

Sign-Off Options and Effects

Sign-offs are possible on the **Sign-offs** tab of the screens listed below. When sign-offs are applied on these screens, the respective data becomes read-only to the signer and all other users except remaining reviewers who have not yet signed off. In addition, the status of the step, file attachment, finding, template or review note is automatically updated to reflect the preparer or reviewer sign-off.

- An audit step in a program can be signed off in the Module C Audit Program Collection screen.
- A file attachment can be signed off in the Module C Attachment Index screen.
- A finding can be signed off in the Module C Findings screen.
- An audit program template can be signed off in the Module C Audit Program Template Library screen.
- A review note can be signed off in the Module C Review Note screen.

Sign-offs are also possible on the **Sign-offs** tab of certain screens listed below. When sign-offs are applied on these screens, the respective data becomes read-only to the signer and all other users except remaining reviewers who have not yet signed off. In addition, the status of the program or project is automatically updated to reflect the preparer or reviewer sign-off. Sign-offs on these screens have an effect on other related audit data, as follows:

- An audit program can be signed off on the Module B Project Set-up screen - **Program Set-up** tab. When a program is signed off by a preparer, all program data including all of its steps becomes read-only to the preparer and all users except those reviewers yet to sign off. On the Administration Screen, users with administrator rights can select the “Audit Steps Sign-off Enforcement” option. When selected, this option requires that all individual audit steps be signed off before an entire program is signed off.
- A project can be signed off on the Module B Project Set-up screen. When a project is signed off by a preparer, all project data becomes read-only to the
The Sign-Offs Tab and Record-Level Security

signer and all other users except those reviewers yet to sign off. In addition, all dependent audit data also becomes read-only to all users except those project reviewers yet to sign off. This dependent data includes programs, audit steps, attachments, and findings for the project. Therefore, project sign-offs should only be applied when all other audit work is completed.

Sign-Off Rules

Under the low security administration setting, sign-offs are bound by the following rules:

• Preparers and reviewers initially can be selected by any user from the respective scrolling list boxes.

• Users can sign off only under their own names.

• Users can only delete their own sign-offs, provided that the next level reviewer has not already signed off. They cannot delete other users’ sign-offs.

• The preparer or reviewer names can be changed by any user if the preparer has not signed off.

• Once the preparer signs off, the record’s fields become read-only to the preparer and all users except the reviewers. However, the reviewer names can still be changed by the preparer and reviewers until those reviewers sign off.

• Once a reviewer signs off, the record’s fields become read-only to the reviewer and all users except the higher level reviewers. Until the higher level reviewers sign off, their names can still be changed by the reviewer who just signed off.

• Once sign-offs occur, they can only be deleted by the respective users in the reverse order in which they were applied.

Differences in High Security Mode

High security mode can be set on the Audit Leverage Administration Screen by those with administrator rights. This mode is used when a department wants security on audit data even before auditors apply their sign-offs. Read-only security is invoked when the preparer and reviewer auditor fields are populated with names.

Under high security and prior to sign-off, the record’s fields are locked for editing to all users except the auditors initially selected as preparer or
reviewers. This is true as long as the work status for the record is not set to “not yet started”, or the label your department has assigned to the status numbered “10”. This applies to the project status, audit step status, attachment status, and review note status fields. In the case of findings, there is no status field, so the rule applies at all times.

High security mode has no security effect on programs defined for a project, or on program templates in the Module C Template Library. The presence of auditor names in the preparer and reviewer fields prior to sign-off does not cause data to become read-only to other users.

Unlike with sign-offs, there is no hierarchical effect of high security related to projects. In other words, even when project preparers and reviewers are selected and the Project Set-up screen data becomes read-only, there is no cascading effect on dependent data like audit steps, findings, and attachments.

Once a preparer sign-off is applied, security behaves just as it does under low security mode.
The Sign-Offs Tab and Record-Level Security
Section 2

Module A: Risk Assessment and Annual Audit Planning
Module A Overview

Module A is used to perform Risk Assessment and Annual Audit Planning. The functions available in Module A are broken up into tasks and queries. You can also access the Audit Universe from Module A, allowing you to create and edit settings for an audit project that is planned or underway.

To access the functions of Module A, from the Audit Leverage Main screen, click the Risk Assessment and Annual Audit Planning button.

The Module A Main Screen appears, as shown in Figure 13.
Module A Overview

Figure 13: Module A Main Screen

From the Module A Main Screen you can select all of the functions for Project Planning and Risk Assessment. These functions are described in detail in these chapters:

- Planning Your Audit Universe
- Setting Up a Risk Assessment
- Risk Assessments
- Creating An Audit Entity
Planning Your Audit Universe

The foundation of Audit Leverage is the audit universe. The audit universe holds all of your department’s auditable entities. At the beginning of an Audit Leverage implementation, your department leadership must determine what your entities are, and how they should be defined and described in the software. The careful definition of entities provides for powerful reporting and data analysis of your audit history.

This chapter covers the following questions that you should answer to plan your audit universe in Audit Leverage:

• **Defining entities**
  — What is an entity?
  — What are our department’s entities?

• **Defining entities in Audit Leverage**
  — How does Audit Leverage help you to describe your entities?

• **Reporting and data analysis considerations**
  — What reporting and data analysis needs do you have which drive your choices of fields to populate?

• **Establishing your department’s conventions**
  — What Audit Leverage fields should you use to describe your entities?
  — What conventions should you establish for identifying entities through the key fields?
  — For the non-key fields, what possible values or data entry conventions do you want to establish?
Planning Your Audit Universe

Your department should take the time to discuss the questions listed above, and strategize about possible conclusions. This is a crucial first step toward a successful Audit Leverage implementation.

This chapter contains the following sections designed to assist you in this process:

- “Defining Entities”
- “Defining Entities in Audit Leverage”
- “Reporting and Data Analysis Considerations”
- “Establishing Your Department’s Conventions”

Defining Entities

What is an entity?

An entity is the lowest level auditable unit for which you issue a standalone audit report. An entity can be a physical location, department, division, function, process, or anything you audit which becomes the sole focus of a standalone audit report. Another term for an entity is an auditee.

In order to determine your Audit Leverage entities, consider how you conduct audits. In some audit departments, audits are conducted at many levels. For example, a bank’s auditors may sometimes audit a low-level process like consumer loans. Upon the conclusion of this audit, they produce a standalone audit report on the consumer loan process. At other times, they audit at a much higher level, examining and reporting on the entire lending department, including consumer, commercial, and real estate loans. At the conclusion of this audit, they also produce a standalone audit report on the entire Lending department. In these cases, the bank’s audit universe should contain an entity called “Consumer Loans” and another entity called “Lending Department.”

Your department’s audit universe may contain a variety of entities representing the various levels at which you conduct audits.

An entity can be audited multiple times over the course of time. Audit Leverage allows you to set up audits, called audit projects, to represent each time you audit an entity - whether it be annually, quarterly, or at some other time interval. Therefore, you do not need to define a new entity every time you conduct an audit. Instead, for each audit, you create a new project that references that entity. For further information on creating audit projects, see Chapter 11: “Creating An Audit Project”.

42
Defining Entities in Audit Leverage

In Audit Leverage, for every audit project defined in Module B, there is a one-to-one relationship between the project, the entity that is the subject of the audit, and the Audit Leverage-generated audit report which focuses solely on the results of the audit on that entity. The relationship is represented below:

1 audit project : 1 entity : 1 audit report

What are your department’s entities?

Ask the following question when determining how to define an entity:

For which physical locations, departments, divisions, processes or functions do you issue a standalone audit report?

Note:

Based upon the results of the question above, make a list of your department’s entities.

Defining Entities in Audit Leverage

How does Audit Leverage help you to describe your entities?

Audit Leverage helps you define your entities through fields on the Auditable Entity Profile screen in Module A. To navigate to the Entity Profile screen, perform the following steps:

1. From the Welcome Screen, click on button A - Risk Assessment and Annual Audit Planning.

The main Module A screen appears, as shown in Figure 14.
Planning Your Audit Universe

2. Click on the **Update the Audit Universe** button.

The Auditable Entity Profile screen appears, as shown in Figure 15.
Figure 15: Auditable Entity Profile Screen

The Entity Profile screen contains five tabs. Entities are defined by populating the key fields at the top of the screen, and various fields on the five tabs. Your department management should study the fields on these tabs and ask the following questions:

- How do you want to describe your entities?
- What fields are important to use in accurately describing your entities?

The answers to these questions determine what attributes are important and what fields your department wants to populate.

For a description of the fields on the Auditable Entity Profile screen, see Appendix C: “Appendix - Module A, B & C Fields”.
Planning Your Audit Universe

Reporting and Data Analysis Considerations

What reporting and data analysis needs do you have that drive your choices of fields to populate?

After you have explored the Auditable Entity Profile screen, your department management should consider its reporting requirements. Consider by what entity characteristics you want to aggregate data when analyzing your audit history. For example:

• Do you want to report on all audit history tied to a specific geographic region? If so, for each entity, populate the region field to enable data analysis by region.

• Do you want to report on all audit history tied to a particular part of the organizational structure? If so, for each entity, populate the company, group, and/or subgroup fields, and possibly the business division field.

• Do you want to report on all audit history by entity type, such as all plants, sales offices, retail stores, and corporate headquarter functions? If so, for each entity, populate the entity type field.

Once you have considered questions like these, and explored the Auditable Entity Profile screen, navigate to the Search Your Database tool to understand your searching and data analysis capabilities in Audit Leverage. See Chapter 12: "Working With Search Your Database" for more information on this tool.

Note:

After researching the Auditable Entity Profile screen fields, the Search Your Database tool and other reports in Audit Leverage, make a list of the entity fields you want to use.

Establishing Your Department’s Conventions

Once you have determined the Auditable Entity Profile screen fields you want to use in describing entities, your department must establish its conventions and convey them to those responsible for creating and maintaining entities. To establish your conventions, answer the following questions and perform the corresponding steps:

What Audit Leverage fields do you plan to use to describe your entities?

• Make a list of all Audit Leverage fields your department plans to use in defining entities, including the key fields marked by an asterisk. It may be
helpful to screen print the tabs of the Auditable Entity Profile screen and mark them.

What conventions should you establish for identifying entities through the key fields?

• Decide if the entity number field must follow any specific pattern, or if entity numbers should be set up sequentially with no additional meaning attached to the number. Entity numbers must be unique.

Note:
Because there are many fields used to describe entities, Audit Leverage attaches no special meaning to the entity number field other than to uniquely identify the entity.

• Decide how you plan to identify your entities in the entity name field. Entity names must be unique.

For the non-key fields, what possible values or data entry conventions do you want to establish?

• For every scrolling list box you intend to use, determine the possible entries that should appear when the user clicks the arrow. Enter these values in the corresponding Module G tables. See Appendix B: “Module G Lookup Tables” for instructions on how to populate the Module G tables.

• For every other type of field, establish conventions for data population to make entries consistent, and therefore more meaningful, across entities.

For example, if you want to use the Comments field on the Comments tab, establish guidelines as to what types of information should be entered. If you want to use the Attachments tab, establish guidelines as to what kinds of files should be attached, and whether or not they should be attached for every entity. Also, determine if hard copy documents should be referenced if they do not exist in electronic form.

Note:
Ensuring data entry consistency enables you to perform more effective data analysis through Search Your Database and other tools.

• If you intend to use the Attachments tab to capture permanent entity information, determine if you want these files to be linked or embedded. See “Working with Attachments - Embedding vs. Linking” in
Planning Your Audit Universe

Chapter 19: “Working With the Audit Program Collection” for an explanation of linking versus embedding.

- Determine if there are any fields that you want to redefine for use other than the way in which they are labeled. Your department can use Audit Leverage fields in any way it wants. Care must be exercised, however, in redefining the meaning of fields, because some fields are used in reports and queries elsewhere in the software. Research the reports and queries in the software before publishing any changes to the use of fields other than that implied by the field label.
Setting Up a Risk Assessment

Audit Leverage allows you to create risk assessments on a per-entity basis to help you determine where audits are needed most. A number of different criteria can be included in the Audit Leverage risk assessment to come to a proper decision, and each criteria can be given a weight to better calculate the risk rating.

Risk assessment is optional. You do not have to risk assess an entity on order to create an audit project for it. Not all audit departments need to perform the risk assessment process.

This chapter describes the types of required data that you must enter into Module G before you can create a risk assessment. It includes a number of questions which your audit department should answer to determine the best methods for structuring your data.

This chapter contains the following sections:

• “Risk Assessment Overview”
• “Defining Risk Assessment Information”
• “Entering Risk Assessment Information”

Risk Assessment Overview

If you choose to use Risk Assessment, it is used as one of the processes to determine if it is desirable or necessary to perform an audit project in the given time period for an entity.

In this definition of Risk Assessment, “risk” is a subjective measure of the likelihood of encountering exceptions in the audit process rather than an objective, statistically based measure as is commonly used in statistical sampling. Risk Assessment, then, can be defined as an intuitive “feel” for the
Setting Up a Risk Assessment

necessity of an audit, based on the prior history of the entity, the nature of the industry, economic conditions, experience of the auditor, and other factors. The “score” given to a risk assessment based on these conditions determines the suggested frequency of the audit.

The Risk Assessment process has three primary components:

• Risk Criteria—the risk element being measured
• Risk Rating—a numeric measure of the degree of risk
• Risk Criteria Weighting—the degree of importance of the criteria

The final subjective part of the Risk Assessment process is for management to assign frequencies of audits based on the scoring.

Defining Risk Assessment Information

Before entering any data into Audit Leverage, your department should determine the risk criteria groups, names, weightings and severity codes that you intend to use during risk assessment. You should also discuss ways that you might populate the Audit Frequencies table to allow Audit Leverage to suggest target dates for future audits. Finally, decide what changes, if any, should be made to the codes for “Place on Audit Plan.”

Before creating risk assessments for entities, your audit department must define some information to be entered into Module G, which relates to your department’s risk criteria and risk model for risk assessments. This information can generally be gathered from the answers to a number of questions that you should ask.

Specifically, your department must answer these questions:

• **Entity Types**—What entity types have we set up for our audit universe?
• **Risk Criteria Usage**—Do we use one set of risk criteria for all entities or do risk criteria differ depending on the entity type? If they differ, do we have a set of risk factors for every defined entity type?
• **Grouping Criteria**—For each set of risk criteria, do we want to subgroup our criteria to get subtotal risk scores in addition to an overall score?
• **Specific Criteria**—What are our risk criteria?
• **Weights**—What weightings do we associate with each criterion? That is, do all criteria carry the same importance, or are some more important than others, and therefore must be considered more heavily than others?
Defining Risk Assessment Information

- **Scoring**—When assessing an entity, how do we score it against the risk criteria? What are the possible scores?

The following sections address these questions.
- “Entity Types”
- “Risk Criteria Usage”
- “Grouping Criteria”
- “Specific Criteria”
- “Weights”
- “Scoring”

**Entity Types**

**What entity types have we set up for our audit universe?**

The list of entity types defined for your database are saved in Module G. These entity types should have been created with risk assessment in mind if risk assessment is part of your department's standard procedure. Risk factors can be defined globally for all entity types, or can be differentiated for each individual entity type. Your department should carefully review your entity types since all other Module G settings relating to risk assessment depend on these entity values.

**Risk Criteria Usage**

**Do we use one set of risk criteria for all entities or do risk criteria differ depending on the entity type? If they differ, do we have a set of risk factors for every defined entity type?**

In Audit Leverage, the setup and configuration settings for risk assessment relate directly to the entity type field. All risk assessment is driven by the entity type of the entity being assessed. These generally fall into two scenarios:

- If your department has one set of risk criteria that applies to all entity types, define the criteria in Module G and do not associate them with an entity type, leaving the entity type field blank. Any entity not associated with a specific entity type are recognized by Audit Leverage as default risk factors.

When you generate risk assessments, Audit Leverage checks the value in the entity type field of the entity being assessed. If it finds no associated risk factors defined for that entity type in Module G, it prompts you to verify that you want to use the default risk factors.
Setting Up a Risk Assessment

- If your department has different sets of risk criteria depending on the entity type, define each set of criteria in Module G and associate them with their respective entity types.

- If you do not have risk factors to associate to every entity type defined in Audit Leverage, you may want to set up a default set of risk factors associated with no specific entity type. Each time a risk assessment is initiated for these entities, Audit Leverage checks the value in the entity type field of the entity being assessed. If it finds no associated risk factors defined for that entity type in Module G, it prompts you to verify that you want to use the default risk factors.

Grouping Criteria

For each set of risk criteria do we want to subgroup our criteria to get subtotal risk scores in addition to an overall score?

If your department uses many risk factors when assessing an entity, it might be useful to view subtotal scores by group, in addition to an overall risk score for the entity.

Note:

If you intend to group your risk criteria into groups or categories to view the weighted average scores of each criteria group, you must populate the Risk Criteria Groupings table first. Typically, if you have less than six criteria for an entity type, it is not useful to divide those six into groups, unless you want to view summary reporting by group.

All risk criteria for each entity must be associated with one overall risk criteria grouping, even if you do not want to use multiple criteria groups to subgroup your risk factors. Therefore, your Risk Criteria Groupings table must contain one group entry for every entity type. The Entity Risk Criteria Grouping table is shown in Figure 16.
Defining Risk Assessment Information

The entity risk grouping table in Module G is where you define the possible risk criteria groups for each entity type.

The table shown in Figure 16 shows some sample entries for risk criteria groups. In this example, all risk criteria groups are directly tied to an entity type. Also, for the Administrative Department entity type, there are two criteria groups: inherent risks and control risks.

For more information on entering information in Module G, refer to “Entry Creation Example” in Chapter 27: “Module G: Table Settings”.

**Figure 16: Entity Risk Criteria Grouping Table**

The entity risk grouping table in Module G is where you define the possible risk criteria groups for each entity type.

The table shown in Figure 16 shows some sample entries for risk criteria groups. In this example, all risk criteria groups are directly tied to an entity type. Also, for the Administrative Department entity type, there are two criteria groups: inherent risks and control risks.

For more information on entering information in Module G, refer to “Entry Creation Example” in Chapter 27: “Module G: Table Settings”.

**Ordering Groups**

The **Group #** field determines the order in which the groups appear in drop-down lists. In order for the risk groupings to appear in a certain order in the risk assessments, use a leading character—such as A, B, C or 1, 2, 3—before the group name.
Setting Up a Risk Assessment

Specific Criteria

What specifically are our risk criteria?

Once you have defined your risk assessment grouping(s), you can define the specific risk criteria for each entity type. Audit Leverage is very flexible in risk criteria definition. Depending on your needs, each entity type can have a different set of risk criteria.

Once you have determined the risk criteria for each entity, you enter this information in the Entity Risk Criteria Names table, as shown in Figure 17.

![Figure 17: Entity Risk Criteria Names Table](image)

For each entity type and criteria group, you enter the risk criteria. You can also enter a description and decimal value weightings assigned to each criterion. In the example shown in Figure 17, the criteria that have no value in the **Entity Type** field are the default values used if you do not specify an entity type.
Defining Risk Assessment Information

Note:

To force the risk criteria to appear in a certain order in the risk assessments, you must use a leading character—for example A, B, C or 1, 2, 3—before the criteria name text.

For more information on entering information in Module G, refer to “Entry Creation Example” in Chapter 27: “Module G: Table Settings”.

Weights

What weightings do we associate with each criterion? Do all criteria carry the same weight (importance), or do some weigh more heavily than others?

You can use the Weight column, shown in Figure 17, to enter a percentage weighting in decimal format for each criterion. Weightings for each criterion must be greater than zero in order for those criteria to appear in new risk assessments. These weights allow you to determine which risk criterion should be considered more heavily in the risk assessment.

Typically, you want the criterion weightings to total 100% for each entity type. As you make table entries, you must manually calculate the total to confirm that your percentages equal 100% for each set of risk criteria defined for an entity type.

Note:

It is possible to allow the total to exceed 100%. This is to allow for those departments who may want to have each criteria grouping add up to values other than 100%. For example, if an entity type had three groups of criteria, then the weightings for that entity type might add up to 300%. Audit Leverage allows this, but displays a warning statement when a risk assessment is being created whose criteria add up to more than 100%.

Scoring

When assessing an entity, how do we score it against the risk criteria? What are the possible scores?

Once you have established the various risk criteria you must assign the possible risk scores, also referred to as risk severity codes, for each criterion. Each risk criterion may have its own set of risk scores and explanations, or you may choose to use the same set of risk scores and explanations for all risk criteria.
Setting Up a Risk Assessment

These values are entered in the Risk Assessment Severity Codes tables, shown in Figure 18.

<table>
<thead>
<tr>
<th>Entity Type</th>
<th>Risk Criteria Grouping</th>
<th>Criteria Names</th>
<th>Risk Rating</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Department</td>
<td>Inherent Risks</td>
<td>A) Audit Committee Interest</td>
<td>4</td>
<td>Audit Committee is weak</td>
</tr>
<tr>
<td>Administration Department</td>
<td>Inherent Risks</td>
<td>A) Audit Committee Interest</td>
<td>3</td>
<td>Audit Committee has issues</td>
</tr>
<tr>
<td>Administration Department</td>
<td>Inherent Risks</td>
<td>A) Audit Committee Interest</td>
<td>2</td>
<td>Audit Committee appears</td>
</tr>
<tr>
<td>Administration Department</td>
<td>Inherent Risks</td>
<td>A) Audit Committee Interest</td>
<td>1</td>
<td>Audit Committee has a</td>
</tr>
<tr>
<td>Administration Department</td>
<td>Inherent Risks</td>
<td>B) Complexity of Operations</td>
<td>4</td>
<td>Very complex. Many obstacles</td>
</tr>
<tr>
<td>Administration Department</td>
<td>Inherent Risks</td>
<td>B) Complexity of Operations</td>
<td>3</td>
<td>Moderately complex.</td>
</tr>
<tr>
<td>Administration Department</td>
<td>Inherent Risks</td>
<td>B) Complexity of Operations</td>
<td>2</td>
<td>Fairly complex.</td>
</tr>
<tr>
<td>Administration Department</td>
<td>Inherent Risks</td>
<td>B) Complexity of Operations</td>
<td>1</td>
<td>Very low complexity.</td>
</tr>
</tbody>
</table>

Figure 18: Risk Assessment Severity Codes Table

For example, if two of your criteria are “Changes in Management” and “Employee morale,” and your rating scale is from 1 to 5, then a rating of 4 can have different explanations for each of the criteria. A 4 rating for changes in Management could be “The entire management team resigned in the last six months” while the same rating for employee morale could represent “All employees are afraid of downsizing.”

In the table you must make a row entry for every criterion and score combination. Therefore, if a criterion can be scored in a range from 1 to 5, then make five row entries to account for every score that criterion can have. If you have ten criteria, and each criterion can have a score from 1 to 5, you must make 50 entries in this table for that entity type.
Defining Risk Assessment Information

Other Risk Assessment Table Settings

The answers to the questions in the preceding sections provide data for the majority of the risk assessment related information to be entered in Module G. However, some other settings may be set which cannot be given fast global values for your department’s processes.

Audit Frequencies

The Audit Frequencies field is used to allow the system to auto-calculate when the next audit should take place based on the entity’s most current risk rating. If you use this feature, you can indicate risk value ranges and the range of time when the next audit should take place. These values are set in the Audit Frequencies table, as shown in Figure 19.

<table>
<thead>
<tr>
<th>Risk Score</th>
<th>Beginning (in months)</th>
<th>End of range (in months)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>32</td>
<td>36</td>
</tr>
<tr>
<td>2.5</td>
<td>28</td>
<td>32</td>
</tr>
<tr>
<td>3</td>
<td>24</td>
<td>20</td>
</tr>
<tr>
<td>4.3</td>
<td>20</td>
<td>24</td>
</tr>
<tr>
<td>5.2</td>
<td>16</td>
<td>20</td>
</tr>
<tr>
<td>6.1</td>
<td>12</td>
<td>16</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td>12</td>
</tr>
</tbody>
</table>

Figure 19: Audit Frequencies Table
Setting Up a Risk Assessment

There are separate fields for “beginning of range” and “end of range.” When calculating the next recommended audit date, the system uses the midpoint of the entered values. For example, for an audit frequency of 32-36 months, the system uses 34 months. Using the default values shown in Figure 19 any scores greater than or equal to 1.6 but less than 2.5 are assigned a range of 32-36 months; scores greater than or equal to 2.5 and less than 3.4 are assigned have a range of 28-32 months, and so on. If any risk scores exceed the highest entry in the table, Audit Leverage uses the time range for the highest risk score threshold in calculating the target date for the next audit.

Codes for “Place on Audit Plan?”

You may customize your own codes to indicate whether or not an entity should be on the audit plan for a given year. The default values for this field are “Yes”, “No”, and “Decide Later.” These values are set in the Codes for “Place on Audit Plan?” table, shown in Figure 20.

![Figure 20: Codes for “Place on Audit Plan?” Table](image)
Entering Risk Assessment Information

**Important:**
Do not delete or rename the **Yes** entry.

**Entering Risk Assessment Information**

Once the Module G tables relating to risk assessment—Criteria Groups, Criteria Names, and Severity Codes—are populated, risk assessments can be created. The entries in Module G can be changed at any time without affecting historical records.

One user, connected to the master network database, should populate the Module G tables for risk assessment, as described in the previous sections. Whoever enters data should be careful to make consistent entries across tables, as inconsistent entries can result in errors. When making entries be sure to select values from scrolling list boxes if they are available, rather than entering values directly into the fields.

For more information on entering information in Module G, refer to “Entry Creation Example” in Chapter 27: “Module G: Table Settings”.
Setting Up a Risk Assessment
Once the data to be used for your risk assessments has been entered into Module G, you can then begin to create risk assessments. This chapter describes the processes used to create a complete risk assessment for an entity in Audit Leverage.

All related data must be entered in Module G before a risk assessment can be created.

This chapter contains the following sections:

- “Viewing a Risk Assessment”
- “Creating a New Risk Assessment”
- “Populating the Risk Assessment”
- “Summary Tab”
- “Details Tab”
- “Comments Tab”
- “Planning Tab”
- “Assessments Tab”
- “History Tab”
- “Viewing Summary Information”
- “Deleting a Risk Assessment”
- “Spreadsheet View”
- “Copying Risk Assessments”
Risk Assessments

Viewing a Risk Assessment

You can view information about any existing risk assessment. You can then edit the information in that risk assessment, if necessary.

How to View a Risk Assessment

To view an existing risk assessment, perform the following steps:

1. In the Module A Main Screen, click **Risk Assessments by Auditable Entity**.

The Auditable Entity Risk Assessment screen appears, as shown in Figure 21.

![Figure 21: Auditable Entity Risk Assessment screen](image-url)
Creating a New Risk Assessment

2. In the **Planning Year** scrolling list box, select the plan year that you want to view.

3. In the **Quick Search** scrolling list box, select the entity associated with the risk assessment.
   The information shown on the screen changes to reflect the risk assessment data for the entity and year selected.
   To edit the data, follow the steps described in "Populating the Risk Assessment".

**Creating a New Risk Assessment**

You can create risk assessments for each entity in your Audit Universe. Each entity can be assigned values for risk criteria that you specify.

Up to one risk assessment per year can be performed for a combination of entity and project type.

**How to Create a Risk Assessment**

To create a new risk assessment, perform the following steps:

1. From the Module A Main Screen, in the **Select Plan Year** scrolling list box, select the planning year.

2. Click **Risk Assessments by Auditable Entity**.

   The Auditable Entity Risk Assessment screen appears, as shown previously in Figure 21.

3. Click the **Create a New Assessment** button.

   The Create New Risk Assessment dialog box appears, as shown in Figure 22.
Risk Assessments

Figure 22: Create Risk Assessment dialog box

4. In the Select Entity... scrolling list box, enter the first few characters of the entity name for which you want to create the risk assessment, or click on the arrow to scroll through the list of possible entities.

5. Select the entity name by pressing Enter or clicking on the name in the list. Once you select an entity, the default year and project type values appear in those fields, as shown in Figure 23.

Figure 23: Create Risk Assessment dialog box with data

6. If necessary, select a new planning year.

7. If necessary, select the project type for the potential audit project to be created if the entity is selected for placement on the audit plan.

**Note:**

If the project type is not yet known, select “Not yet classified” from the list. You must select a project type field, or unexpected results may occur in the risk assessment.

64
8. Click **Create**.
   A message box appears, prompting you to verify your selections.

9. Click **Yes** to confirm your selections and create the assessment, or **No** to cancel risk assessment creation.

**Note:**
If a risk assessment for the selected entity, year, and project type already exists, Audit Leverage cannot create a new risk assessment unless you delete the existing risk assessment.

Once you have successfully created a risk assessment, the Create Risk Assessment dialog box remains active. You can either create another risk assessment or return to the Risk Assessment screen.

10. To create another assessment, repeat Step 4 through Step 9. Otherwise, click **Exit**.
    To enter the data, follow the steps described in “Populating the Risk Assessment”.

### Populating the Risk Assessment

Once the risk assessment is created for the entity, you can begin to enter data or edit information associated with the risk assessment. The data that you enter combined with the calculations that Audit Leverage performs on that data helps determine if the entity's risk factor warrants an audit for the plan year.

**Note:**
You can change your risk criteria from one year to the next without affecting any historical data.

If you are editing an existing risk assessment, enter the new data in the tabs. You can change any field in an existing risk assessment except the auditable entity, plan year and project type. If you want to edit an assessment for another plan year, change the value in the Plan Year scrolling list box, and then use the Quick Search field to find the desired risk assessment.

### How to Populate the Risk Assessment

To populate the risk assessment, perform the following steps:

1. In the **Quick Search** field, select the entity for which you just created a risk assessment.
Risk Assessments

The screen changes to reflect the data for the selected entity.

Entering Information in the Tabs

The rest of the information can be entered in the tabs that are included in the bottom portion of the page. Detailed descriptions for each of these tabs can be found in the following sections:

- “Details Tab”
- “Summary Tab”
- “Details Tab”
- “Comments Tab”
- “Planning Tab”
- "Assessments Tab"
- “History Tab”

Details Tab

Although the **Summary** tab appears first on the screen, you must enter information in the **Details** tab first before you can continue entering data in the other tabs. Therefore, the **Details** tab is described first.

The **Details** tab allows you to enter the risk rating and weight information for each risk category related to the entity. The options displayed on this tab are based on the risk criteria, risk categories, risk ratings and weights set up in Module G. The risk criteria appearing on this screen relates directly to the entity type for the entity. When you click on the **Details** tab, the view changes to display the appropriate fields, as shown in Figure 24.
How to Enter Data in the Details Tab

To enter data in the Details tab, perform the following steps:

1. In the Risk Rating scrolling list box, select the rating for the selected risk criterion.

   Although a weighting already appears in the Weight field, you can change it if desired for a particular risk assessment.

2. If necessary, in the Weight field, enter the desired weight to be given to this risk criteria. You can enter this value as a percentage or a decimal value.

   As you enter values in the Risk Rating field, the values in the Weighted Average Score field and the corresponding weight percentage total change to reflect the risk scores.

Figure 24: Details Tab
Risk Assessments

3. In the **Detailed Comments** field, enter any comments you want to include about the risk criterion.

4. Repeat Step 1 through Step 3 for each risk criteria used for this risk assessment.

Summary Tab

The **Summary** tab provides a synopsis of some of the information entered and calculated on the other risk assessment tabs, and allows you to determine if the risk assessment should be placed on the audit plan. When you click on the **Summary** tab, the view changes to display the appropriate fields, as shown in Figure 25.

**Figure 25: Summary Tab**

As shown in Figure 25, the risk scores for the selected entity are displayed on the screen. If the entity uses more than one risk criteria grouping, the weighted
Summary Tab

The risk groups are shown in the **Risk Criteria Grouping** column. The total weighted average score and the sum of the weights entered in the Details tab for each risk grouping is also shown.

On this tab, the auditor may choose to adjust the system-calculated weighted average score by adding or subtracting points in the **Add/Subtract Risk Points** field. This allows the auditor’s judgment to modify the final scoring of this entity. So, if you feel that factors not represented in the risk criteria should have a material affect on the decision of placing this entity on the audit plan, you can use this field to increase or decrease the score manually.

Once the final score is determined and the entity’s score is compared to other entity scores for the year, the department determines which entities are to appear on the final audit plan for the year. If an entity is placed on the audit plan, you then indicate how many budgeted auditor hours you want to allocate to this entity's audit for this year. The budgeted hours for each entity, when totalled, must agree with the number of auditor hours available for the plan year.

**How to Enter Data in the Summary Tab**

To enter data in the **Summary** tab, perform the following steps:

1. If necessary, in the **Add/Subtract Points** field, enter the number of points you want to add or subtract. To subtract points, enter a negative number.

   **Note:**
   
   You may want to explain your decision to add or subtract points in the **Comments** tab.

   Based on the total risk score after adding or subtracting points, determine if the entity should be added to the audit plan.

2. In the **Do you want to place this entity on the audit plan** list box, select the appropriate value.

3. In the **Planned Time of Year** scrolling list box, select the appropriate value.

   Default values are months of the year. The value entered in the **Planned Time of Year** field appears in the Project Set-up screen. For more information on the Project Set-up screen, refer to Chapter 11: “Creating An Audit Project”.

score is a total of the scores for each grouping. For information on creating these scores, see the “Details Tab” section.
4. In the **Priority** field, select the priority of this entity’s audit relative to other entities. This value entered in the **Priority** field is displayed on the Audit Project Setup screen.

**Note:**

The values selected in Step 2 through Step 4 can be modified in Module G. For detailed information, refer to “Entry Creation Example” in Chapter 27: “Module G: Table Settings”.

5. If you need to include any file attachments to the risk assessment using the File Attachments (if any) box, refer to “How to Add Attachments” in Chapter 19: “Working With the Audit Program Collection”.

6. In the **Audit Office** column of the **Planning Hours** table, select the audit office assigned to perform either the complete audit, or a portion of it.

7. In the **Hours Planned** column of the **Planning Hours** table, enter the number of hours you expect to devote to this portion of the audit.

As you enter hours in the **Hours Planned** column, the total hours shown in the **Preliminary Budget Hours** field changes to reflect the sum of hours entered in the table. This automatic sum replaces any value manually entered in the field.

8. If desired, in the **Comments** column of the **Planning Hours** table, enter any additional comments about this portion of the audit.

9. Repeat Step 6 through Step 8 for each audit office expected to be involved in the complete audit.

**Comments Tab**

The **Comments** tab allows you to enter comments relating to the overall risk assessment. From the **Comments** tab you can also navigate to the Module G to edit the table settings related to risk assessment. When you click on the **Comments** tab, the view changes to display the appropriate fields, as shown in Figure 26.
The Planning tab allows you to view planned audit projects for the selected entity for all audit offices. You can also view the date of the last audit report issued for the entity, the expected frequency of audits, and the expected target date for the next audit based on the date the last audit report was issued.

Once you have made entries in the Summary, Details and Comments tabs, the Planning tab presents a summary of some of this data. All of the data on this tab is read-only. When you click on the Planning tab, the view changes to display the appropriate fields, as shown in Figure 27.
Figure 27: Planning Tab

The top window in the tab displays the audit office assigned to the planned audit, as well as the hours budgeted for each office. **The Tot. Hrs for Assessment** column shows the total budgeted hours for all audit offices assigned to this entity for this year. Since this total refers to all hours for this year’s assessment, the value is repeated for each entry for that year. Entries for all audit offices ever assigned to audit this entity are also displayed with their corresponding plan years and hour totals.

The bottom window of the tab displays the date when the next audit should take place, based on the parameters entered in the **Audit Frequencies** table, as described in the “Audit Frequencies” section in Chapter 6: “Setting Up a Risk Assessment.” The last report date used in this calculation is the most recent Report Date found in the milestone date fields on the Audit Project Set-up screen of Module B.
Assessments Tab

The Assessments tab allows you to view summary information about risk assessments for this entity over all entered years. Audit Leverage uses data from the Summary and Comments tabs, including planning year, auditable entity and project type from the main portion of the screen; weighted average, manual points added/subtracted, decision to place on audit plan, and preliminary budget estimate from the Summary tab; and overall comments from the Comments tab. All information shown in this tab is read-only. When you click on the Assessments tab, the view changes to display the appropriate fields, as shown in Figure 28.

Figure 28: Assessments Tab
**Risk Assessments**

**History Tab**

The **History** tab allows you to view all audit projects initiated for this entity over time. The **Project Set-up Screen** button allows you to up to the Project Set-up screen and get a detailed view of and edit the information shown on this tab. For detailed information on setting up an audit project, see Chapter 11: “Creating An Audit Project”. All information shown in this tab is read-only. When you click on the **History** tab, the view changes to display the appropriate fields, as shown in Figure 29.

![Figure 29: History Tab](image-url)
Viewing Summary Information

From the Auditable Entity Risk Assessment screen, you can view a summary of the working draft of the audit plan, which displays risk assessment information for all entities risk assessed for the current year.

How to View Summary Information

To view summary information about the audit plan, perform the following steps:

1. From the Auditable Entity Risk Assessment Screen, click the View Summary Chart for This Year button.

The Summary Working Draft of the Audit Plan screen appears, as shown in Figure 30.
Risk Assessments

Deleting a Risk Assessment

If you have the proper permissions, you can delete an existing risk assessment. Once you delete a risk assessment, you cannot retrieve that information; there is no undo.

How to Delete a Risk Assessment

To delete a risk assessment, perform the following steps:

1. Ensure that the year shown in the Plan Year field displays the year for the risk assessment you want to delete.

2. In the Quick Search scrolling list box, select the entity related to the risk assessment you want delete.
3. Ensure that the year shown in the Plan Year field displays the year for the risk assessment you want to delete.

4. Click the Delete this Risk Assessment button.

5. Repeat Step 1 through Step 4 for each risk assessment and planning year you want to delete.

**Spreadsheet View**

You can view the risk assessment data normally found in the Details tab in a view similar to a spreadsheet instead of using the tab view. When using spreadsheet view, note that data for all risk assessments are shown.

**How to View Risk Assessments in Spreadsheet View**

To view risk assessments in spreadsheet view, perform the following steps:

1. From the Risk Assessment screen, click the Spreadsheet button.

2. Click the button again to return to tab view.

**Copying Risk Assessments**

Once you have set up a risk assessment for a particular year, entity and project type, you can copy either the structure of the risk assessment or both the structure and data from one year to another. Audit Leverage also gives you the option of copying all risk assessments from a particular year to another year.

**How to Copy a Risk Assessment to a Different Year**

To copy an existing risk assessment and its data from one plan year to another plan year, perform the following steps:

1. Click the Copy Risk Assessment... button.
Risk Assessments

The Risk Assessment Copier Wizard appears on the screen containing data from the currently selected risk assessment, as shown in Figure 31.

![Risk Assessment Copier Wizard](image)

**Figure 31: Risk Assessment Copier Wizard**

2. If necessary, in the **Select Year** scrolling list box, select the year of the risk assessment you want to copy.

3. If necessary, in the **Select Entity** scrolling list box, select the name of the entity whose risk assessment you want to copy.

4. If necessary, in the **Select Project** scrolling list box, select the project type of the risk assessment you want to copy.

**Note:**

If you are copying all risk assessments for a specific plan year, select only the **Project Year**.

If you make changes in the selections, the information in the Wizard box changes to reflect the selected year, entity and project.

5. In the **Copy to Year** scrolling list box, select the plan year to which you want to copy this risk assessment.

6. If you want to also copy the risk assessment scores, ensure that the **Copy Scores?** checkbox is selected, otherwise deselect it.

7. If you want to copy only the selected risk assessment, select the **Copy Selected Risk Assessment** radio button, or if you want to copy all risk assessments for the selected year, select the **Copy All Risk Assessment for Selected Year** radio box.

8. Click the **Copy** button.
Copying Risk Assessments

A message box appears, prompting you to verify your selections.

9. Select **Yes** to verify your selections and to copy the assessment(s), or **No** to cancel the action.

   A message box appears confirming that the operation was completed successfully.

10. Click **OK**.

11. If you want to copy another assessment, repeat Step 1 through Step 10.

12. Click **Exit** to return to the Risk Assessment Screen.
Risk Assessments
Creating An Audit Entity

The Audit Leverage audit universe contains all of a department’s auditable entities. Auditable entities are the subjects of your audits, and they must be created before you can create a project.

This chapter describes the steps to create, view, modify and delete entities. This chapter contains the following sections:

- “The Auditable Entity Profile Screen”
- “The Main Tab”
- “The Comments Tab”
- “The Attachments Tab”
- “The History Tab”
- “The Miscellaneous Tab”

The Auditable Entity Profile Screen

The Auditable Entity Profile screen allows you to enter and modify a variety of information about a specific entity. The Auditable Entity Profile screen is shown in Figure 32.
On the Auditable Entity Profile screen, there are two main areas:

- **Entity Identification, Search, Filter and View**—The top section of the screen contains fields for identifying the entity, quick searching entities, indicating data filters, and displaying entities in spreadsheet view.

- **Entity Display**—The bottom section of the screen contains tabs with entity information. It displays one entity at a time.

Before you create an entity, you should obtain and be familiar with your department’s guidelines regarding the fields to be populated, and any standards about field entries.

There are also a number of actions that you can perform on this screen regardless of the selected tab, including searching for an entity, displaying entity information, and deleting entities.
How to Create an Audit Entity

To create an entity, perform the following steps:

1. From the main Module A screen, click **Update the Audit Universe (List of Auditable Entities)**.

   ![Auditable Entity Profile screen](image)

   The Auditable Entity Profile screen appears as shown previously in Figure 32.

2. In the **Record Navigator**, click the **New Record** button.

   ![New Record button](image)

3. In the **Entity #** field at the top of the screen, type a unique number for the entity. Up to ten digits are allowed.

4. In the field below the **Entity #** field, type a unique name for the entity.

How to Quick Search, Display and Delete Entities

To perform other actions independent of the tab you are viewing, perform the following steps:

**Quick Search and Display Entities**

1. In the **Quick Search** scrolling list box at the top of the screen, click on the drop-down arrow.

2. In the list that appears, use the vertical scroll bar to find the desired entity.

3. With the mouse cursor, highlight and click on the entity name.

   The data for the selected entity is shown on the screen.

4. Click on the tabs to display information in form view.

5. Navigate between entities using the record navigator buttons at the bottom left of the screen.

**Display Entities in Spreadsheet View**

1. Click the **Spreadsheet View** button to display data on all entities in spreadsheet view.
Creating An Audit Entity

Microsoft Access functions can be performed in spreadsheet view, such as entering, changing and deleting data, sorting and filtering data, hiding columns, sizing columns and rows, and printing.

2. To return to form view, use the menu option View > Form View.

Delete an Entity in Form View

1. To delete an entity in form view, click on the Delete this entity button.

Delete an Entity in Spreadsheet View

1. To delete an entity in spreadsheet view, click on the gray box to the left of the Location Number field on the line containing the project of interest.

2. Press the keyboard’s Delete key.

Important:

Audit Leverage does not allow deletion of entities when related records, such as audit history, exist in the database. In order to delete an entity, the dependent records, such as risk assessments, audit workpapers and projects, must be deleted first.

Entering Information in the Tabs

The rest of the information can be entered in the tabs that are included in the bottom portion of the page. Detailed descriptions for each of these tabs can be found in the following sections:

• “The Main Tab”
• “The Comments Tab”
• “The Attachments Tab”
• “The History Tab”
• “The Miscellaneous Tab”
The Main Tab

The **Main** tab contains the most commonly referenced entity information. When you first enter the Auditable Entity Profile Screen the **Main** tab is shown by default, as shown in Figure 33.

**Figure 33: Auditable Entity Profile Screen - Main Tab**

**How to Enter Data on the Main Tab**

To enter data in the **Main** tab, perform the following steps:

1. In the **Entity Long Name** field, enter the full entity name as you want it to appear on the engagement letter and audit report.

The **Company**, **Group** and **Subgroup** fields represent the organizational hierarchy to which the entity belongs. Company is the highest level...
Creating An Audit Entity

organizational unit, with group and subgroup representing the next two levels down the hierarchy.

2. In the **Company** scrolling list box, select the company to which the entity belongs.

3. In the **Group** scrolling list box, select the group of the company to which the entity belongs.

4. In the **Subgroup** scrolling list box, select the subgroup of the group to which the entity belongs.

5. In the **Country** field, enter the country in which the entity resides.

6. In the **Region** scrolling list box, select the region in which the entity resides.

7. In the **Physical Address** field, enter the entity's street address.

8. In the **City** field, enter the name of the city in which the entity resides.

9. In the **State** scrolling list box, select the state or province in which the entity resides.

10. In the **Zip** field, enter the zip or postal code for the entity's address.

11. In the **Primary Contact** fields, enter the last name of the entity's main contact in the first field, followed by the first name in the second field.

The **Description** field holds permanent reference information, including the entity's auditable activities, relationship to other entities, etc.

12. In the **Description** field, enter a description of the entity.

The **History of External Reviews** table holds references to audits conducted by external auditors, regulatory agencies, etc.

13. In the **Month** field, enter the two-digit number representing the month in which the review was conducted.

14. In the **Year** scrolling list box, select the year in which the review was conducted.

15. In the **By Whom** scrolling list box, select the external audit group that conducted the review.

    If the external auditor is not listed, you can enter the name directly in the field.

16. In the **Comments** field, enter a description of the purpose of the external review.
17. In the **File Attachment** field, link or embed the external audit report, as described in the “How to Add Attachments” section.

18. If the entity is still actively audited, ensure that the **Still Active?** checkbox is selected. Otherwise, deselect it.

19. In the **Audit Office** scrolling list box, select the audit office that typically audits the entity.

20. In the **Typical Project Type** scrolling list box, select the type of project most often conducted when this entity is audited.

**Note:**
Placing values in the **Audit Office** and **Typical Project Type** fields does not exclude audits by other audit offices, or audits of other project types for the entity. These fields identify the audit office that most often audits the entity, and the type of project most frequently conducted. When a project is created for the entity, these field values are copied to corresponding fields on the Project Set-up screen. However, they can be changed for a particular audit if they do not apply.

21. In the **Business Division** scrolling list box, select the business division to which the entity belongs.

22. In the **Entity Type** scrolling list box, select the entity type that most closely describes the entity.

**Important:**
The entity type selected may directly affect the risk factors available when conducting risk assessment for the entity. See Chapter 6: “Setting Up a Risk Assessment” for more information.

The **Hours Typically Needed for Full Scope** table holds the names of audit offices, and the respective hours required of each office when a full-scope audit of the entity is conducted.

23. In the first field of the table, click on the drop-down arrow and select an audit office.

24. In the field immediately to the right, type the number of hours the audit office devotes to a typical audit of the entity.

25. If necessary, repeat Step 23 and Step 24 on subsequent lines of the table for each audit office involved in a full-scope audit.
Creating An Audit Entity

Audit Leverage calculates the total hours and displays them in the **total for this audit entity** field.

The Comments Tab

The **Comments** tab contains a text box for entering any information not captured on other tabs. It also contains read-only fields reflecting the date the entity was created, the date it was last modified, and by whom, as shown in Figure 34.

![Figure 34: Auditable Entity Profile Screen - Comments Tab](image)

The Attachments Tab

The **Attachments** tab holds the entity's permanent file attachments, sometimes referred to as a “perm file.” The entity's organizational chart, driving directions, biographies of key managers, etc. are examples of files typically stored on the Attachments tab. See Figure 35.
The History Tab

Figure 35: Auditable Entity Profile Screen - Attachments Tab

Note:
The Attachments tab holds entity-specific information, not audit-specific workpapers or file attachments. Creating audit workpapers is described in Chapter 19: “Working With the Audit Program Collection”.

For steps regarding how to create a file attachment, see “How to Add Attachments” in Chapter 19: “Working With the Audit Program Collection”.

The History Tab

The History tab displays read-only information on the entity’s audit history, presenting a list of all projects ever initiated for the entity, regardless of completion status. Audit Leverage draws data from the Project Set-up area of
Creating An Audit Entity

Module B to display each project on a separate line in datasheet view, as shown in Figure 36.

![Figure 36: Auditable Entity Profile Screen: History Tab](image)

Although the data on the **History** tab is read-only, this screen provides a method to move to the Project Set-up screen to edit the data.

**How to View Projects**

To view the projects, perform the following steps:

1. Use the horizontal scroll bar to move right and left to view all of the records' data.

2. If the project list exceeds the viewable area, use the vertical scroll bar to view all of the records. You can also click on the record navigator buttons to move the highlight bar up and down the project list.

3. If necessary, click and drag column and row borders to resize them.
The Miscellaneous Tab

**How to Modify Project Data**

To view the Project Set-up screen for a particular project to edit the data, perform the following steps:

1. Select the project by clicking on the gray box to the left of the **Year** field on the line containing the project of interest.
2. Click the **Go to Audit Set-Up Screen** button.

For detailed information on Project Set-up, see Chapter 11: “Creating An Audit Project”.

The Miscellaneous Tab

The Miscellaneous tab—abbreviated on the screen as Misc.—holds other information not stored on the Main tab. The Misc. tab is shown in Figure 37.

![Figure 37: Auditable Entity Profile Screen - Miscellaneous Tab](image)

**How to Enter Data on the Miscellaneous Tab**

To enter data in the Misc. tab, perform the following steps:

1. In the **Entity Size** scrolling list box, select an entry representing the entity's size as compared to other entities in the audit universe.
Creating An Audit Entity

2. In the **Revenues** field, enter the annual revenues generated by the entity (if applicable).

3. In the **External Audit Requirement** scrolling list box, select the type of audit required when the entity is externally audited.

4. In the **Phone Number** field, enter the entity’s telephone number.

5. In the **Fax Number** field, enter the entity’s fax number.

6. In the **E-mail Address** field, enter the e-mail address of the primary contact person at the entity.

7. In the **I.T. Contact** field, enter the name of the information technology contact person at the entity.

8. In the **Site/General Manager** field, enter the name of the site or general manager at the entity.
Section 3

Module B: Project Management and Timekeeping
Module B Overview

Module B contains all of the operations needed to create audit programs, audit schedules, timekeeping, comparisons of audit hours to budgeted time, and time summaries grouped by various criteria.

From Module B you can also perform a comprehensive search on your data.

To access the functions of Module B, from the Audit Leverage Main screen, click the Project Management and Timekeeping button.

The Module B screen appears, as shown in Figure 38.
Module B Overview

Figure 38: Module B Screen

The following selections are available in Module B:

- Audit Project Set-up
- Branches Visited
- Search Your Database
- Visual Scheduler
- Auditor Timesheets
- Budget vs. Actual Audit Hours
- Time Summaries

The following chapters describe these topics.
Planning Projects and Budgets

In Audit Leverage, audit projects are the hub of day-to-day audit activity. All audit work is tied to projects, including file attachments, findings, review notes, and audit reports. Project budgets track hours allocated to projects, and compare them to actual hours charged to them by auditors.

This chapter covers the following questions that you should answer to plan your projects and budgets in Audit Leverage:

• **Defining Projects and Budgets**
  — What is a project?
  — What audit and non-audit projects do you want to create?
  — What is a budget?
  — How do you want to set up your budgets?

• **Defining Projects and Budgets in Audit Leverage**
  — How does Audit Leverage help you to describe your projects and budgets?

• **Project and Program Sign-offs**
  — What is a sign-off?
  — What effect do sign-offs have?

• **Engagement Letters**
  — Do you want Audit Leverage to automatically generate engagement letters for projects?
  — Do you want to use an existing format, or have one customized for your department?
  — If you want to use an existing format, should you edit any of the standard text or field references?
Planning Projects and Budgets

- **Reporting and data analysis considerations**
  - What reporting and data analysis needs do you have which drive your choices of fields to populate?

- **Establishing your department’s conventions**
  - What Audit Leverage fields should you use to describe your projects and budgets?
  - What conventions should you establish for identifying projects through the key fields?
  - For the non-key fields, what possible values or data entry conventions do you want to establish?
  - What sign-offs does your department want to use?
  - What engagement letter format, if any, does your department want to use?

Your department should take the time to discuss the questions listed above, and strategize about possible conclusions. This is a crucial first step toward a successful Audit Leverage implementation.

This chapter contains the following sections designed to assist you in this process:

- “Defining Projects and Budgets”
- “Defining Projects and Budgets in Audit Leverage”
- “Project and Program Sign-Offs”
- “Engagement Letters”
- “Reporting and Data Analysis Considerations”
- “Establishing Your Department’s Conventions”

**Defining Projects and Budgets**

**What is a project?**

- A project represents an audit of an entity. A project is uniquely identified by a project ID and plan year, and described by fields used to capture general project details, background, objective, scope, staffing, milestone dates, programs to be conducted, and, if applicable, locations to be visited. Audit Leverage can automatically generate an engagement letter for the project, and after the gathering of findings, generate an audit report.
Defining Projects and Budgets

- A project can also represent any other non-audit activity to which auditors charge time. This includes things like training, staff meetings, sick time, vacation, holidays, and any other activities for which you want auditors to record their time. Non-audit, or administrative projects, are typically defined with the name of the activity in the Project ID required field. It is not necessary to populate any of the other fields on the Project Set-up screen, since the remaining fields are designed to describe audit projects. Administrative projects can be created once and used perpetually through subsequent years, or they can be recreated for each plan year.

What audit and non-audit projects do you want to create?

If your audit department uses Audit Leverage’s timekeeping component, then you may want to set up both audit and non-audit, or administrative, projects.

Note:

Make a list of the types of audit and non-audit projects your department wants to create in Audit Leverage.

What is a budget?

A budget represents the number of auditor hours allocated to a specific project. Hours can be tracked as a lump sum, or broken out by phase or cycle of the audit. As auditors charge time to a project, Audit Leverage automatically calculates hours charged, variances against budget, and percentage of budget spent, both in total and by phase. Budgets can be revised. When present, revised figures are used in the automatic calculations.

How do you want to set up your budgets?

Decide if your department wants to use Audit Leverage’s budgeting feature. If the answer is yes, determine if you want lump sum auditor-hour budgeting, or if budgets should be detailed by phase or cycle of the audit. If phase or cycle budgeting is chosen, make a list of the phases or cycles against which you want to budget, and to which you want auditors to charge time.

Note:

Budgeted hours can be broken out by cycle. In addition, auditors can charge time against cycles in the Timekeeping tool. Module B Time Summaries can be generated based on cycle. However, the Budget-to-Actual Hours Comparison screen does not display budgeted or actual hours related to cycles.
Defining Projects and Budgets in Audit Leverage

How does Audit Leverage help you to describe your projects and budgets?

Projects

Audit Leverage helps you define your projects through fields on the Project Set-up screen in Module B, as shown in Figure 39.

Figure 39: Audit Project Set-up Screen

The Project Set-up screen contains nine tabs. Audit projects are defined by populating the key fields, Audit Project ID and Plan Year, and various fields on the nine tabs. Your department management should study the fields on these tabs and ask the following questions:
Defining Projects and Budgets in Audit

- How do you want to describe your audit projects? Consider fields related to:
  - General project information
  - Staffing
  - Programs to be conducted
  - Scheduling of project milestone dates
  - Background, objective and scope of the audit
  - Branches visited
  - Sign-offs to be employed at the overall project level and individual program level

- What fields are important to use in accurately describing your entities?
  The answers to these questions determine what attributes are important and what fields your department wants to populate.

  For a description of the fields on the Project Set-up screen, see Appendix C: "Appendix - Module A, B & C Fields".

Budgets

Audit Leverage helps you define your budgets through fields on the Budget-to-Actual Hours Comparison Screen spreadsheet view in Module B, as shown in Figure 40.
Planning Projects and Budgets

The budget screen contains six columns. Budgets are initially defined by populating the Hours Budgeted cell with a total number of auditor hours devoted to the project. If you want to break that total down by phase or cycle, create a new row for each phase or cycle to which you assign hours. Your department management should study the fields on this spreadsheet and ask the following questions:

- Do you want to track audit budgets?
- If so, do you want to track budget hours in a lump sum, or do you want to create line items by phase or cycle of the project?
- Do you want to revise your budget as necessary throughout the life of the project?

The answers to these questions determine what fields are important and how you want to build your budgets.
Once a budget is created and auditors begin charging time to the project's budget, the Budget-to-Actual Hours Comparison screen in Module B displays a budget analysis, as shown in Figure 41.

![Budget-to-Actual Hours Comparison](image)

**Figure 41: Budget-to-Actual Hours Comparison Screen**

### Project and Program Sign-Offs

**What is a sign-off? What effect do sign-offs have?**

The Project Set-up screen contains two sign-off areas:

- **The Sign-Offs tab:** The preparer and reviewer fields allow auditors to sign-off on the project as a whole. In low security mode, when a project is signed off by a preparer, all project data becomes read-only to the signer and all other users except those reviewers yet to sign off. In addition, all dependent audit data, including programs, audit steps, attachments, and findings, also becomes read-only to all users except those project reviewers yet to sign off.
Planning Projects and Budgets

Therefore, project-level sign-offs should only be applied at the end of the project when all associated audit work is complete.

- The **Program Set-up** tab, **Sign-Offs** sub-tab: Preparers and reviewers can also sign off on individual programs. In low security mode, when a program is signed off by a preparer, all program data including all of its steps become read-only to the signer and all users except those reviewers yet to sign off. Therefore, program-level sign-offs should only be applied when the all steps in the program is completed. Those users with administrator security rights can select an option requiring that all individual audit steps be signed off before a program can be signed off. This option prevents premature locking of program data before all steps have been individually signed off.

**Note:**
Sign-offs are optional, and the number of sign-offs applied is flexible. Decide with your department leadership if project and/or program-level sign-offs should be applied, which auditors should be authorized to perform these sign-offs, and when they should be applied.

For instructions on how to perform sign-offs as well as an explanation of the differences of high security mode, see Chapter 3: “The Sign-Offs Tab and Record-Level Security”.

Engagement Letters

**Do you want Audit Leverage to automatically generate engagement letters for projects?**

Audit Leverage can automatically generate an engagement letter for each project. This letter combines data from fields on the Project Set-up screen with standard text supplied in the software. You can choose from a number of engagement letter formats.

**Do you want to use an existing format, or have one customized for your department?**

You can choose to generate an engagement letter from one of the existing formats supplied with the software. Or, you can design your own letter and submit the specifications to IAD Solutions for customization into the software. Alternatively, if someone in your department has Microsoft® Access report design skills, he or she can create a custom report format for inclusion in the software. If you desire a customized solution, contact Audit Leverage support for guidance.
If you want to use an existing format, do you need to edit any of the standard text or field references?

The standard text and field references used in the existing engagement letter formats can be changed on a project-by-project basis. See “Creating An Engagement Letter” in Chapter 10: “Planning Projects and Budgets” to generate and edit the engagement letter. Also, the engagement letter text and field references can be permanently changed for all projects in Module G. If you want to change or add new field references, IAD Solutions recommends that your Audit Leverage system administrator contact support for assistance in identifying new fields.

The engagement letter formatting can also be permanently changed. However, only someone with Microsoft Access expertise should attempt this procedure. Since this is a front-end database change, any changes you make are overwritten when you upgrade. Therefore, you should save the changed form to an Access database file outside of Audit Leverage so you can import it into the software again after an upgrade. Any modified front-end database file must be redistributed to all machines for those changes to be available to all users.

Note:
Examine the engagement letter options by clicking the Create or edit engagement letter button on the Main tab of the Project Set-up screen. Decide if your department wants to generate engagement letters from within Audit Leverage. If you do, determine if one of the existing formats can be used with or without customization in Module G. Or, determine if you want to create a customized format.

Reporting and Data Analysis Considerations

What reporting and data analysis needs do you have which drive your choices of fields to populate?

After you have explored the Project Set-up and Budget-to-Actual Hours Comparison screens, your department management should consider its reporting requirements. Consider by what project and budget characteristics you want to aggregate data when analyzing your audit history. For example:

• Do you want to analyze the results of all audits of a particular type, such as all financial audits? Or all operational audits? If so, for each project, populate the project type field to enable data analysis by project type.
Planning Projects and Budgets

• Do you want to report on all audits that were rated at a specific overall rating level or below? If so, at the end of each project, populate the overall rating field.

• Do you want to search for projects using certain keywords in the background, objective, or scope of the audit? If so, populate one or all of those fields in a consistent manner.

• Do you want to search for projects based on the presence of certain milestone dates, or in a certain project status? If so, populate the milestone dates on a frequent and consistent basis so you can report on projects that have reached certain milestones. Or, update the project status field regularly so you can perform aggregate reporting on all projects in a certain status.

• Do you want to budget and/or keep auditor time by phase or cycle? If so, set up each budget to reflect the phase or cycle detail. Cycles and phases must first be defined in Module G before you can use them in budgets.

Once you have considered questions like these, and explored the Project Set-up screen and Budget-to-Actual Hours Comparison screen, navigate to the Search Your Database tool to understand your searching and data analysis capabilities in Audit Leverage. See Chapter 12: "Working With Search Your Database" for more information on this tool.

Note:

After researching the Project Set-up screen fields, the Budget-to-Actual Hours Comparison screen, the Search Your Database tool and other reports in Audit Leverage, make a list of the project and budget fields you want to use.

Establishing Your Department’s Conventions

Once you have determined the project and budget screen fields you want to use, your department must establish its conventions and convey them to those responsible for creating and maintaining projects and budgets. To establish your conventions, answer the following questions and perform the corresponding steps:

What Audit Leverage fields do you plan to use to describe your projects and budgets?

• Make a list of all Audit Leverage fields your department plans to use in defining projects and budgets, including the key fields marked by an
Establishing Your Department’s

asternisk. It may be helpful to screen print the tabs of the Project Set-up screen and the Budget-to-Actual Hours Comparison screen and mark them.

What conventions should you establish for identifying entities through the key fields?

• Decide if the Project ID field must follow any specific pattern, such as the last two digits of the plan year, combined with a hyphen and a sequential number. Project IDs must be unique.

For the non-key fields, what possible values or data entry conventions do you want to establish?

• For every scrolling list box you intend to use, determine the possible entries that should appear when the user clicks the arrow. Enter these values in the corresponding Module G tables. See Chapter 27: “Module G: Table Settings” for instructions on how to populate the Module G tables.

• For every other type of field, establish conventions for data population to make entries consistent, and therefore more meaningful, across projects and budgets.

For example, if you want to use the Objective field on the Objective tab, establish guidelines as to what type of information should be entered. If you want to use the File Attachments field on the Main tab, establish guidelines as to what kinds of files should be attached, whether or not they should be attached for every project, and whether or they should be linked or embedded.

Note:
Ensuring data entry consistency enables you to perform more effective data analysis through Search Your Database and other tools.

• Determine if there are any fields that you want to redefine for use other than the way in which they are labeled. Your department can use Audit Leverage fields in any way it wants. Care must be exercised, however, in redefining the meaning of fields, because some fields are used in reports and queries elsewhere in the software. Research the reports and queries in the software before publishing any changes to the use of fields other than that implied by the field label.

What sign-offs does your department want to use?

• Decide if your department should employ program and/or project sign-offs, and if so, who the preparers and reviewers in your department should be.
Planning Projects and Budgets

What engagement letter format, if any, does your department want to use?

- Decide if your department wants to generate engagement letters to auditees from within Audit Leverage. If so, determine if you want to use one of the existing engagement letter formats, customize one of them, or develop your own for inclusion in the software.
Creating An Audit Project

An audit project represents an audit of a specific entity in a specific plan year. In Audit Leverage, all audit-related data is associated to projects. Therefore, the project represents the cornerstone of audit activity.

Every project contains data about the entity audited, the type and status of the audit, the staff assigned, the timetable and priority of the audit, audit programs conducted, background, objective and scope, locations visited, and the engagement letter.

Before creating a project, you should obtain and be familiar with your department's guidelines regarding which fields are to be populated, and standards about field entries.

This chapter describes the steps to create, view, modify and delete audit projects. This chapter contains the following sections:

- “The Project Set-up Screen”
- “The Main Tab”
- “The Staffing Tab”
- “The Sign-Offs Tab”
- “The Program Set-up Tab”
- “The Milestones Tab”
- “The Background Tab”
- “The Objective Tab”
- “The Scope Tab”
- “The Branches Visited Tab”
Creating An Audit Project

- “Updating Projects”
- “Closing Projects”

The Project Set-up Screen

To view the Project Set-up screen, from the main Module B screen, click Audit Project Set-up.

The Project Set-up screen appears as shown in Figure 42.

Figure 42: Project Set-up Screen

On the Project Set-up Screen, there are two main areas:
The Project Set-up Screen

- **Project Search and Filter**—The top section of the screen contains:
  - The **Quick Search** field for finding projects
  - A check box called “**Showing SYD Results?**.” A check in the box indicates that the set of projects displayed are the result of a Search Your Database search
  - A “**Remove Data Filtering**” button to remove the data filter (resulting from an SYD search or a Quick Search) and show all projects, beginning with the first one in the database.

- **Project Display**—The bottom section of the screen contains tabs with project information. It displays one project at a time. The record navigator bar at the bottom of the screen, as shown below, allows the user to navigate from project to project no matter which tab is selected.

```
Record: 12345 of 356
```

**How to View Project Information**

To view information for an existing project, perform the following steps:

1. In the **Quick Search** scrolling list box at the top of the screen, click on the drop-down arrow.

   ![Quick Search dropdown](image)

   The Enter Parameter Value dialog box appears:

   ![Enter Parameter Value](image)

   You can limit the list to projects involving a specific entity, or you can leave the field blank to get a complete list of projects.

2. Enter the first few letters of the entity name in the input field.

3. Click **OK**.

4. In the list that appears, use the vertical scroll bar to find the project of interest.
Creating An Audit Project

5. With the mouse cursor, highlight and click on the project. The data for the selected project is shown on the screen.

6. Click on the tabs to display information in form view.

How to Create an Audit Project

To create a project, perform the following steps:

1. If necessary, click the Main Tab.
2. Click the Create New Project button in the upper right corner of this tab.

A blank Project Set-up screen appears. Some fields are already populated with default entries.

Entering Information in the Tabs

You enter the rest of the information in the tabs included in the bottom portion of the page. Detailed descriptions for each of these tabs can be found in the following sections:

- “The Main Tab”
- “The Staffing Tab”
- “The Sign-Offs Tab”
- “The Program Set-up Tab”
- “The Milestones Tab”
- “The Background Tab”
- “The Objective Tab”
- “The Scope Tab”
- “The Branches Visited Tab”

The Main Tab

The Main tab contains general project information, including project identification, plan year, entity audited, certain milestone dates, and staffing
information. When you first enter the Project Set-up Screen, the Main tab is displayed by default, as shown in Figure 43.

![Figure 43: Project Set-up Screen - Main Tab](image)

### How to Enter Data on the Main Tab

To enter data on the Main tab, perform the following steps:

1. In the Audit Project ID field, enter the project identifier.

   The Audit Project ID field may contain any alphanumeric characters, not just numbers. The asterisk next to the field label indicates this is a required field.

   **Important:**

   The project identifier you select should conform to your department's guidelines regarding audit project identification. For audit projects many departments use a combination of the last two digits of the year plus some sequential number.
Creating An Audit Project

2. In the **Plan Year** scrolling list box, select the plan year in which the audit is planned.

   The asterisk next to the field label indicates this is a required field.

3. In the **Auditable Entity** scrolling list box, select the entity being audited.

   **Note:**
   Once the auditable entity is selected, you can click on the blue **Auditable Entity** field label. The Auditable Entity Profile Screen appears, displaying the selected entity. Use the **Close** button to return to the Project Set-up Screen.

4. In the **Audit Title** field, enter the title of the audit as it is to appear in the engagement letter and audit report.

   The **Business Division** scrolling list box may already contain a value. If a value has been entered into Audit Leverage for the entity record, it is displayed. Otherwise, it is blank.

5. If necessary, in the **Business Division** scrolling list box, select a business division to which the entity belongs.

   Changing this value does not change the business division assigned to the entity on the Auditable Entity Profile Screen. To change this assignment, return to that screen and change the **Business Division** field entry as described in Chapter 8: “Creating An Audit Entity”.

   The **Project Type** scrolling list box may already contain a value. If a value has been entered into Audit Leverage for the entity record in the **Typical Project Type** field, it is displayed in this field. Otherwise, it is blank.

6. If necessary, in the **Project Type** scrolling list box, select a project type describing the nature of the project.

   Changing this value does not change the typical project type assigned to the entity on the Auditable Entity Profile Screen. To change this assignment,
return to that screen and change the typical project type field entry as described in Chapter 8: “Creating An Audit Entity”.

7. In the **Project Status** scrolling list box, select the current status of the project.

⚠️ **Important:**

The audit manager or auditor-in-charge should return to this screen throughout the audit to update the project status as appropriate. See “Updating Projects”.

8. In the **Report addressed to** list box, enter the names of one or more individuals at the auditee to whom the audit report is to be addressed. Separate each name with a comma or line return (Ctrl+Enter).

9. Skip the **Overall Rating** scrolling list box.

This scrolling list box is used later in the audit. Refer to “Updating Projects”.

10. In the **Project Source Description** field, enter a detailed explanation of the project source entry.

11. In the **Project Source** scrolling list box, select the party who requested the audit, or the process determining the necessity for the audit.

Examples include the audit committee, rotation plan, and annual risk assessment.

12. If necessary, in the **Project Priority** scrolling list box, select the priority of this audit as compared to other audits planned for the year:

Changing this value does not change priority assigned to the entity on the Auditable Entity Risk Assessment screen (Summary tab), or on the Working Draft of the Audit Plan. To change this assignment, return to the Risk Assessment screen in Module A and change the **Project Priority** field entry as described in Chapter 7: “Risk Assessments”.

13. If necessary, in the **Planned Time of Year** scrolling list box, select the timing of the audit.

Changing this value does not change the planned time of year assigned to the entity on the Auditable Entity Risk Assessment screen (Summary tab) or on the Working Draft of the Audit Plan. To change this assignment, return to the Risk Assessment screen in Module A and change the **Planned Time of Year** field entry as described in Chapter 7: “Risk Assessments”.

14. In the **Comments** field, enter information about the audit, such as justification for the priority and timing of the audit.
Creating An Audit Project

15. The **File attachments (if any)** box can be used to insert any project-related documents. For example, if the final audit report is exported out of Audit Leverage and saved in another application, it can be attached here at the end of the project. The File Attachments box can hold more than one attachment. Once the first attachment is inserted, a right vertical scroll bar appears in the box. Click on the down arrow to find an open spot to insert the next attachment. Repeat as necessary. For instructions on how to insert an attachment, see “How to Add Attachments” in Chapter 8: “Creating An Audit Entity”.

Creating An Engagement Letter

Before creating an engagement letter, ensure that you have made entries in the Engagement Letter - Actual, the Start of Field Work - Planned, and the End of Field Work - Planned milestone fields on the **Milestones** tab. For detailed information on entering data on the **Milestones** tab, see “The Milestones Tab”.

How to Create an Engagement Letter

To create an engagement letter, perform the following steps:

1. From the **Main** tab, click the **Create or Edit Engagement Letter** button.

2. Select one of the engagement letter formats by clicking on the gray box to the left of the format name.

3. Click the **New** button.

   A warning message appears, informing you that if you have previously initiated an engagement letter for this project, and made changes to the letter, these changes are overwritten if you proceed.

   **Note:**
   When you click on **Create or Edit Engagement letter** for the first time, select a letter format and click the **New** button. Once you view and/or edit the letter and exit the screen, Audit Leverage saves that version. If you want to edit the letter at a later time, click on the **Create or Edit Engagement Letter** button. Select the same letter format used before and click the **Edit** button. This preserves your previous work and allows you to continue where you left off before.

4. Click **Yes**.
The Edit Engagement Letter input screen appears as shown in Figure 44.

![Edit Engagement Letter Screen](image)

**Figure 44: Edit Engagement Letter Screen**

5. In the **CC: list** list box, enter the names of those individuals to be copied on the engagement letter.

**Note:**

The **To:**, **Date:** and **Subject:** fields are automatically populated with data drawn from the Project Setup screen. The **To** field is populated from the **Report addressed to** field on the **Main** tab. The **Date** field is populated from the milestone date called **Engagement Letter - Actual**. The **From** field is populated with the name of the Audit Director as entered on the Audit Leverage Main Screen. The **Subject** field is populated from the **Audit Title** field on the **Main** tab. Of these fields, only the subject is editable on the Edit Engagement Letter screen.
Creating An Audit Project

The **Subject** field may already contain a value.

6. If necessary, enter a subject in the **Subject** field.
   
   Edits update the **Audit Title** scrolling list box on the **Main** tab.

7. Use the right vertical scroll bar to examine the paragraphs that follow the subject line.
   
   The default text of these paragraphs is customizable in Module G. Depending on the letter format chosen, several **Main** tab field entries may appear pre-populated into the text, such as the fieldwork dates and staff assigned to the project.

8. Edit each of the engagement letter paragraphs as necessary.

   **Note:**

   Editing the text of the engagement letter on this screen changes the default text for **this project only**. Engagement letters created for other projects are not affected.

9. Click the **Spell Check** button to conduct a spelling check.

10. Click the **Print Preview** button to preview the letter.

11. Use the menu option **File > Print** to output the letter to a printer, or from the **Print Preview** screen, click the printer icon in the Access toolbar.

12. To export the engagement letter to Microsoft Word, click on the **W** icon on the Access toolbar. Or, close the **Print Preview** screen and click the **Export to MS Word** button on the Edit Engagement Letter screen.
How to Edit an Engagement Letter

1. From the Main tab, click the button Create or Edit Engagement Letter.
2. Click on the gray box to the left of the format name to select it.
   Ensure that you select the same format used to create the letter.

   **Important:**
   After an engagement letter has been created with a certain format, that same format must be selected each time the letter is opened. If a different format is selected prior to opening the letter, the letter may not format correctly, and text can be lost.
3. Click the **Edit** button.
4. Edit the fields as necessary.

How to Display and Delete Projects

To display and delete projects, perform the following steps:

1. To delete a project in form view from the Main tab, click on the **Delete this Project** button.

   After you press the delete button, two message boxes appear in succession prompting you to verify your decision to delete the project.
2. Click **Yes** and **OK**, respectively, in the message boxes that follow.
3. Click the **Spreadsheet View** button to display data on all projects in spreadsheet view.
4. Click **OK** in the message box that appears.

   Microsoft Access functions can be performed in spreadsheet view, such as entering, changing and deleting data, sorting and filtering data, hiding columns, sizing columns and rows, and printing.
   To return to form view, use the menu option **View > Form View**.
Creating An Audit Project

5. To delete a project in spreadsheet view, click on the gray box to the left of the Audit Report ID field on the line containing the project of interest.

6. Press the Delete key.

7. Click Yes in the message box that appears.

**Note:**
Audit Leverage does not allow deletion of projects when related records, such as audit steps, findings, or review notes, exist in the database. In order to delete a project, the dependent records must be deleted first.

How to Navigate to Other Modules

From the Main tab, Audit Leverage presents options to navigate to other modules within the product.

- To navigate to the Module C Workpapers main menu, click the Go to Workpaper Module button.

- To display all findings for the project currently displayed on the Project Setup screen, click the Go to Audit Findings button.

- To display the budget for the project currently displayed on the Project Setup screen, click the Go to Budget-vs.-Actual Hours Comparison button.

The Staffing Tab

The Staffing tab allows the project planner to assign auditors, their roles, and dates of their assignments on a project. The Staffing tab data feeds into the Visual Scheduler, a tool that provides visual depiction of projects and auditor assignments. For more information on the Visual Scheduler, see Chapter 13: “Using the Visual Scheduler”. 

120
1. Click the **Staffing** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 45.

![Figure 45: Project Set-up Screen, Staffing Tab](image)

2. In the **Name** scrolling list box, select an auditor to assign to the project.

3. In the **Role** scrolling list box, select a role in which you expect the auditor to function on the project.
Creating An Audit Project

4. In the **Begin Date** field, type a date on which the project work begins.

5. In the **End Date** field, type a date on which the project assignment ends.

6. In the **Site** scrolling list box, select a site that describes the staff person’s location during that time period.

7. If necessary, repeat Step 2 through Step 6 for other time periods and sites for the auditor.

8. If necessary, repeat Step 2 through Step 7 to represent other auditors assigned to the project.

**The Sign-Offs Tab**

The **Sign-Offs** tab allows the preparer and reviewers to sign-off the project. Applying sign-offs also invokes security on the project data as well as all data belonging to the project, including programs, their audit steps and attachment references, findings, and the audit report. Therefore, project-level sign-offs should only be applied when all associated audit work is complete. Sign-offs are optional, and the number of sign-offs applied is flexible.

Click the **Sign-Offs** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 46.

---

**Sites**

When you create an auditor assignment, the **Site** field is populated with a default value of “Assigned.” The other values—**In Office, Vacation, Overnight, Off-site, Multiple Sites, and Training**—allow you to choose a more specific description for the location where the staff member spends time if you want a greater level of granularity. While some site options are self-explanatory, a few are listed below for clarification:

- **In Office** refers to work in the internal audit office.
- **Off-site** refers to work at an auditee site or other location.
- **Multiple sites** refers to work at multiple auditee sites or other locations.

If, for example, on a specific project assignment, a staff person spends a week at the auditee site, and another week in the home office, you could schedule the first week with a Site/Place value of Off-site and the second week with a Site/Place value of In Office. Note, however, that you must create a separate assignment for each different Site/Place value.
For the project, a preparer and up to three reviewers can be designated. Under the low security administration setting, sign-offs are bound by the following rules:

- Preparers and reviewers initially can be selected by any user from the respective scrolling list boxes.
- Users can sign-off only under their own names.
- Users can only delete their own sign-offs, provided that the next level reviewer has not already signed off. They cannot delete other users’ sign-offs.
- The preparer or reviewer names can be changed by any user if the preparer has not signed off.
- Once the preparer signs off, the Project Set-up fields on all tabs become read-only to the preparer and all users except the reviewers. However, the
Creating An Audit Project

reviewer names can still be changed by the preparer and reviewers until those reviewers sign off.

- Once a reviewer signs off, the Project Set-up fields on all tabs become read-only to the reviewer and all users except the higher level reviewers. Until the higher level reviewers sign off, their names can still be changed by the reviewer who just signed off.

- Once sign-offs occur, they can only be deleted by the respective users in the reverse order in which they were applied.

**Note:**
Sign off functionality differs depending upon your department’s choice of the high security or low security options. These settings are accessible to Audit Leverage system administrators on the Audit Leverage Administration screen. Under high security, the selection of preparer and reviewer names, prior to sign-off, locks the Project Set-up data for editing to all users except the auditors designated as preparer or reviewers. This is the case as long as the project status is set to anything other than “not yet started” (or whatever label your department has assigned to the status numbered “10”).

How to Assign Preparers and Reviewers

To assign the preparer and reviewers, perform the following steps:

1. Click on the **Sign-Offs** tab.
2. In the **Auditor** scrolling list box, select the preparer’s name.
3. In the **Reviewer 1** scrolling list box, select the first reviewer’s name.
4. In the **Reviewer 2** scrolling list box, select the second reviewer’s name.
5. In the **Reviewer 3** scrolling list box, select the third reviewer’s name.
6. For instructions on how to sign off an audit project, see “Updating Projects”.

The Program Set-up Tab

The **Program Set-up** tab allows you to list the audit program(s) to be conducted during the audit. The tab contains three smaller tabs: **Program**, **Details**, and **Sign-Offs**.

Click on the **Program Set-up** Tab. The screen displays as shown in Figure 47.
**The Program Tab**

The **Program** tab contains an ordered list of the audit program(s) to be conducted during the audit. Each program is identified by a three-part naming convention using the fields **Cycle**, **Subcycle** and **Task**. Further, each program can have a designated standard program template from which the audit steps are derived. For a complete explanation of the cycle-subcycle-task naming convention for programs, see Chapter 10: “Planning Projects and Budgets”, and Appendix C: “Appendix - Module A, B & C Fields”.

Before creating a program list for your project, you should be familiar with your department’s guidelines regarding which fields are to be populated, and standards about field entries. In the case of the **Cycle**, **Subcycle**, and **Task** fields, your department should have guidelines regarding how many of these fields are to be populated.
Creating An Audit Project

1. Click on the **Program** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 48.

![Figure 48: Project Set-up Screen - Program Set-up Tab, Program Tab](image)

2. In the **Order** field, enter a number indicating the order in which you want this audit program to appear in printouts. Use leading zeros with the number.

3. In the **Cycle** scrolling list box, select a cycle by which to name the audit program.

   The asterisk next to the field label indicates this is a required field.

4. In the **Subcycle** scrolling list box, select a subcycle by which to name the audit program.

   The asterisk next to the field label indicates this is a required field. Selecting a specific subcycle name is optional. If you choose not to use a specific subcycle name, ensure that the entry reads "N/A."
The Program Set-up Tab

5. In the **Task** scrolling list box, select a task by which to name the audit program. The asterisk next to the field label indicates this is a required field. The asterisk next to the field label indicates this is a required field. Selecting a specific task name is optional. If you choose not to use a specific task name, ensure that the entry reads “N/A.”

If you plan to import a copy of a standard audit program template into your project, you must select a specific template name now, and then perform the steps in the section, “How to Import Template Steps into a Program”. If you do not want to use a template copy, but intend to create the program's audit steps from scratch, ensure that you select 'N/A' in the **Template Name** scrolling list box.

6. In the **Template Name** scrolling list box, select the template name or “N/A”. The asterisk next to the field label indicates this is a required field.

7. In the **Pre-fieldwork Risk Rating** scrolling list box, select a risk rating that describes the anticipated risk exposure associated with the process(es) examined in that program.

8. In the **Auditor** scrolling list box, select the name of the auditor who is primarily responsible for the execution of this audit program. The asterisk next to the field label indicates this is a required field.

9. In the **Comments** field, enter any comments about the audit program.

10. To create another program listing, click the **new record** button on the Microsoft Access record navigator.

11. Repeat Step 2 through Step 9 above.

**How to Import Template Steps into a Program**

1. On the **Program** tab, select and display a program for which you indicated a **Template Name** other than “N/A.”

2. Click on the **Import Template** button.

A message box appears indicating that you are about to create an audit program for this audit using the steps in the designated template.
Creating An Audit Project

3. Click Yes to continue. When the steps are imported, the Steps counter which appears below the Order field updates to show the number of steps imported.

4. Click on the Audit Program Collection button to see the program steps.

5. Click the Close button.

The Audit Program Collection screen closes and you return to the Project Set-up Screen.

6. Create, edit, or delete steps as explained in Chapter Chapter 19: “Working With the Audit Program Collection”

How to Write Audit Steps Without a Template

1. On the Program tab, select a program for which you indicated “N/A” in the Template Name scrolling list box.

2. Click on the Audit Program Collection button at the bottom of the Program Set-up tab.

3. Create, edit, or delete steps as explained in Chapter 19: “Working With the Audit Program Collection”.

How to Delete an Audit Program

1. On the Program tab, select and display the program you want to delete.

2. Click on the Delete Program button at the bottom of the Program Set-up tab.

   A message box appears prompting you to verify the deletions.

3. Click Yes.
The Program Set-up Tab

Note:

Audit Leverage permits deletion of a program only if all steps in the program are deleted first. Audit Leverage deletes steps automatically when the user clicks the Delete Program button if:

1. The user is assigned to the step as a preparer or reviewer, and
2. The user possesses the highest level sign-off already performed on the step, or the next level sign-off to be performed.

When the Delete Program button is clicked, Audit Leverage deletes all steps that meet the conditions above, and adjusts the step counter accordingly. If the program has no steps left, it deletes the program entry from the Program Set-up Tab. If there are steps left, the program entry is not deleted, and the step counter is adjusted to reflect the number of remaining steps.

The Details Tab

The Details tab allows you to document pre-field work assessments and post-field work assessments for every cycle-subcycle-task combination. You can enter any details about the pre- and post-field work assessments in these fields.

Click on the Details tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 49.
Creating An Audit Project

Some audit departments may want to use the pre-field work assessment box for project-level risk assessment. This is separate from entity-level risk assessment performed in Module A. For example, a department may have decided through Module A risk assessment to audit an entity. During the planning of this audit, the project manager determines five processes that could be audited. However, the department has time to audit only two processes. In order to determine which two processes to audit, the audit team engages in preliminary assessment to determine the strength of internal controls in each of the five processes.

To capture this in Audit Leverage, the audit manager creates the cycle-subcycle-task entries to represent the five processes which later may become programs. Second, the auditors conduct pre-field work assessment, and enter the results in the pre-field work assessment text boxes for each process. Finally, through comparison of the results, they determine which processes are of highest risk. The team selects the two processes to be audited. The audit manager returns to Audit Leverage and generates the program steps for those two cycle-subcycle-task combinations representing the processes.
The Program Set-up Tab

At the end of the audit, the audit manager returns to the Program Set-up tab to record the accuracy of the pre-field work assessments regarding the risks revealed by the audit. These conclusions are entered in the Post-fieldwork Assessment text boxes for each cycle-subcycle-task combination (process).

**Note:**
To learn how to generate program steps, see the sections entitled, “How to Import Template Steps into a Program” and “How to Write Audit Steps Without a Template”.

**How to Enter Field Work Assessments**

To enter pre-field work and post-field work assessments, perform the following steps:

1. Click on the Details tab.
   
   The screen displays text boxes for entry of pre-field work and post-field work information for the currently displayed program.

2. Using the Microsoft Access record navigator, navigate to the program for which you want to enter a pre-field work assessment or a post-field work assessment.

3. In the Pre-fieldwork Assessment field, enter the appropriate information.

4. Enter Post-fieldwork Assessment field, enter the appropriate information.

5. Repeat Step 2 through Step 4 for every program for which you want to capture a pre-field work assessment and/or post-field work assessment.

The Sign-Offs Tab

The Sign-Offs tab allows for preparer and reviewer sign-offs on each program. Applying sign-offs also invokes security on the program data as well as all data belonging to the program, including their audit steps and attachment references. Sign-offs are optional, and the number of sign-offs applied is also optional.

Click on the Sign-Offs tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 50.
Creating An Audit Project

Figure 50: Project Set-up Screen - Program Set-up Tab, Sign-Offs Tab

For each program, a preparer and up to three reviewers can be designated. Program sign-offs work the same way that project sign-offs do in low security mode. High security mode has no effect on program sign-offs. See “The Sign-Offs Tab” for rules about sign-offs.

The Administration screen, accessible to those with administrator user rights, has a setting which, when selected, requires that all audit steps signed off before an entire audit program can be signed off. Check with your Audit Leverage system administrator to determine if your department enabled this setting.

To designate the preparer and reviewers of programs, follow the same steps in “The Sign-Offs Tab”. Repeat these steps for each program.

For detailed information about signing off on Audit Leverage screens, see Chapter 3: “The Sign-Offs Tab and Record-Level Security”.

132
The Milestones Tab

The Milestones tab allows you to track important dates in the life of the audit. Audit Leverage uses some of these dates in the engagement letter and audit report cover memo, as well as to lock down findings and time charges at appropriate times. Click on the Milestones tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 51.

![Figure 51: Project Set-up Screen - Milestones Tab](image)

How to Enter Milestone Dates

To enter milestone dates throughout the life of the audit, from the planning stage through project closing, perform the following steps:


   The actual date appears in some engagement letter formats, as well as in the Module B Project Status Summary report.
Creating An Audit Project

2. Enter a date in the Pre-Entrance Conference field.

3. Enter a date in the Entrance Conference field.

   The Entrance Conference date appears in the Module B Project Status Summary report.

4. Enter dates in the Start of Field Work Planned and Start of Field Work Actual fields.

   The Start of Field Work Planned date appears in some engagement letter formats. The Start of Field Work Actual date appears in the Module B Project Status Summary report.

5. Enter dates in the End of Field Work Planned and Start of Field Work Actual fields.

   The End of Field Work Planned date appears in some engagement letter formats. The End of Field Work Actual date appears in the Module B Project Status Summary report.

6. Enter a date in the Pre-exit Conference field.

7. Enter a date in the Exit Conference field.

   The Exit Conference date appears in the Module B Project Status Summary report.


   The Report (draft) Actual date appears in the Module B Project Status Summary report.

9. Enter a date in the Manager Review (final) field.

   The Manager Review (final) date appears in the Module B Project Status Summary report.

10. Enter a date in the Director Review (final) field.

11. Enter dates in the Response Received Planned and Response Received Actual fields.

    The Response Received Planned date appears in the Module B Project Status Summary report.

    The Response Received Actual date appears in the Module B Project Status Summary report.

The Background Tab

The presence of a **Report (final) Actual** date causes findings to become read-only - findings can no longer be created, edited, or deleted.

The **Report (final) Actual** date appears in the Module B Project Status Summary

13. Enter a date in the **Closed by Director** field.

A date in the Closed by Director field means auditors can no longer charge time to the project.

**Note:**

If a project has a report (final) actual date, but has no entries in the response received (actual) and closed by director fields, the project appears in the Late Management Response query in Module E.

**The Background Tab**

The **Background** tab allows you to enter background information on the overall audit, such as reasons why the department felt it important to conduct the audit. The **Background** tab can be used to provide helpful information to the audit team members, such as specific directions to team members or other “FYI” information. Click on the **Background** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 52.
Creating An Audit Project

The Objective tab allows you to enter general statements capturing the goals and desired accomplishments of the audit as a whole, across all cycles or processes examined and all audit programs conducted. Click on the **Objective** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 53.

**Figure 52: Project Set-up Screen - Background Tab**

The **Objective** tab allows you to enter general statements capturing the goals and desired accomplishments of the audit as a whole, across all cycles or processes examined and all audit programs conducted. Click on the **Objective** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 53.
The **Scope Tab**

The **Scope** tab allows you to define the boundaries of the audit as a whole, including areas to be reviewed, procedures to be conducted and the time period under review. Click on the **Scope** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 54.

![Figure 53: Project Set-up - Objective Tab](image-url)
Creating An Audit Project

The Scope Period Covered by Audit From and To dates refer to the date scope of the audit. Entered dates convert to the date format specified in Windows Control Panel, Regional Settings. To enter the scope period, perform the following steps:

1. In the From: field, enter the beginning date of the period covered by the audit scope.
2. In the To: field, enter the ending date of the period covered by the audit scope.
3. In the text field, enter a description of the scope of the audit, including audit areas examined, sites visited, or any other pertinent information.

Figure 54: Project Set-up - Scope Tab
The Branches Visited Tab

The **Branches Visited** tab allows you to further break down a complex entity involving multiple sub-entities. Depending on the nature of the entity, sub-entities may be physical locations, subdepartments, or responsibility centers.

While the entity is the focus of the audit report, some audit departments also keep track of the sub-entities visited during the audit. Designating the sub-entities helps in tracking the frequency with which they are included in audits. Reporting on Branches Visited is available through the Branches Visited query. This query can be generated from either the main Module B screen, or through the Search Your Database (SYD) tool. Figure 55 shows the **Branches Visited** tab.

![Figure 55: Project Set-up - Branches Visited Tab](image)

The **Company** column allows you to associate the sub-entity to the part of the organizational hierarchy to which it belongs. The **Branch**, **Facility**, and **Location** scrolling list boxes are used to represent the sub-entities. These
Creating An Audit Project

values can be used in a hierarchical fashion or can be used independently. One paradigm involves viewing the Branch as the sub-entity, the Facility as an organization within the Branch, and the Location as a specific person, place, or function within the facility. One, two or all three fields can be used depending on the detail and reporting requirements of the audit department. Ultimately, the interpretation and meaning of these columns is up to the audit department to determine within its own audit universe.

How to Document Branches Visited

To document the Branches, or sub-entities, visited during an audit, perform the following steps. Follow your department's guidelines as to which fields to populate:

1. In the Company scrolling list box, select the company to which the sub-entity belongs.
2. In the Branch scrolling list box, select the sub-entity being visited, or the branch to which the sub-entity belongs.
3. In the Facility scrolling list box, select the sub-entity being visited, or the facility to which the sub-entity belongs.
4. In the Location scrolling list box, select the sub-entity being visited.
5. In the Comments field, enter text describing the sub-entity being visited.

Updating Projects

As the project progresses, the project manager should periodically update certain fields in Project Set-up.

How to Update Projects

The Main Tab

• In the Project Status scrolling list box, select the updated project status. Keeping this entry accurate ensures that users can use the Search Your Database (SYD) tool to reliably search for projects in various statuses or stages of their life spans.

The Milestones Tab

• Enter and adjust date entries as necessary.
Keeping these dates current and accurate ensures the accuracy of the Project Status Summary report and SYD searches. Entering data in the report (final) actual date causes findings to become read-only, and they can no longer be created, edited, or deleted.

The Branches Visited Tab

- As sub-entities are visited, enter general results or other comments.

Auditors conducting future audits can launch the Branches Visited query and read the comments recorded for each sub-entity.

The Program Set-up Tab

- As programs and their associated steps and file attachments are completed, ensure that the final preparer or reviewer:
  a. Enters a Post-field work assessment on the Details tab. The screen displays a field for entry of post-field work information.
  b. Enters a Post-field work risk rating on the Program tab. In the scrolling list box, select the actual risk exposure discovered in that audit area.
  c. If necessary, ensure that program preparers and reviewers sign off to close the program to further changes or additions. Sign-offs invoke security on all program-related data. When a user signs off, all data belonging to a program, including audit steps and attachment references, becomes read-only to all users except higher-level reviewers. Therefore, sign-offs should occur only when work is completed. For steps on how to apply a sign-off, see Chapter 3: “The Sign-Offs Tab and Record-Level Security”.

Closing Projects

When the project is closed, the project manager should return to the Project Set-up screen and ensure that audit steps, workpapers, findings, the cover letter for the audit report and the audit report are complete, except for management responses and audit follow-up.

How to Close a Project

1. Click on the Main tab.
2. In the Project Status scrolling list box, select the Closed status.
3. In the Overall Rating scrolling list box, select an overall rating which summarizes the risk exposed by the audit across all processes examined.
Creating An Audit Project

4. In the File Attachments (if any) box, create attachments for any electronic files not accounted for in the Workpaper Module.
   
   These attachments may include the final audit report if it was exported from Audit Leverage into another application like Microsoft Word. Or, if the audit was conducted by an external auditor, the external report can be attached here.

5. Click on the Milestones tab.

6. In the Closed by Director field, enter a close-out date for the project.
   
   Once a date is entered in this field, auditors no longer can charge time to the project.

7. Click on the Branches Visited tab.

8. In the Comments field, enter any remaining comments about sub-entities visited.

9. Click on the Sign-Offs tab.

10. Click the Sign-Off button directly below your user name.

   Two information messages appear.

11. Read the messages and click OK to each of them.

   Audit Leverage places the current date in the Sign-off date field, and the user’s log-in name in the Electronic Signature field.

Note:

Sign-offs invoke security on all project-related data. When a user signs off, all data belonging to a project, including programs, their audit steps, attachment references, findings and the audit report become read-only to all users except any higher-level reviewers who have not yet signed off. Therefore, project sign-offs should occur only when all associated audit work is complete.
The **Search Your Database** (SYD) screen allows you to perform searches on every component of the audit: entities, branches, projects, findings, management responses, and follow-up entries. Each of the fields on these screens are repeated on the search screen for setting search criteria.

When you perform a **Search Your Database** search, some of the resulting Audit Leverage screens displayed contain a checkbox labeled **Showing SYD Results?** A check in this box indicates that the data displayed resulted from an SYD search. In this way, when viewing the Entity Profile screen, Branches Visited query, Project Set-up screen, and Follow-up Entries screen, you can distinguish whether the displayed data appears as a result of an SYD search, or was selected through some other means.

This chapter describes the steps to conduct data searches. This chapter contains the following sections:

- “The Search Your Database Screen”
- “Common Features Across All Tabs”
- “Conducting Specific Data Searches”

**The Search Your Database Screen**

To view the Search Your Database screen, from either the main Module B screen or the main Module D screen, click the **Search Your Database** button.
Working With Search Your Database

The Entities tab is displayed by default when you first enter the Search Your Database screen, as shown in Figure 56.

**Figure 56: The Search Your Database Screen**

The SYD screen consists of six tabs representing entities, branches visited, audit projects, findings, management responses, and follow-up entries. Each tab contains the fields represented on their respective screens in the software.

**Common Features Across All Tabs**

The following features are options on all tabs:

- Entering data in one or more fields as criteria for the search
- Enabling OR searches for blank entries
- Incorporating search criteria on tabs to the left of the displayed tab
Common Features Across All Tabs

- Limiting scrolling list box entries to only those values that have already been used in audit records
- Performing AND or OR searches
- Print previewing search criteria
- Clearing search parameter entries
- Executing the search

Entering Data in the Search Parameter Fields

The fields on each SYD tab are search criteria. They take the form of scrolling list boxes, text fields, checkboxes and radio buttons.

Searches can be conducted with no criteria selected. If no limitations have been made using the criteria, Audit Leverage returns all audit data for the tab selected. For example, a project search with no project criteria defined yields all projects in the database.

Search results can be narrowed by entering data on the SYD tabs. Data can be entered into scrolling list boxes, text boxes, checkboxes, and radio buttons.

How to Enter Data in the Search Parameter Fields

To enter data on a tab, perform the following steps:

1. Click on the tab representing the audit component for which you want to perform a search.
2. To enter data in a scrolling list box, click the arrow and select an entry from the list, as shown in Figure 57.

![Figure 57: Selecting an Entry From a Scrolling List Box](image)

3. To enter data in a text box, type the data directly into the field, as shown in Figure 58.
Working With Search Your Database

4. To select a checkbox, click on the box, as shown in Figure 59.

5. To select a radio button, click on the button, as shown in Figure 60.

6. To enter data on another tab for a combined tab search, click on the tab of interest and enter the data.

Adding an OR Search for Blank Entries

Almost every search parameter field has a checkbox at the far right of the field.
If you have populated a field as a search parameter, selecting the checkbox indicates that you want not only data returned that contains the value you selected, but also all records for which there is nothing entered in that field. The checkbox appears at the end of the input field, as shown in Figure 61:

Incorporating Search Criteria on Previous Tabs

You can incorporate search criteria on other tabs, as long as the tab appears to the left of the tab on which you want to run the search. For example, if you want to conduct a Findings search, you can enter values on the Audit Projects tab, the Branches Visited tab, and the Entities tab to limit your search further. In
Common Features Across All Tabs

In this example, however, you cannot use criteria on the Management Responses tab or the Follow-up Entries tab to limit your search.

**Note:**

The exception to the information above concerns the Entities and Branches Visited tabs. When you conduct a Branches Visited search, any criteria specified on the Entities tab has no effect.

Limiting Scrolling List Box Entries

On other screens in Audit Leverage, clicking on a scrolling list box lists all the possible entries for that field as defined in Module G. On the SYD tabs, scrolling list box entry choices can be limited to make your searches easier and more meaningful.

The Only values for option box includes the following choices: by tab, projects, findings, management responses, and follow-up entries. The By Tab option is the default selection, as shown Figure 62:

![Figure 62: Only Values For Options Box](image)

**The By Tab Option**

Using the By Tab option means that all scrolling list boxes present only the values that are used in existing records related to the tab displayed. For example, imagine that your audit department defined five valid finding types in Module G. However, in your findings table, only three of the finding types have been used to describe the existing findings. When setting up a findings search, the finding type scrolling list contains only the three finding type values used in the existing finding records.

To use the By Tab option, select the appropriate radio button.
Other Options

Consider the example where you have 500 projects in your database, but only some of those projects have related findings. Of those 500 projects, you want to search out the projects that have findings involving a specific business division. When you set up a search for projects and click on the Business Division scrolling list box, you want the business division list choices to be limited to those that are used in projects with findings.

To set up this search, perform the following steps:

1. Click on the Audit Projects tab.
2. In the Only values for box, select the Findings radio button.
3. Click on the Business Division scrolling list box.
   The list of possible entries appears. This list is limited to only those business division values associated to projects that have findings.
4. Select a business division.

In a similar way, you can limit other scrolling lists on this and other tabs.

To use the projects, findings, management responses or follow-up entries option, click on the radio button next to the option.

Note:
Limiting follows the dependencies indicated by the SYD tab order. Choosing an option (projects, findings, management responses, or follow-up entries) limits scrolling list box options for all fields on preceding tabs. For example, choosing the Management Responses radio button limits scrolling list boxes on the Entities, Branches Visited, Audit Projects, and Findings Tabs, but not the Management Responses or Follow-up Entries tabs. Scrolling list boxes on the tabs which include or lie to the right of the selected option are limited on a “by tab” basis only.

AND/OR Searches

If you have specified two or more search criteria, you can specify whether or not you want Audit Leverage to perform an AND search or an OR search. These searches can be selected in the Search Type box, as shown Figure 63.
Common Features Across All Tabs

Figure 63: Search Type Box

AND searches combine all search criteria. The results return include records that meet all criteria. OR searches return records that meet one or more of the criteria.

The default search is AND. To select an OR search, click on the OR radio button in the Search Type box.

How to Print Preview Search Criteria and Clear Search Criteria Entries

To print preview the search criteria, click the Print Preview Search Criteria button.

To clear search criteria entries, perform these steps:
1. Click the Clear Entries button.
2. In the dialog box that appears, indicate if you want to clear all tabs or just the currently displayed tab.

How to Execute the Search

On all tabs, to perform the search, click on the Search! button:

If you are conducting a finding, management response, or follow-up entry search, a screen appears prompting you to choose how to group your search results. For more information, see “Conducting Specific Data Searches”.

149
Conducting Specific Data Searches

How to Conduct an Entity Search

To conduct an entity search, perform the following steps:

1. Click on the **Entities** tab.

2. The **Entities** fields appear on the tab, as shown in Figure 64.

3. Follow the steps in “How to Enter Data in the Search Parameter Fields” to establish search criteria.

4. Click the **Search!** button

   If the search produces any results, the **Entity Profile** screen from Module A displays, as shown in Figure 65.
Conducting Specific Data Searches

Figure 65: Entity Search Results Displayed on Entity Profile Screen

As shown in Figure 65, when Audit Leverage displays search results, the Showing SYD Results? checkbox is selected.

5. To display a spreadsheet view of the search results, click on the Spreadsheet View button on the Entity Profile screen.

Note:

From this view, you can sort and filter data, hide columns, size columns and rows, and more.

6. Click on the printer icon on the Access toolbar, or select File > Print to send the spreadsheet view to a printer.

7. To return to the Entity Profile screen form view, select View > Form View.
Working With Search Your Database

8. To remove the filter which presents the SYD search results, and display all entity records, click the **Remove Data Filtering** button on the Entity Profile screen.

Audit Leverage deselects the **Showing SYD Results?** checkbox automatically.

9. To return to the SYD screen, click the **Close** button.

How to Conduct a Branches Visited Search

To conduct a **Branches Visited** search, perform the following steps:

1. Click on the **Branches Visited** tab.

2. The fields from the **Branches Visited** tab of the Project Set-up screen appear on the tab, as shown in Figure 66:

![Figure 66: Search Your Database Branches Visited Tab](image)

- **Project Number**: 
- **Company**: 
- **Company Number**: 
- **Branch**: 
- **Branch Number**: 
- **Facility**: 
- **Facility Number**: 
- **Location**: 
- **Location Number**: 
- **Comments**: 

NOTE: Entities and Branches Visited have NO relation with each other and search results are NOT dependent on one another. A comparison USL search can be done either to Entities or Branches Visited. If both are selected, the Branches Visited tab, depending on the parameters you choose, the projects returned will depend on Entities and Branches.
Conducting Specific Data Searches

3. Follow the steps in the previous sections of this chapter to establish search criteria.

4. Click the **Search!** button

   If the search produces any results, the **Branches Visited** query from Module B displays, as shown in Figure 67.

![Figure 67: Branches Visited Search Results Displayed on Branches Visited Query](image)

5. To remove the filter which presents the SYD search results, and display all Branches Visited records, click the **Remove Data Filtering** button on the Branches Visited screen.

   Audit Leverage deselects the **Showing SYD Results?** checkbox automatically.

6. To return to the SYD screen, click the **Close** button.
**Working With Search Your Database**

**Using the Branch to Project Relation Options**

You can use the **Branch to Project Relation** box to limit searches on other SYD tabs. The **Branch to Project Relation** option defaults to Inclusive, as shown in Figure 68:

![Figure 68: Branch to Project Relation Box](image)

Choosing the **Exclusive** option limits SYD searches on tabs to the right based on whether or not projects have any branches, facilities, or locations defined on the **Branches Visited** tab of Project Set-up. If you choose the **Exclusive** option, any searches performed on the Projects tab yields only projects that have entries on the **Branches Visited** tab of Project Set-up. Findings searches, management response searches, and follow-up entry searches only include those belonging to projects having one or more entries on the **Branches Visited** tab of Project Set-up.

Leaving the **Branch to Project Relation** set to the default value, **Inclusive**, eliminates this effect.

**How to Conduct a Projects Search**

To conduct a project search, perform the following steps:

1. Click on the **Audit Projects** tab.
2. The Project Set-up fields appear on the tab, as in Figure 69:
Conducting Specific Data Searches

3. Follow the steps in “How to Enter Data in the Search Parameter Fields” to establish search criteria.

4. Click the Search! button

   If the search produces any results, the Project Set-up screen from Module B displays, as shown in Figure 70.
5. To display a spreadsheet view of the search results, click on the **Switch to Spreadsheet View** button on the **Project Set-up** screen.

![Spreadsheet View](image)

**Note:**

From this view, you can sort and filter data, hide columns, size columns and rows, and more.

6. Click on the printer icon on the Access toolbar, or select **File > Print** to send the spreadsheet view to a printer.

7. To return to the **Project Set-up** screen form view, select **View > Form View**.
Conducting Specific Data Searches

8. To remove the filter which presents the SYD search results, and display all project records, click the **Remove Data Filtering** button on the **Entity Profile Screen**.

Audit Leverage deselects the **Showing SYD Results?** checkbox automatically.

9. To return to the SYD screen, click the **Close** button.

**How to Conduct a Findings Search**

To conduct an findings search, perform the following steps:

1. Click on the **Findings** tab.

2. The Finding fields appear on the tab, as shown in Figure 71.

![Figure 71: Search Your Database Findings Tab](image)

3. Follow the steps in “How to Enter Data in the Search Parameter Fields” to establish search criteria.
Working With Search Your Database

4. Click the **Search!** button

If the search produces any results, the **Group Your Search Results** screen displays, as shown in Figure 72.

![Figure 72: Group Your Search Results Screen](image)

Your viewing options on this screen include:

— Viewing findings one at a time on a modified Findings screen
— Showing a summary of findings grouped by project and entity characteristics, then navigating to the findings screen for specific records
— Print previewing finding summary or detail reports

**How to View Findings One at a Time**

To view findings one at a time, perform the following steps:

1. Click on the **View Audit Findings one at a time** radio button.
2. Click the **View the results** button.

A modified **Findings** screen appears, as shown in Figure 73.

![Figure 73: Finding Search Results Displayed on Modified Findings Screen](image)

This screen differs from the Module C findings screen. It does not have the **Create or edit audit report cover memo** button, or the **Preview the report** button. However, this screen does have buttons not present on the regular Module C **Findings** screen. A **View all findings for this audit** button, and a **View Search Reports** button are both present.
Working With Search Your Database

3. Click on the arrows of the record navigator to move back and forth between the findings.

4. Click on the View Search Reports button to navigate to the summary and detail search report options.

The **Print Options** form appears, presenting the same summary report and detailed report options available on the **Group Your Search Results** screen.

![Print Options Form]

**Figure 74: Finding Search Report Print Options Box**

5. Select the appropriate radio button for the report you want to print preview.

6. Click the **Preview** button.

7. Click the printer button on the Access toolbar, or select **File > Print** to send the report to a printer.

8. Click the **Close** button on the Access toolbar, or select **File > Close**, to return to the modified **Findings** screen.

9. To view all findings for the displayed project, click the **View all findings for this audit** button.

![Findings Screen]

The **Findings** screen from Module C appears, displaying the first finding for the project, as shown in Figure 75.
Conducting Specific Data Searches

10. Click the Close button to return to the SYD modified Findings screen.

11. Click the Close button to return to the Group Your Search Results screen.

How to Show Grouped Statistical Summaries

To display a summary of finding data grouped by entity or project characteristics, perform the following steps:

1. Click the Show a summary grouped by radio button.
2. Click on the radio button next to the characteristic by which you want to group search results.

3. Click on the **View the results** button.

   The **Statistical Summary of Search Results** screen appears, with data similar to that shown in Figure 76.
Conducting Specific Data Searches

The first few columns may vary depending upon the choices made on the previous screen. However, regardless of choices on the previous screen, the **Statistical Summary of Search Results** screen includes:

- **Number of audit findings** column
- **Average risk severity** column
- **Total dollar savings** column
- **See detail** column
- **Average per result line item** total for risk severity
- **Average per result line item** for total dollar savings
- **Cumulative total** for findings
- **Cumulative total** for dollar savings

4. Click on the **Print this form with the same data it is showing now** button to print preview the **Statistical Summary of Search Results**.
Working With Search Your Database

The print preview appears.

5. Click on the printer icon on the Access toolbar, or select File > Print to send the print preview to a printer.

6. Click the Close button on the Access toolbar to return to the Statistical Summary of Search Results screen.

7. Choose a line item of interest on the screen.

8. Click the blue arrow under the See Detail column to navigate to the modified Findings screen.

   The modified Findings screen displays the first of the findings referenced in the line item. If more than one finding is referenced, you can use the record navigator to move back and forth between the findings.

9. Follow Step 3 through Step 9 in “How to View Findings One at a Time” to use the modified Findings screen features.

10. Click the Close button to return to the Statistical Summary of Search Results screen.

11. Click the Close button to return to the Group Your Search Results screen.

How to Print Preview Summary and Detail Reports of all Findings

To print preview summary or detail reports of all findings meeting your search criteria, perform the following steps:

1. Click on the Print preview a summary report of all comments radio button.

Two types of reports can be print previewed: a summary report and a detailed report. Each report can be organized by cycle, control issue and project, or cycle, region and project.
Conducting Specific Data Searches

2. Select the radio button next to the your report choice.
3. Click the View the results button.
   The report print preview appears.
4. Click the record navigator buttons to move back and forth through the pages of the report.
5. Click on the printer icon on the Access toolbar, or select File > Print to send the print preview to a printer.
6. Click the Close button on the Access toolbar to return to the Group Your Search Results screen.

How to Print Preview the SYD Search Criteria

To print preview all SYD tabs containing your search criteria, perform the following steps:

1. Click on the Print preview the search criteria button.
2. Click the View the results button.
   The Search Your Database Parameters print preview appears, as shown in Figure 77.
3. Click on the record navigator buttons to view the pages of the report.

4. Click on the printer icon on the Access toolbar, or select File > Print to send the print preview to a printer.

5. Click the Close button on the Access toolbar to return to the Group Your Search Results screen.

6. Click the Close button to return to the SYD Findings tab.

How to Conduct a Management Response Search

To conduct a management response search, perform the following steps:

1. Click on the Management Responses tab.

The Management Responses tab appears, as shown in Figure 78.
Conducting Specific Data Searches

Figure 78: Search Your Database Management Responses Tab

2. Follow the steps in “How to Enter Data in the Search Parameter Fields” to establish search criteria.

3. Click the Search! button

   If the search produces any results, the Group Your Search Results screen displays, as shown in Figure 79.
Working With Search Your Database

Figure 79: Group Your Search Results Screen

To use these options, refer to the following sub-sections in “How to Conduct a Findings Search”.

— “How to View Findings One at a Time”
— “How to Show Grouped Statistical Summaries”
— “How to Print Preview Summary and Detail Reports of all Findings”
— “How to Print Preview the SYD Search Criteria”

Note:

In performing a management response search, any choice you make on the Group Your Search Results screen that displays the modified Findings screen displays it with the Management Response tab selected. To use the other finding related functions described in the chapter sections listed above, click on the Main tab of the modified Findings screen.
How to Conduct a Follow-up Entries Search

To conduct a follow-up entries search, perform the following steps:

1. Click on the **Follow-up Entries** tab.
2. The follow-up entries fields appear on the tab, as shown in Figure 80.

![Figure 80: Search Your Database Follow-up Entries Tab](image)

3. Follow the steps in “How to Enter Data in the Search Parameter Fields” to establish search criteria.
4. Click the **Search!** button

   If the search produces any results, the **Audit Follow-up Entries** screen displays, as shown in Figure 81.
5. Click on the record navigator buttons to move back and forth between projects, management responses, and follow-up entries.

**Note:**
Use the bottom record navigator to move from project to project. Use the middle record navigator to move from one management response to another. Use the uppermost record navigator to navigate between follow-up entries.

6. Click on the **View finding details** button to navigate to the corresponding finding for a particular follow-up entry.

The Findings screen, **Main** tab from Module C appears.

7. Click the **Close** button to return to the Audit Follow-up Entries tab.
Using the Visual Scheduler

Audit Leverage includes a Visual Scheduler which allows you to view time lines for projects and staff members. With the Visual Scheduler, you can see at a glance the staff members assigned to a particular audit project, including the assigned dates and roles they have for that audit project. You can also view all of the assignments for staff members for a particular time frame.

This chapter describes the steps to create, view, and modify time entries for staff members and projects using Audit Leverage’s Visual Scheduler. This chapter contains the following sections:

- “Visual Scheduler Overview”
- “Using the Visual Scheduler”
- “Setting View Options”
- “Printing the Schedule”

Visual Scheduler Overview

Audit Leverage’s Visual Scheduler allows you to view, add, and modify auditor assignments in a visual grid-like environment. You can view the assignments for a given period of time based on either a project-level or staff-level view.

The Visual Scheduler Screen

When you open the Visual Scheduler, the staff assignments are shown graphically, using a bar graph-style presentation. The default Visual Scheduler view is shown in Figure 82.
Using the Visual Scheduler

Figure 82: Default Visual Scheduler view

Figure 82 displays the default view shown when the Visual Scheduler screen appears. The left-hand pane contains the Projects tab and the Staff tab. You can click on these tabs to determine the grouping you want to use when viewing staff assignments. The Projects tab groups the assignments by the audit project ID, and the Staff tab groups the assignments by staff member and role.

When the Visual Scheduler screen appears, the view defaults to display any audit project that has an assignment within the current month. Once the Visual Scheduler screen appears, you can change the displayed time frame. By default, if any activity is assigned for any day within the selected time period is shown in the screen. However, the entire assignment bar for each staff member is shown, even if part of it falls outside of the selected time frame.
At the top of the screen are two date fields, which determine the inclusion dates. When the Visual Scheduler first appears, those fields default to the first and last day of the current month, based on the date of the system clock of your local machine. For example, Figure 82 assumes that the system clock is set to June 2002. To the right of the two date fields is a scrolling list box which determines the time frame used to view the data, either Days, Weeks, or Months.

The Visual Scheduler Data

The dates shown for the project length are based on the values for the **Start of field work** and **End of Field Work** fields in the **Milestones** tab of the Project Set-up screen. If dates are entered in the **Planned** column, but the actual dates are not known, the Visual Scheduler displays its values based on the planned dates. However, if dates are entered in the **Actual** column, the Visual Scheduler uses the actual dates instead.

The data used by the Visual Scheduler for staff assignments, roles, and site come directly from the **Staffing** tab of the Project Set-up screen. From the Project Set-up screen, you assign staff members and assignment dates for the project. For detailed information on the Project Set-up screen, see Chapter 11: “Creating An Audit Project”.

Using the Site/Place Label

The staff assignments in the **Staffing** tab of the Project Set-up screen and in the Visual Scheduler Assignment Set-up dialog box include a field for **Site/Place**. When you create an assignment, the bar is given a default value of “Assigned.” The other values—In Office, Vacation, Overnight, Off-site, Multiple Sites, and Training—allow you to choose a more specific description for the location where the staff member spends time if you want a greater level of granularity.

For example, if it is typical for members of your department to spend a week at the auditee site, and another week in the home office, you could schedule the first week with a Site/Place value of Off-site and the second week with a Site/Place value of In Office. Note, however, that you must create a separate assignment for each different Site/Place value.

Additionally, each Site/Place value has a different color code and placement value associated with it. For example, in Figure 83, the listing for Joe for project 025462 - Price Tower uses two Site/Place settings, Assigned and Vacation. Note that the setting for Vacation uses a different bar and endpoint color than the other bars in the figure. Some Site/Place styles also appear above the midline within the staff member’s line.
Using the Visual Scheduler

How to View the Visual Scheduler

To view the Visual Scheduler, perform the following steps:

1. From the Module B Main screen, click the **Scheduler** button.

The default view of the Visual Scheduler appears, displaying projects for the selected time frame grouped by project, similar to that shown in Figure 83.

![Figure 83: Visual Scheduler Project view](image-url)
Visual Scheduler Overview

There are two main views that can be used with the Visual Scheduler: viewing assignments by Project ID or viewing assignments by Staff Member name.

1. If necessary, from the Visual Scheduler screen, click on the **Projects** tab.
   The view changes to show the projects scheduled within the selected dates, grouped by Project ID, as shown in Figure 83.

2. From the Visual Scheduler screen, click on the **Staff** tab.
   The view changes to show the projects scheduled within the selected dates, grouped by staff member name, and further by the staff member’s role, as shown in Figure 84.

![Figure 84: Visual Scheduler Staff view](image)
Using the Visual Scheduler

This view allows you to see if there are any scheduling conflicts for a staff member. For example, in Figure 84, Stewart is assigned to two roles in two projects for conflicting dates.

3. If necessary, change the start date by click on the first date scrolling list box.

A calendar for the selected month appears, similar to that shown in Figure 85.

4. If necessary, use the arrow buttons at the top of the calendar to select the desired month.

5. Click on the desired day.

**Note:**

The Visual Scheduler does not allow you to enter a start date that is later than the current end date, nor an end date that is before the current start date. When selecting dates, ensure that you change them in the correct order so that there is no overlap.

6. Click outside of the calendar control to complete the selection.

The Visual Scheduler updates to show the assignments within the newly selected date range.

7. Repeat Step 3 through Step 6 to set the end date.

8. If necessary, change the time frame used to display the dates from the **By** scrolling list box.

Your choices are Days, Weeks, and Months. By selecting a different value, you can view the assignment bars over different time frames, effectively scaling the view.
Using the Visual Scheduler

In most cases, additions or modifications to the Visual Scheduler can be made either from the Project Set-up screen, using the dialog box that appears when you double-click on an assignment bar, or by dragging the bar itself to change the dates. The following sectionstopics discuss the various ways you can add or modify the settings:

- “Entering Assignments in the Project Set-up Screen”
- “Adding or Modifying Assignment Bars Directly”
- “Modifying Assignments in the Set-up Dialog Box”

Note that if you add or modify dates and assignments, the changes are reflected in the Project Set-up screen when you return to it.

Entering Assignments in the Project Set-up Screen

Since all of the dates and roles shown in the Visual Scheduler are based on values set for the project in the Project Set-up screen, any changes that you make to the project field work dates on the Milestones tab or the staff assignment information on the Staffing tab are reflected on the Visual Scheduler. For detailed information on the Project Set-up screen, see Chapter 11: “Creating An Audit Project”.

To add, modify, or delete assignments, follow the steps described in “The Staffing Tab” of Chapter 11: “Creating An Audit Project”.

Adding or Modifying Assignment Bars Directly

There are some operations that can be performed using the bars directly in the Visual Scheduler screen.

How to Add an Assignment

To add an assignment directly in the Visual Scheduler screen, perform the following steps:

1. Place the cursor anywhere on the screen.
2. Click and drag a new bar onto the screen.

When you release the mouse button, the Assignment Set-Up dialog box appears, similar to that shown in Figure 86.
Using the Visual Scheduler

**Figure 86: Assignment Set-up dialog box**

The dates, project ID, staff member name and role are based on the values of the line where the bar was created.

3. If necessary, in the **Begin Date** scrolling list box, modify the date on which the assignment should begin.

4. If necessary, in the **End Date** scrolling list box, modify the date on which the assignment should end.

5. If necessary, in the **Project** scrolling list box, select the project to which this assignment is associated.

6. If necessary, in the **Staff Member** scrolling list box, select the staff member to whom the assignment applies.

7. If necessary, in the **Staff Role** scrolling list box, select the role that the staff member is to take in the project.

8. If necessary, in the **Text Alignment** scrolling list box, select the alignment location for the project name in the bar.

   Changing this value determines if the text is aligned to the left side, the right side, or the center of the bar.

9. If necessary, in the **Site/Place** scrolling list box, select the physical location where the staff member is to be during the project.

   For more information on Site/Place, see “Using the Site/Place Label”.

10. Click **OK** to accept the assignment.

    When you click **OK**, the bar may move depending on the criteria you set. If you changed the project or staff member name, it relocates to the proper location, based on the tab from which you are viewing. The color and
Using the Visual Scheduler

placement of the bar may also change depending on the Site/Place setting you assigned to the bar.

**How to Move an Assignment**

To move an assignment bar, retaining the length of the assignment, perform the following steps:

1. Place the cursor over the center of the bar.
2. Click and drag the bar right or left until you have reached the selected dates.

When you move an assignment using this method, the start and end dates change, but the length of the assignment remains unchanged.

**How to Modify an Assignment**

To modify an assignment bar, perform the following steps:

1. Place the cursor over the end of the bar which corresponds to the date you want to modify—either the start date or the end date. When the cursor is in the correct position, the cursor changes from the standard cursor to a small arrow pointing right and left, with a small line in the center.

   **Note:**
   If the cursor is not positioned correctly, when you attempt to drag the end of the bar, you instead create a new bar. The only way to delete this newly created assignment is from the **Staffing** tab of the Project Set-up screen.

2. Click and drag the end of the bar right or left until you have reached the selected day.
3. If necessary, repeat for the other end of the bar.

**Modifying Assignments in the Set-up Dialog Box**

**How to Modify an Assignment**

To modify an assignment using the Set-up dialog box, perform the following steps:

1. Double-click on the bar that you want to modify.
Using the Visual Scheduler

The Assignment Set-Up dialog box appears, similar to that shown previously in Figure 86.

The dates, project ID, staff member name and role are automatically populated with the information for the bar.

2. If necessary, in the **Begin Date** scrolling list box, modify the date on which the assignment should begin.

3. If necessary, in the **End Date** scrolling list box, modify the date on which the assignment should end.

4. If necessary, in the **Project** scrolling list box, select the project to which this assignment is associated.

5. If necessary, in the **Staff Member** scrolling list box, select the staff member to whom the assignment applies.

6. If necessary, in the **Staff Role** scrolling list box, select the role that the staff member is to take in the project.

7. If necessary, in the **Text Alignment** scrolling list box, select the alignment location for the project name in the bar.

   Changing this value determines if the text is aligned to the left side, the right side, or the center of the bar.

8. If necessary, in the **Site/Place** scrolling list box, select the physical location where the staff member is to be during the project.

   For more information on Site/Place, see “Using the Site/Place Label”.

9. Click **OK** to accept the assignment.

   When you click **OK**, the bar may move depending on the criteria you set. If you changed the project or staff member name, it relocates to the proper location, based on the tab from which you are viewing. The color and placement of the bar may also change depending on the Site/Place setting you assigned to the bar.

   If necessary, you can navigate to the Project Set-up screen or the Audit Staff screen directly from the dialog box by clicking on the **Go to Project** and **Go to Staff Member** buttons respectively. You can then view or modify the information for the project or staff members.
Setting View Options

The Visual Scheduler provides a number of viewing options to filter the assignments shown in each screen which can be set to make viewing projects and staff assignments more efficient. Typically, the fewer projects the Visual Scheduler displays at any one time, the quicker the display appears and refreshes itself with updates.

By selecting or deselecting these viewing options, the views within the Visual Scheduler can better reflect the information you want to see and display the information more quickly. To access the dialog box where you can select the viewing options, click on the **Options** button in the upper right of the screen.

### Non-Assigned Staff

When you are viewing all staff assignments using the **Staff** tab, the unassigned staff members can be displayed in red at the bottom of the screen. “Unassigned Staff” refers to any staff member without an assignment for the selected period. If you have a large department, this list could be quite large, depending on the circumstances and the time period shown. By deselecting the **Display Non-Assigned Staff** checkbox, only staff members with an assignment for the given period are displayed in the **Staff** tab.

### Non-Staffed Projects

When you are viewing project assignments using the **Projects** tab, projects with no staff assigned to them can be viewed. These projects appear as a single black line in the Visual Scheduler window, with no staff assignment lines below the Project ID listing. If you have a number of projects with no staff assigned to them, these projects can sometimes be distracting. By deselecting the **Display Non-Staffed Projects** checkbox, only projects with staff members assigned to it for the given period are displayed in the **Projects** tab.

### Closed Projects

When you are viewing project assignments using the **Projects** tab, projects that are closed can be displayed. The project title appears in the project listing on the left with *(Closed)* appended to the title to indicate the status of the project. If you are displaying projects over a large period of time, for instance six months or an entire year, there may be a large number of closed projects which are displayed. By deselecting the **Display Closed Projects** checkbox, only open projects for the given period are displayed.
Using the Visual Scheduler

Printing the Schedule

Audit Leverage allows you to print the schedule for a selected period. Like the view on the screen, the printed view includes the entire bar for all projects or staff assignments which fall within the selected time period. Depending on the number of assignments and their length, the printout may be more than one page long and more than one page wide.

How to Print the Scheduler View

To print the schedule, perform the following steps:

1. From the Visual Scheduler screen, click the **Print** button.

The Visual Scheduler - Print Options dialog box appears, as shown in Figure 87.

![Visual Scheduler - Print Options dialog box](image)

**Figure 87: Visual Scheduler - Print Options dialog box**

2. In the **Document Title** field, enter the text that you want to appear at the top of each printed page.

By default, the **Document Sub-Title** field is automatically populated with text that includes the selection dates from the Visual Scheduler screen.

3. If desired, in the **Document Sub-Title** field, modify the text that appears under the Document Title on each printed page.

4. Click **OK**.

5. In the Windows Print dialog box, select your printer.

6. Click **OK**.
Auditor Timesheets

Audit Leverage allows you to directly enter time for auditor time tracking. From the timekeeping screen you can view, enter, modify, and delete auditor time tracking information. You can also approve auditor timesheets and view time summaries. This chapter describes how to perform timesheet operations.

This chapter contains the following sections:

• “Viewing Time Entries”
• “Creating Time Entries”
• “Editing Time Entries”
• “Deleting Time Entries”
• “Viewing Budget-To-Actual Hours”
• “Approving Timesheets”
• “Viewing Time Summaries”
• “Printing Timesheets”

Viewing Time Entries

Audit Leverage allows you to view auditor time entries and to narrow the search using a number of criteria including date, auditor name, project type, project number, and more. Once you have selected the criteria by which to view the entries, you can then choose to view the results in either a summarized or detailed form.
How to View Auditor Time Entries

To view timesheet data by changing the viewing criteria, perform the following steps:

1. From the Module B Welcome Screen, click the Auditor Timesheets button.

The Auditor Timesheet screen appears, as shown in Figure 88

**Figure 88: Auditor Timesheet Screen**

The From field in the Date Range area defaults to the current date, and the Auditor Name field defaults to the current user, if the current user is listed in the Audit Staff list in Module F. Also by default, the Summary tab is selected.
The fields in the top portion of the screen allow you to narrow down the timesheet criteria that you want to view. The default view allows you to view the current day's time, if any, for the user currently logged in.

The Date Range area allows you to specify a range of dates between which the timesheet data is displayed. Similarly, the Staff Level Range allows you to specify a range of staff levels for timesheet data. The other fields at the top of the screen allow you to filter the view by auditor, billable company, audit office, project ID, project type, cycle, phase, or any combination.

You can enter dates in either the To and From fields in the Date Range area. By entering dates in these fields, you limit the range of dates displayed in the timesheet.

2. If desired, in the Date Range area, enter the starting date of the range in the From field.

3. If desired, in the Date Range area, enter the end date of the range in the To field.

You can also leave either or both of these fields blank. If you leave a single field blank, the screen displays all time entries for the other selected criteria between the entered date and the current date. If you leave both fields blank, entries for all dates which match the other selected criteria are displayed.

4. If desired, select a value in any of the remaining fields to narrow the results.

After each entry, the view in the tab below changes to reflect the criteria you select. If more than one entry appears in the tab, you can move between the entries using the scroll bar on the right side of the viewing window.

Note:

Although by default a date and auditor name is selected, these values can be removed or changed to broaden the results.

The Summary tab in the bottom portion of the screen displays the date and auditor for which hours were charged, the project number, and the number of hours charged. It also displays optional information such as phase, cycle, billable time if any, who the billable time was charged to, if the hours include overnight travel, and any comments about the time. Finally, it displays a hour total for the criteria that you selected.

5. If desired, click on the Details tab to see more detailed information about the time entries.

The Auditor Timesheet Details Tab appears, as shown in Figure 89.
Auditor Timesheets

Figure 89: Auditor Timesheet Details Tab

The Details tab displays all of the information shown in the Summary tab. In addition, it displays the position of the person who charged the time, the office they work from, the entity, project title, project type, and business division, as well as the status of the project.

Timesheet Example

For example, you could enter a date range, a billable company, and an auditor’s name to narrow the search to just that information. Figure 90 shows a Summary tab sample for auditor Mike, billable to a specific company between specific dates.
Creating Time Entries

You can enter time for any open project from the Auditor Timesheet screen. Past, current, or future time entries can be included.

**How to Create Auditor Time Entries**

To enter timesheet data, perform the following steps:

1. From the Module B Welcome Screen, click the **Auditor Timesheets** button.

   The Auditor Timesheet screen appears, as shown in Figure 91.
Auditor Timesheets

2. Click the **Enter Time** button.

   The Time Entry Form appears, as shown in Figure 92.

**Figure 91: Auditor Timesheet Screen**

**Figure 92: Time Entry Form**
Creating Time Entries

The name shown in the **Charged By** field defaults to the name of the user currently logged in. The value shown in the **Date** field defaults to the current date.

3. If necessary, change the date.
   
   As long as the project you choose is not closed and the time period has not already been approved, you can enter time for any applicable date.

4. In the **Project Number** scrolling list box, select the project to which you want to charge time.
   
   The list that appears contains only projects you have charged time to previously or to which you have been assigned as a staff member.

5. In the **Hours** field, enter the number of hours that should be charged to this project.

6. If applicable, in the **Audit Phase** scrolling list box, select the phase of the audit to which the hours apply.

7. If applicable, in the **Cycle** scrolling list box, select the cycle to which the hours apply.

8. If applicable, in the **Billable To** scrolling list box, select the company to which the hours should be charged.

   The **Billable To** list contains all companies defined in your audit universe.

   **Note:**
   
   You must select “N/A” for **Audit Phase**, **Cycle**, and **Billable To** if there is no specific value for them.

9. If the hours are to be billed to a certain company or client, ensure that the **Billable Time** checkbox is selected.

10. If the hours involved overnight travel, ensure that the **Overnight** checkbox is selected.

11. If desired, in the **Comments** field, enter a description.

12. Click **Enter** to add the entry to the database, or **Close** to exit without adding the new information.

   When you click **Enter**, Audit Leverage confirms that the time entry was added and prompts you to select if you want to add another entry.
Auditor Timesheets

13. If you want to make another entry click Yes and repeat Step 3 through Step 12. If you do not want to make another entry click No.

Note:

If the Budget Check checkbox is selected, Audit Leverage displays a message box if you attempt to charge time to a project whose budget is exceeded or a project for which a budget does not exist.

Once you have finished entering time, you are returned to the Auditor Timesheet screen. The tabs at the bottom of the screen update to reflect the changes.

Editing Time Entries

Once a time entry has been created in Audit Leverage, it can be modified as long as the project is open and the time period in which the entry occurs has not been approved.

Note:

A project is considered open for time entries as long as the Closed by Director milestone on the Project Set-up screen does not have a value. For more information, see Chapter 11: “Creating An Audit Project”

How to Edit Auditor Time Entries

To edit timesheet data, perform the following steps:

1. From the Auditor Timesheet screen in either the Summary or Details tab, select a time entry to edit by clicking on the gray box to the left of the entry.

2. Click on the Edit Time button.

The Time Entry Form appears containing the data for the entry, similar to that shown in Figure 93.
Deleting Time Entries

Figure 93: Time Entry Form containing data

3. Enter any changes that must be made to the various fields.

4. Click Change to modify the entry, or Close to exit without adding the new information.

   The Change Time Entry? dialog box appears, displaying the information entered in the form and prompting you to verify that you want to change the entry to reflect the entered data.

5. Click Yes to accept the changes or No to exit without changing the entry.

   If you click Yes, a message box appears informing you that the entry was changed. If you click No, you return to the Auditor Timesheet screen.

6. If you clicked Yes, click OK to return to the Auditor Timesheet screen.

   Once you have finished modifying the entries, you are returned to the Auditor Timesheet screen. The tabs at the bottom of the screen update to reflect the changes.

Deleting Time Entries

Once a time entry has been created in Audit Leverage, it can be deleted as long as the project is open and as long as the time period in which the entry occurs has not been approved.

Note:

A project is considered open for time entries as long as the Closed by Director milestone on the Project Set-up screen does not have a value. For more information, see Chapter 11: “Creating An Audit Project”
Auditor Timesheets

How to Delete Auditor Time Entries

To delete timesheet data, perform the following steps:

1. From the Auditor Timesheet screen in either the Summary or Details tab, select a time entry to delete by clicking on the gray box to the left of the entry.

2. Click on the Edit Time button.

The Time Entry Form appears containing the data for the entry, similar to that shown in Figure 94.

3. Click Delete to remove the entry, or Close to exit without deleting anything.

   The Delete Time Entry? dialog box appears, displaying the information for the entry and prompting you to verify that you want to delete it.

4. Click Yes to delete the changes or No to exit without changing the entry.

   If you click Yes, a message box appears informing you that the entry was deleted. If you click No, you return to the Auditor Timesheet screen.

5. If you clicked Yes, click OK to return to the Auditor Timesheet screen.

   Once you have deleted the entry, you are returned to the Auditor Timesheet screen. The tabs at the bottom of the screen update to reflect the changes.

Viewing Budget-To-Actual Hours

Once you have viewed timesheets, you can compare budgeted hours to actual hours for a project on an auditors timesheet. For detailed information on Budget-To-Actual Hours, refer to Chapter 15: “Working With Budget vs. Actual Audit Hours”.

192
How to View Budget-To-Actual Hours

To view budgeted versus actual charged hours, perform the following steps:

1. In the Summary or Details tab, select the entry whose project number matches the project budget you want to view.

2. From the Audit Timesheet screen click the Go to Budget-to-Actual time comparison button.

The Budget-to-Actual Hours Comparison screen appears, containing the data for the timesheet entry you selected, as shown in Figure 95.
Auditor Timesheets

Perform steps to view or modify the information in this screen as described in Chapter 15: "Working With Budget vs. Actual Audit Hours”.

Approving Timesheets

Once your auditors have entered their time for an auditing project, you can approve or reject the time directly in Audit Leverage, or delete a previously granted approval. Audit Leverage also provides a method to sign off multiple timesheets at one time.

You can use this screen to approve the time for a specific person up to and including a specific date, regardless of the project being charged. Each new approval requires a new row in the table shown in the screen.

Approval Restrictions

• Once an approval is set for a specific date, the auditor whose time was approved can no longer add any time entries for dates prior to the approval date, unless the approval is deleted.
• Once you enter your approval, you cannot edit it. To correct an error, you must delete the approval and recreate it.
• Audit Leverage does not allow anyone to delete your approval except you.
• You can approve time for any auditor except yourself.

How to Approve Single Auditor Timesheets

To approve time entries for auditors individually, perform the following steps:

1. From the Auditor Timesheet screen, click the Approvals button.

The Timesheet Approvals screen appears, similar to that shown in Figure 96.
Approving Timesheets

Figure 96: Timesheet Approvals Screen

The Timesheet Approvals Screen displays a complete list of timesheet approvals, including the name of the auditor whose time has been approved, the date through which the time was approved, who approved the time, and the date on which the time was approved.

2. Scroll, if necessary, to the bottom of the approval list.

3. Click in the last row, marked with a “*”

   The **Approved By** and **Approved On** automatically defaults to the user currently logged in and the current system date.

4. In the **Auditor Approved** column, select the name of the auditor whose time you want to approve.

5. In the **Approved Through** column, enter the date through which the auditor’s time has been approved.
**Auditor Timesheets**

The Timesheet Approval screen updates to reflect the changes.

6. If necessary, repeat Step 3 through Step 5 to approve time for additional auditors.

**How to Delete Single Approvals**

To delete a time entry for an auditor individually, perform the following steps:

1. From the Auditor Timesheet screen, click the **Approvals** button.

The Timesheet Approvals screen appears, as shown previously in Figure 96.

2. Scroll, if necessary, to the entry you want to delete.

3. Select the entry by clicking in the Auditor Approved or Approved Through column.

4. Click the **Delete Selected Approval** button.

Audit Leverage displays a message box warning you to double check the data for the approval you are deleting.

5. Click **OK**.

A message box appears asking you to verify that you want to delete the approval.

6. Click **Yes** to delete the approval or **No** to exit without changing the data.

7. If necessary, repeat Step 2 through Step 6 to delete time approvals for additional auditors.

The Timesheet Approval screen updates to reflect the changes.

**How to Approve Multiple Timesheets**

To approve time entries for multiple auditors at one time, perform the following steps:

1. From the Auditor Timesheet Approval screen shown previously in Figure 96, click the **Batch Approval Wizard** button.
The Timesheet Batch Approval dialog box appears, as shown in Figure 97.

**Figure 97: Timesheet Batch Approval Dialog Box**

2. In the list box, select the names of any auditor whose time you want to approve, or select all auditors by clicking the **Select All** button.

**Notes:**
1. As you click on each auditor’s name, previous selections remain highlighted. To deselect an auditor, click on the name again.
2. If you click the **Select All** button, the button text changes to display **Deselect All**. Click it to deselect all names.
3. In the **Enter Date** field, enter the date through which you want to approve the selected auditors’ time entries.

**Important:**
Once you have approved an auditor’s time through a certain date, the auditor can no longer enter, edit or delete time entries for dates prior to the selected date. Ensure that all selected auditors have completed entering time entries prior to the specified date before approving time.

4. Click the **Approve** button to approve time for all selected auditors through the chosen date, or **Done** to exit without approving the time.
Auditor Timesheets

The Timesheet Approval screen updates to reflect the changes.

Viewing Time Summaries

Once you have viewed time for one or more staff members, you can also view time summaries for that timesheet. The information shown in the time summary you select is based on the filter information you selected from the Auditor Timesheet screen. You can create a time summary from any combination of filters.

Time Summary Types

The following time summaries can be generated from the filtered information in the Auditor Timesheet screen:

- **Project Number**—Groups the timesheet hours by Audit Project ID, and includes project year, budgeted time if any, and time variance of actual versus budgeted time.
- **Project Type**—Groups the timesheet hours by the project type assigned to audit projects in the Project Set-up screen.
- **Auditable Entity**—Groups the timesheet hours by Auditable Entity name, regardless of Audit Project breakout.
- **Business Division**—Groups the timesheet hours by Business Division. You must specify Business Divisions to your entities in the Audit Universe for this time summary to work correctly.
- **Billed To**—Groups the timesheet hours by the company billed. You must specify the company billed when entering timesheet hours for this time summary to work correctly.
- **Region**—Groups the timesheet hours by geographic region. You must specify geographic regions to your entities in the Audit Universe for this time summary to work correctly.
- **Entity Grouping**—Groups the timesheet hours by the Group values set in the Audit Universe.
- **Staff**—Groups the timesheet hours by staff member name.
- **Staff and Project Number**—Groups the timesheet hours by staff member name, and then by individual project ID.
- **Project Cycle**—Groups the timesheet hours by the cycle selected for the audit program.
Viewing Time Summaries

- **Project Cycle and Phase**—Groups the timesheet hours by the cycle assigned for an audit program and then by the phase of the audit which can be assigned to specific timesheet hours during time entry.

- **Project Phase**—Groups the timesheet hours by the phase of the audit which can be assigned to specific timesheet hours during time entry.

- **Project Phase and Cycle**—Groups the timesheet hours by the phase of the audit which can be assigned to specific timesheet hours during time entry and then by the cycle assigned for an audit program.

How to View Time Summaries

To view time summaries based on timesheet filters perform the following steps:

1. From the Auditor Timesheet screen, select the filters you want to use to define the time summary.
2. Click the **Time Summaries** button.

The Module B Main Screen Appears, as shown in Figure 98.
Auditor Timesheets

Figure 98: Module B Main Screen

3. From the Time Summaries by: scrolling list box, select the type of time summary that you want to view.

4. Click Generate Summary to view the selected time summary.

The Auditor Timesheet Totals screen appears displaying all data satisfying the timesheet filters. The information is sorted by time summary type.

Printing Timesheets

Once you have selected the timesheet to view, you can then print it using the selected criteria.

How to Print Timesheets

To print a selected timesheet, perform the following steps:
1. From the Auditor Timesheet, click on the **Print Preview** button.

The Print Options dialog box appears, as shown in Figure 99.

![Print Options dialog box](image)

**Figure 99: Print Options dialog box**

2. From the Print Options dialog box, select the radio button that corresponds to the grouping option you want to use on the report.

3. Click **Preview**.

   A preview of the report appears, with the information grouped using the grouping criterion you selected in Step 2.

4. Select **File>Print** or click the Microsoft Access print icon to output the preview to the printer.
Auditor Timesheets
Working With Budget vs. Actual Audit Hours

The Budget-to-Actual Hours Comparison screen presents a project's budgeted hours compared with hours charged by auditors. Budgets can be created, revised, and printed.

Budgets can be created from scratch. However, they are created automatically if you create a project from the Module A Working Draft of the Audit Plan screen. If you enter a preliminary budget estimate of auditor hours required for a project before clicking the “Create Projects” button on this screen, Audit Leverage creates a starter budget for the project with a one-line entry representing the estimated hours.

This chapter describes the steps to create and work with budgets. This chapter contains the following sections:

• “The Budget-to-Actual Hours Comparison Screen”
• “Interpreting the Budget Screen Display Area”

The Budget-to-Actual Hours Comparison Screen

To view the Budget-to-Actual Hours Comparison screen, from the Timekeeping area of the main Module B screen, click the Budget vs. Actual Audit Hours button.

The Budget-to-Actual Hours Comparison screen appears, as shown in Figure 100.
Working With Budget vs. Actual Audit Hours

Figure 100: Budget-to-Actual Hours Comparison Screen

On the **Budget-to-Actual Hours Comparison** screen, there are two main areas:

The top section of the screen contains project selection and navigation options:

- Project quick search scrolling list boxes
- Shortcuts: buttons to create or change budgets, navigate to the Project Setup screen, navigate to the Auditor Timesheet screen, and print preview the budget

The bottom section of the screen contains the budget information:

- Original budgeted hours, revised estimates, and hours charged to date
- Variances, percentages of budget spent, and totals
The Budget-to-Actual Hours Comparison

How to Search for a Project with a Budget and/or Time Charges

To quick search for a project with either an existing budget, existing time charges, or both, perform the following steps:

1. Find the scrolling list box at the top left of the screen with the label, “Use this drop-down list to view projects that have either time budgets, actual time charges, or both.”

2. Click on the drop-down arrow in the scrolling list box.

   The Enter Parameter Value box appears:

   ![Enter Parameter Value](image)

3. To limit the subsequent list to projects involving a specific entity, enter the first few letters of the entity name in the input field. Or, leave the field blank.

4. Click OK.

5. In the list that appears, use the vertical scroll bar to find the project of interest.

6. With the mouse cursor, highlight and click on the project.

   The project's budget information appears in the display area.

How to Change a Budget

Budgets can be changed to add or remove phases and/or cycles, to add revised estimates, to change numerical values, or to add comments. To change an existing budget, perform the following steps:

1. Click on the Create or Change a Budget button:

   ![Create or Change a Budget](image)

2. Click OK to in the message box that appears.

   The budget spreadsheet view appears, as shown in Figure 101:
Working With Budget vs. Actual Audit Hours

3. To change the original hours budgeted, click in one of the cells under the **Hours Budgeted** column.

4. Type the new number.

**Notes:**

1. You can budget by phase, cycle, or combination of phase and cycle.

2. No two rows in the budget spreadsheet can have the same phase, including the “N/A” phase.

3. Although the cycle field appears on the budget spreadsheet view, it does not appear on the budget display screen.

5. To change the phase or cycle budgeted, click in the scrolling list box in one of the cells under the **Phase** or **Cycle** column.
The Budget-to-Actual Hours Comparison

6. Select an entry.
7. To enter a revised estimate, click in one of the cells under the Revised Estimate column.
8. Type a number.
9. To create a new row, vertical scroll to the bottom of the spreadsheet.
10. Click in a cell in the row with the asterisk.
11. Enter a phase, cycle, hours budgeted, and detailed comments.

How to Create a New Budget

To create a new budget, perform the following steps:
1. Find the scrolling list box at the top right of the screen with the label, “Use this drop-down list to start a new budget.”
2. Click on the drop-down arrow in the scrolling list box.
   The Enter Parameter Value box appears:

   ![Enter Parameter Value](image)

3. To limit the subsequent list to projects involving a specific entity, enter the first few letters of the entity name in the input field. Or, leave the field blank.
4. Click OK.
5. In the list that appears, use the vertical scroll bar to find the project of interest.
6. With the mouse cursor, highlight and click on the project.
7. Click OK to in the message box that appears.
   The budget spreadsheet view appears as shown in Figure 102:
**Working With Budget vs. Actual Audit Hours**

![Figure 102: New Budget Spreadsheet View](image)

**Note:**

Budgets can be set up with one lump sum total of auditor hours. This is represented by one row in the spreadsheet with a single number in the **Hours Budgeted** column. Budgets can also be broken out by phase, cycle, or a combination of both. This is represented by multiple rows in the spreadsheet. However, no two rows in the budget spreadsheet can have the same phase, including the "N/A" phase. While the cycle field appears in the budget spreadsheet view, it does not appear on the budget display screen.

8. If you want to enter a single lump sum number of auditor hours, click in the cell under the **Hours Budgeted** column.

9. Enter a number representing all hours budgeted for the project.
Interpreting the Budget Screen Display

To subdivide the budgeted hours by phase, perform the following steps:
1. Click on the scrolling list box in the cell under the Phase column.
2. Select a phase from the list.
3. In the Hours Budgeted column, enter a number of hours budgeted for that phase.
4. To allocate budget hours to another phase, click on the new row at the bottom of the spreadsheet.
5. Repeat Step 1 through Step 3.
6. Repeat Step 1 through Step 5 for every phase for which you want to allocate budget hours.

How to Subdivide Budgeted Hours

To subdivide the budgeted hours by cycle, perform the following steps:
1. Click on the scrolling list box in the cell under the Cycle column.
2. Select a cycle from the list.
3. In the Hours Budgeted column, enter a number of hours budgeted for that phase.
4. To allocate budget hours to another cycle, click on the new row at the bottom of the spreadsheet.
5. Repeat Step 1 through Step 3.
6. Repeat Step 1 through Step 5 for every cycle for which you want to allocate budget hours.

Interpreting the Budget Screen Display Area

Once a budget is created through the budget spreadsheet, numbers appear under the columns in the display area of the Budget-to-Actual Hours Comparison screen, as shown in Figure 103.
Working With Budget vs. Actual Audit Hours

The **Budget-to-Actual Hours Comparison** display area contains the following columns, with totals at the bottom of the screen:

- **Project number**
- **Phase**
- **Original hours budgeted**
- **Revised estimate**
- **Hours charged to date by auditors**
- **Variances over or under budget**
- **Percentage of budget spent per line item**
- **Description column for entering detailed comments on the original budget and subsequent progress**

**Figure 103: Budget-to-Actual Hours Comparison Screen, with Budget Data displayed**

![Budget-to-Actual Hours Comparison Screen](image-url)
Interpreting the Budget Screen Display

A budget has one row in the display area if only a lump sum number of auditor hours was budgeted. Alternatively, a budget can have multiple rows if the budget was broken into more than one phase.

As auditors charge time to a project using their timesheets, the **Hours Spent So Far** column is automatically updated.

If a budget is revised, the revised number(s) appears in the **Revised Estimate** column. The total at the bottom of the **Revised Estimate** column reflects the new budget total. Below that, the budget differential is displayed in the field labeled **Resultant additional hours budgeted**. Audit Leverage calculates the variance numbers and **Percentage of Budget Spent** percentages against any revised figures, when they exist.

How to Print Preview a Budget

To print preview a budget, perform the following steps:

1. Click the **Print Preview the budget showing** button.

The **Budget-to-Actual Hours Comparison** print preview appears, as shown in Figure 104:
Working With Budget vs. Actual Audit Hours

Figure 104: Budget Print Preview Screen

2. Click the printer button on the Access toolbar, or use the menu option File > Print to send the report to a printer.

How to Navigate to Other Screens

To navigate to the auditor timesheet screen, click the Go to Auditor Timesheet button.

To navigate to the Project Set-up screen for the project whose budget is currently displayed, click on the Go to Audit Set-up screen button.

212
Module C Overview

Module C contains all of the operations required to track audit programs and workpapers. From Module C you can create and modify audit programs, audit program templates and workpapers. Audit findings and review notes can be viewed, as well as the general status of the audit.

The workpapers tracked within Audit Leverage can be either hardcopy or available electronically, stored directly in Audit Leverage or linked from its location on your hard drive or network.

Once an audit program and its associated workpapers is underway, audit findings and review notes are generated by Audit Leverage for review.

To access the functions of Module C, from the Audit Leverage Main screen, click the Workpapers button.

The Module C screen appears, as shown in Figure 105.
The following selections are available in Module C:

- Choose Audit Project
- Audit Programs
- Audit Program Template Library
- Workpaper Index
- Findings
- Review Notes
- Audit Status Screen

The following chapters describe each selection in detail.
Planning Workpapers

In Audit Leverage, audit steps, file attachments, review notes, findings, management responses, and follow-up entries are the heart of day-to-day audit work. Audit Leverage collectively refers to these audit components as workpapers.

This chapter addresses procedural issues for workpapers, such as sign-off and status tracking policies, and options in generating the audit report directly within Audit Leverage. It also covers those components on which you can perform data analysis in the Search Your Database tool: findings and management responses. Before performing audit activity in the software, it is important to consider what fields you want to use in defining your workpapers.

This chapter poses the following questions that you should answer to plan your workpapers in Audit Leverage:

- **Sign-Offs and Statuses**
  - What audit components have sign-offs and statuses?
  - How are statuses used in Audit Leverage?
  - How are statuses manually and automatically updated?
  - What changes can you make to the default statuses in Module G?

- **Defining Findings**
  - What is a finding?
  - How does Audit Leverage help you to describe your findings?

- **Defining Management Responses**
  - What is a management response?
  - How does Audit Leverage help you to describe your management responses?
Planning Workpapers

- **Audit Reports**
  - Do you want Audit Leverage to automatically generate audit reports for projects?
  - Do you want to use an existing format, or have one customized for your department?
  - If you want to use an existing format, should you edit any of the standard text or field references?

- **Reporting and data analysis considerations**
  - What reporting and data analysis needs do you have which drive your choices of fields to populate?

- **Establishing your department’s conventions**
  - What Audit Leverage fields do you plan to use to describe your workpapers?
  - What conventions should you establish for identifying entities through the key fields?
  - For the non-key fields, what possible values or data entry conventions do you want to establish?

Your department should take the time to discuss the questions listed above, and strategize about possible conclusions. This is a crucial first step toward a successful Audit Leverage implementation.

This chapter contains the following sections designed to assist you in this process:
- “Statuses”
- “Defining Findings”
- “Defining Management Responses”
- “Audit Reports”
- “Reporting and Data Analysis Considerations”
- “Establishing Your Department’s Conventions”

**Statuses**

What audit components have statuses?

Findings, audit steps, review notes, and file attachments have work statuses to enable auditors to capture the degree of work performed or completed, or level
Statuses of review applied to each. For example, default work statuses for a file attachment include:

- 10-Not yet started
- 20-Work progressing
- 30-Work halted; waiting for information
- 40-Ready for review
- 50-Approved by first reviewer
- 60-Approved by second reviewer
- 70-Approved by third reviewer

**How are statuses used in Audit Leverage?**

Maintaining the status of audit components, either manually or through sign-offs, allows you to track progress through the Project Status tool in Module C. This query helps you track the status of an audit by showing the status of all audit steps, attachments, review notes and findings. The query can be filtered for a particular project, and for a particular staff person’s responsibilities.

**How are statuses manually and automatically updated?**

Statuses can be manually updated by selecting a status from the scrolling list box on each screen. Some statuses are automatically updated when sign-offs are applied. For example, the statuses in Table 1 are changed automatically when preparers and reviewers sign off on a file attachment. Statuses revert to their previous state when sign-offs are deleted. Similar statuses exist for audit steps, findings, and review notes. To see all the possible statuses, check the respective screens, or the corresponding status code tables in Module G.

<table>
<thead>
<tr>
<th>Action Taken</th>
<th>Status Changes From</th>
<th>Status Changes To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparer signs off</td>
<td>Previous status</td>
<td>40-Ready for review</td>
</tr>
<tr>
<td>Reviewer 1 signs off</td>
<td>40-Ready for review</td>
<td>50-Approved by 1st reviewer</td>
</tr>
<tr>
<td>Reviewer 2 signs off</td>
<td>50-Approved by 1st reviewer</td>
<td>60-Approved by 2nd reviewer</td>
</tr>
<tr>
<td>Reviewer 3 signs off</td>
<td>60-Approved by second reviewer</td>
<td>70-Approved by 3rd reviewer</td>
</tr>
</tbody>
</table>
Planning Workpapers

What changes can you make to the default statuses in Module G?

In some cases, the numbers associated with status text have specific meanings within the Audit Leverage software. Therefore, you should not delete or change the number values or meaning of the status codes unless necessary. You should limit changes or additions of status codes in Module G to the following:

- Audit step status codes: anything above 10 but less than 40
- File attachment status codes: anything above 10 but less than 40
- Review note status codes: anything above 10 but less than 30
- Finding status codes: anything above 10 but less than 40.

Note:
Decide whether your department wants to maintain the status fields, either manually or through use of the sign-off process, or both. Determine if you must adjust any of the status codes in the bulleted list above, and if so, make the necessary changes or additions in Module G.

Defining Findings

What is a finding?

Findings are the exceptions discovered during an audit. They are observations of activity that fall outside the expected norms or rules. They can be good, bad, or neutral. Some findings are included in the final audit report, and some are handled in other ways. When you execute an audit program, findings inevitably result.

In general, Audit Leverage uses the term finding to refer to the exceptions and all other associated information, such as a recommendation, criteria and risk, management responses, and other related data.

How does Audit Leverage help you to describe your findings?

Audit Leverage helps you define your findings through fields on the Findings screen in Module C, as shown in Figure 106.
Defining Findings

The Findings screen contains eight tabs. Findings are defined by populating the required field — the **follow-up status** field on the **Management Response** tab — as well as various fields on the eight tabs. Your department management should study the fields on these tabs and ask the following questions:

- How do you want to describe your findings? Consider fields related to:
  - General finding information, including the finding text, recommendation text, subheading for the report, finding sequence number, and disposition level.
  - Fields on the **Main** tab by which you can perform data analysis through the Search Your Database tool. These fields include the associated cycle, subcycle, task, audit step, file attachment, finding author, control issue, finding type, respondent, risk severity code, financial impact, and repeat.
Planning Workpapers

finding flag.
— Background of the finding, criteria and risk.
— Associated management responses, including response, action plan,
  level of agreement, responsible department and person(s), explanation
  of disagreement, auditor rebuttal, completion dates and status.
— Synopsis of the finding and recommendation to feed into the Audit
  Director’s Audit Summary Report in Module D.

• What fields are important to use in accurately describing your findings?

The answers to these questions determine what attributes are important and
what fields your department wants to populate. Possible entries for scrolling list
box fields must be defined in Module G.

For a description of the fields on the Findings screen, see Appendix
C: “Appendix - Module A, B & C Fields”.

Defining Management Responses

What is a management response?

Management responses are the responses of the auditee to the findings and
recommendations presented by the internal auditors.

How does Audit Leverage help you to describe your management
responses?

Audit Leverage provides a tab on the Module C Findings screen for entering
management response data, as shown in Figure 107.
For each finding, multiple management responses can be created, if necessary. Therefore, if more than one department or responsible party at the auditee responds, you can capture those responses separately while still tying them to a specific finding. Navigation through multiple management responses is performed by clicking on the innermost record navigator bar just below the **Actual Date** field.

**Note:**

Unless your auditees are granted Audit Leverage log-in access to your database, auditors must copy management responses from a source e-mail or document into the Audit Leverage fields.

Your department management should study the fields on the **Management Response** tab and ask the following questions:
Planning Workpapers

- How do you want to log your auditee management responses? Consider fields related to:
  - Management's response
  - Management's action plan
  - Level of agreement, explanation of disagreement, and auditor rebuttal
  - Responsible department, responsible person(s)
  - Original target date, revised target date, and actual target date, along with a change history text field to capture reasons for date changes
  - Follow-up status - required field
  - File attachment field for attaching electronic documents, such as e-mail text or word processing documents containing the original form of the auditee responses

- What fields are important to use in accurately describing your management responses?

The answers to these questions determine what attributes are important and what fields your department wants to populate. Possible entries for scrolling list box fields must be defined in Module G.

For a description of the fields on the Management Response screen, see Appendix C: “Appendix - Module A, B & C Fields”.

Audit Reports

Do you want Audit Leverage to automatically generate audit reports for projects?

Audit Leverage can automatically generate an audit report and the accompanying cover memo for each project. The cover memo combines data from fields on the Findings and Project Set-up screen with standard text supplied in the software. You can choose from a number of audit report formats.

Do you want to use an existing format, or have one customized for your department?

You can choose to generate a cover memo and audit report from one of the existing formats supplied with the software. Or, you can submit specifications for your own format to IAD Solutions for customization into the software. Alternatively, if someone in your department has Microsoft® Access report design skills, he or she can create a custom report format for inclusion in the software. If you desire a customized solution, contact Audit Leverage support for guidance.
Reporting and Data Analysis

If you want to use an existing format, do you need to edit any of the standard text or field references?

The standard text and field references used in the cover memos of the existing audit report formats can be changed on a project-by-project basis. See Chapter 22: “Generating the Audit Report” for steps to generate and edit the audit report cover memo. The cover memo text and field references can be permanently changed for all projects in Module G. If you want to change or add new field references, IAD Solutions recommends that your Audit Leverage system administrator contact support for assistance in identifying new fields.

The formatting of the cover memo and the body of the report can also be permanently changed. Only someone with Microsoft Access expertise should attempt this procedure. Since this is a front-end database change, any changes you make are overwritten when you upgrade. Therefore, you should save the changed form to an Access database file outside of Audit Leverage so you can import it into the software again after an upgrade. Any modified front-end database file must be redistributed to all machines for those changes to be available to all users.

Note:
Examine the cover memo and audit report options by clicking the Create or edit audit report cover memo button on the Main tab of the Findings screen. Decide if your department wants to generate audit reports from within Audit Leverage. If you do, determine if one of the existing formats can be used with or without customization in Module G. Or, determine if you want to create a customized format.

Reporting and Data Analysis Considerations

What reporting and data analysis needs do you have which drive your choices of fields to populate?

After you have explored the Module C Workpapers screens, your department management should consider its reporting requirements. Consider by what workpaper characteristics you want to aggregate data when analyzing your audit history. For example:

- Do you want to analyze the results of all findings of a particular type, such as all operational-related findings? Or all internal control-related findings? If so, for each finding, populate the finding type field to enable data analysis by finding type.
Planning Workpapers

- Do you want to report on all findings rated at a specific severity level? If so, for each finding, populate the risk severity code field.

- Do you want to search for all findings that emerged from a particular cycle or audit program, and involving a particular control issue? If so, for each finding, populate the cycle field and the control issue field.

- Do you want to search for findings involving a certain financial savings? If so, for each finding, populate the resulting savings field.

- Do you want to search for management responses or action plans using certain keywords? If so, for each finding, populate the management’s response and management’s action plans fields in a consistent manner.

- Do you want to search for management responses in a certain follow-up status? If so, for each finding, consistently update the follow-up status for each management response.

Once you have considered questions like these, and explored the Findings screen, navigate to the Search Your Database tool to understand your searching and data analysis capabilities in Audit Leverage. See Chapter 12: “Working With Search Your Database” for more information on this tool. Also, examine the Module C Project Status tool to determine how Audit Leverage can help you to track the status of audit steps, file attachments, findings and review notes.

Note:
After researching the Findings screen, the Search Your Database tool, the Project Status tool, and other reports in Audit Leverage, make a list of the workpaper-related fields you want to use.

Establishing Your Department’s Conventions

Once you have determined the workpaper-related fields you want to use, your department must establish its conventions and convey them to those responsible for creating and maintaining workpapers. To establish your conventions, answer the following questions and perform the corresponding steps:

What Audit Leverage fields do you plan to use to describe your workpapers?
- Make a list of all Audit Leverage fields your department plans to use in defining workpapers, including the key fields marked by an asterisk. It may be helpful to screen print the tabs of the Findings screen and mark them. You may also want to screen print the Audit Program Collection screen tabs,
Establishing Your Department’s

the Attachment Index screen, and the Review Notes screen to become familiar with the fields on these screens.

What conventions should you establish for identifying entities through the key fields?

• Audit steps require a step title. Attachments require an attachment ID. Findings require a follow-up status. Decide what your conventions, if any, may be for identifying these audit components through their key fields.

For the non-key fields, what possible values or data entry conventions do you want to establish?

• For every scrolling list box you intend to use, determine the possible entries that should appear when the user clicks the arrow. Enter these values in the corresponding Module G tables. See Chapter 27: “Module G: Table Settings” for instructions on how to populate the Module G tables.

• For every other type of field, establish conventions for data population to make entries consistent, and therefore more meaningful, across your workpapers.

For example, if you want to use the Criteria & Risk tab on the Findings screen, establish guidelines as to what types of information should be entered. If you want to use the File Attachments field on the Main tab of the Findings screen, establish guidelines as to what kinds of files should be attached, whether or not they should be attached for every project, and whether or they should be linked or embedded.

Note:

Ensuring data entry consistency enables you to perform more effective data analysis through Search Your Database and other tools.

• Determine if there are any fields that you want to redefine for use other than the way in which they are labeled. Your department can use Audit Leverage fields in any way it wants. Care must be exercised, however, in redefining the meaning of fields, because some fields are used in reports and queries elsewhere in the software. Research the reports and queries in the software before publishing any changes to the use of fields other than that implied by the field label.
Planning Workpapers
The Audit Program Template Library is a warehouse for all audit programs your department uses on a recurring basis. These templates are stored and maintained in the library as the original versions of the programs. When you need to use a template program in a particular project, you copy and import it into the appropriate cycle, subcycle and task designation in the project.

To each template audit step, you can attach a starter workpaper. These starter workpapers are copied into audit projects when the template is copied. This provides auditors with a skeleton or framework with which to create appropriate workpapers for a project. These template workpapers can be any type of document, but the most common are spreadsheets and word processing documents.

This chapter describes the steps to create audit program templates. This chapter contains the following sections:

- “The Audit Program Template Library Screen”
- “Creating A New Template”
- “Signing Off on a Template”

**The Audit Program Template Library Screen**

To view audit program templates, from the Main Module C screen, click the Audit Program Template Library button.
Working With the Audit Program Template Library

The Audit Program Template Library screen appears as shown in Figure 108.

![Audit Program Template Library Screen](image)

**Figure 108: Audit Program Template Library**

On the Audit Program Template Library screen, there are two main areas:

- The top area section of the screen provides template search, basic information and navigation options:
  - The **Program Template Name** scrolling list box for selecting a template
  - General template information including the **Program Template Description**, **Audit Program Sequence #** and **Audit Cycle**
  - The **Program Section Filter** scrolling list box, and a checkbox for showing steps in spreadsheet view
  - Buttons to display a list of available templates, create a new template, and print preview the currently displayed template.
  - Sign-Off area in which the preparer and reviewer(s) of the program template can apply sign-offs.
The bottom section of the screen contains the audit program step information. It displays three steps at a time. The record navigator bar at the bottom of the screen allows you to navigate from step to step within a program template. You can also use the vertical scroll bar to move between steps.

**How to Search for an Existing Template**

To quick search for an existing template, perform the following steps:

1. In the *Program Template Name* scrolling list box at the top of the screen, select the name of the template you want to view.

The screen view changes to display the template’s steps, as shown in Figure 109.
How to View Existing Program Steps

Each block containing an **Audit Program Section**, **Audit Step Title**, **Sequence #**, **Description of Audit Step**, and **Doclink** field represents an audit step. Each audit step block is separated by a thin black line. Three steps are displayed at one time. You can use the record navigator to move between steps, or use the vertical scroll bar.

To filter the displayed data to show only those program steps belonging to one section of the program, perform the following steps:

1. In the **Program Section Filter** scrolling list box, select the section of the audit program you want to display.
The Audit Program Template Library

The bottom area displays the first step in the selected section. The record counter reflects the total number of steps in that section of the program.

To remove the program section filter, perform the following steps:

1. In the Program Section Filter scrolling list box, click and drag your mouse to highlight the name of the program section.
2. Press Delete.
3. Press Enter to remove the filter.

The bottom area displays the first step in the program. The record counter shows the total number of steps in the program.

How to View Steps in Spreadsheet View

To show the selected audit program template's steps in spreadsheet view, perform the following steps:

1. Click the Show audit steps in spreadsheet view checkbox.

The bottom area changes to display all audit steps in a scrollable spreadsheet view, as shown in Figure 110.
Working With the Audit Program Template Library

Figure 110: Program Template Library, Spreadsheet View

2. Use the vertical scroll bar or the record counter bar to navigate down the rows of the spreadsheet.

3. Use the horizontal scroll bar to view all the columns.

4. Click and drag on the column borders and row borders to resize columns and rows.

5. Deselect the Show audit steps in spreadsheet view checkbox to return to form view, displaying three steps at a time.

How to Print Preview a Program

To print preview existing program steps, perform the following steps:

1. Click the Print Preview the Template Shown on this Screen button.
Creating A New Template

A print preview of the audit program appears.

2. Click the printer button on the Access toolbar, or select **File > Print** to send the report to a printer.

3. Click **Close** to return to the Audit Program Template Library screen.

Creating A New Template

To create a new template, you must first enter its name into the Audit Program Listing table. Then you enter steps on the Audit Program Template Library screen.

How to Create a Template Name

To create a new program template name, perform the following steps:

1. Click the Create a New Template button.

The **Edit Audit Program Listing** table appears with a message box, as shown in Figure 111.
2. Click OK to the message box that appears.
3. Click on the last row of the spreadsheet.
4. In the Audit Program ID column, enter the name of the new template.
5. In the # column, enter the sequence number to represent the order in which you want this template to appear in the list of templates.
6. In the Description column, enter a description for the template.
7. In the Associated Cycle scrolling list box, select a cycle to which this template corresponds, if applicable. This is optional.

**Note:**
Entering an Associated Cycle helps auditors when they need to copy the template steps into a project on the Audit Project Set-up screen.
Creating A New Template

On that screen, when they click on the Program Template Name scrolling list box to select a template to copy, only those templates whose associated cycle matches the project's cycle appear as choices. Also, any templates with no entry in the associated cycle field appear as choices.

8. Click Close to return to the Audit Program Template Library Screen.

How to Create Program Template Steps

The bottom of the screen contains all step information, including the section of the audit program to which the step belongs, the step title, sequence number, description and doclink.

To create audit program template procedures, perform the following steps:

1. In the Program Template Name scrolling list box, select the new template. The Program Template Description, Audit Program Sequence #, and Audit Cycle (optional) fields are automatically populated with the data previously entered in the Audit Program Listing Table. If those fields were not populated when the Program Template Name was entered, you can enter data in them now.

2. If you plan to have many steps and want to divide the steps into program sections, type a section name in the Audit Program Section field. If not, leave it blank.

Note:

Use an alpha or numeric prefix with all program section names to ensure that the sections remain in the desired order. Sections without prefixes are automatically sorted alphabetically by section name.

The Audit Step Title field is just below the Audit Program Section field.

3. In the Audit Step Title field, type the title for the step. This is a required field.

4. In the Seq. # field, enter a sequential number representing the order in which you want this step to appear.

   If you have more than 9 steps, use a leading zero.
Working With the Audit Program Template Library

Note:
If you use program sections, you may prefer to restart step numbering when you start a new section.

5. In the Description of Audit Step field, enter the procedure for the step.
   As the program template author, you may want to associate a starter workpaper with an program template step. When auditors copy the template into specific audit projects, they launch the starter workpaper and use it as a framework for building a project-specific workpaper. Starter workpapers can be any type of document. Commonly used starter workpapers are spreadsheets with column headings and formulas predefined, or word processing documents with questions or checklists.

6. In the Doclink for Further Explanation (if any) field, link or embed a starter workpaper. For steps on how to link or embed a file, see "How to Add Attachments" in Chapter 19: "Working With the Audit Program Collection".

7. To create another new audit step in the same program section, click on the next audit step block.

8. In the Audit Program Section scrolling list box, select the program section.

9. Repeat Step 3 through Step 6 for every step you want to include in the section.

10. To create a new audit step in a new program section, repeat Step 2 through Step 6.

11. Click the Delete Audit Step button to permanently delete an audit step from the program template.

How to Add Program Template Steps

To add additional steps to an existing program template, perform the following steps:

1. If you want to add audit steps to an existing program section, in the Program Section Filter scrolling list box, select the program section.
   Audit Leverage automatically filters the steps so that only those belonging to the section are displayed.

2. Click on the new record button on the record navigator.

3. Perform Step 3 through Step 9 of “How to Create Program Template Steps”.
Signing Off on a Template

4. If you want to add a steps in a different program section, perform Step 2 through Step 9 of “How to Create Program Template Steps”.

Notes:

1. If you insert new steps and want to re-order them, adjust the Sequence # of the affected steps as necessary.
2. If you add new sections and want to re-order them, adjust the alpha or numeric prefixes of the affected program sections as necessary.

Signing Off on a Template

The Sign-Offs area of the screen allows auditors to sign off indicating completion of the audit program template. It also allows up to three reviewers to sign off after reviewing the work. This section describes the assignment of preparers and reviewers, and the sign-off process.

How to Designate Preparers and Reviewers

To assign a program template’s preparer and reviewers, perform the following steps:

1. In the Auditor scrolling list box above the Owners's Sign-Off button, select the name of the auditor who bears responsibility for creating the template.
2. In the Auditor scrolling list boxes above the Co-Owner Sign-Off buttons, select the names of the auditors who you expect to review the owner’s template.

How to Sign-Off an Audit Program Template

For instructions on sign-offs and the effects of applying sign-offs, see Chapter 3: “The Sign-Offs Tab and Record-Level Security”.

Note:

Once sign-offs are applied, the template becomes read-only. If future updates to the template are necessary, sign-offs must be removed in the reverse order in which they were applied. Then, changes to the template can be made, and sign-offs reapplied.
The Audit Program Collection holds all the audit steps performed during a project. These steps can be created from scratch, obtained by copying a program stored in Audit Leverage’s Program Template Library, or both.

Audit Leverage allows you to connect file attachments, findings and review notes to the steps that precipitated them. You then can navigate from an audit step to all of the associated file attachments, findings and review notes.

This chapter describes the steps to create and work with audit program steps. This chapter contains the following sections:

- “The Audit Program Collection Screen”
- “The Main Tab”
- “The Sign-Offs Tab”
- “The Attachments Tab”

**The Audit Program Collection Screen**

To view the Audit Program Collection Screen, from the Main Module C screen, click button 1 for the **Audit Program Collection**.

The Audit Program Collection Screen appears as shown in Figure 112.
Working With the Audit Program Collection

Figure 112: Audit Program Collection screen with sample data

On the Program Collection Screen, there are two main areas:

- **Project Search, Program Display and Navigation Options**: the top section of the screen contains:
  - The project quick search scrolling list box for finding projects
  - A box to the right of the quick search containing general project information including the entity name, audit title, and project staffing
  - The cycle scrolling list box for finding programs by their cycle/subcycle/task/template/auditor name combinations
  - Display area including including the subcycle, task, and template identified with the selected program
  - Program display options: program section filter scrolling list box, and checkboxes for showing included steps only, and showing steps in spreadsheet view
  - Buttons to print preview audit program steps, and navigate to findings and review notes for the displayed step
The Audit Program Collection Screen

- **Audit Step Display**: the bottom section of the screen contains tabs with program information. It displays one program step at a time. The record navigator bar at the bottom of the screen allows you to navigate from step to step within a program, no matter which tab is selected.

**How to Search for a Project**

To quick search for an existing project, perform the following steps:

1. In the **Audit Program Collection for** scrolling list box at the top of the screen, click on the drop-down arrow.

```
Audit Program Collection for: ────────────────────────────
```

The **Enter Parameter Value** box appears as shown in Figure 113:

![Figure 113: Enter Parameter Value Box](image)

2. To limit the subsequent list to projects involving a specific entity, enter the first few letters of the entity name in the input field. Or, leave the field blank.

3. Click **OK**.

4. In the list that appears, use the vertical scroll bar to find the project of interest.

5. With the mouse cursor, highlight and click on the project.

Information on the first program for the selected project is shown on the screen.

**How to View Existing Program Steps**

To select a program for which to view, create, edit or delete steps, perform the following steps:

1. In the **Cycle** scrolling list box, select the cycle/subcycle/task/template/auditor combination representing the program for which you want to view steps.

```
Working With the Audit Program Collection

The Subcycle, Task and Program Template Name fields display the corresponding values for the cycle selected.

The tabbed area displays the first step in the program. The record counter shows the total number of steps in the program. The Main tab is displayed by default, as shown in Figure 114.

Figure 114: Audit Program Collection screen, Main tab

2. In the Program Section Filter scrolling list box, select the section of the audit program you want to display.

The tabbed area displays the first step in the selected section. The record counter reflects the total number of steps in that section of the program.
The Audit Program Collection Screen

To remove the program section filter, perform the following steps:

1. In the **Program Section Filter** scrolling list box, click and drag your mouse to highlight the name of the program section.
2. Press Delete.
3. Press Enter to remove the filter.

   The tabbed area displays the first step in the program, if any exist. The record counter shows the total number of steps in the program.

### How to View Included Steps Only

To display only steps included in the audit, perform the following steps:

1. Select the **Show included steps only?** checkbox.

   If any steps have been de-selected for performance in the audit, the record counter changes to reflect a reduction in the number of audit steps displayed.

2. To remove the filter, deselect the **Show included steps only?** checkbox.

   The record counter changes to reflect the total number of audit steps in the program.

### How to View Steps in Spreadsheet View

To show the selected audit program's steps in spreadsheet view, perform the following steps:

1. Click the **Show spreadsheet view?** checkbox.

   The tabbed area changes to display all audit steps in a scrollable spreadsheet view, as shown in Figure 115.
Working With the Audit Program Collection

Figure 115: Main Tab, Spreadsheet View

2. Use the vertical scroll bar or the record counter bar to navigate down the rows of the spreadsheet.

3. Use the horizontal scroll bar to view all the columns.

4. Deselect the Show spreadsheet view? checkbox to return to form view, displaying one step at a time.

How to Start a Finding for an Audit Step

To navigate to the Findings screen in order to write a finding for an audit step, perform the following steps:

1. Use the record navigator to locate the step for which you want to write a finding.

2. Click the Findings button.

The Findings screen appears, with the associated project ID, cycle, subcycle, task, and audit step fields automatically populated.

For steps on how to create a finding, see Chapter 20: “Findings”.
How to Start a Review Note for an Audit Step

To navigate to the Review Notes screen in order to write a review note for an audit step, perform the following steps:

1. Use the record navigator to locate the step for which you want to write a review note.
2. Click the Review Notes button.

The Review Notes screen appears, with the associated project ID, cycle, subcycle, task, and audit step fields automatically populated.

For steps on how to create a review note, see Chapter 23: “Review Notes”.

How to Print Preview a Program

To print preview existing program steps, perform the following steps:

1. Click the Print Preview Audit Program Steps button.

A print options box appears as shown in Figure 116.

![Figure 116: Print Options]

2. Click the radio button next to the desired printing option.
3. Click the Preview button.
Working With the Audit Program Collection

A print preview of the audit program(s) appears.

4. Click the printer button on the Access toolbar, or select File > Print to send the report to a printer.

How to Navigate to Other Modules

The top portion of the Audit Program Collection screen presents options to navigate to other modules within Audit Leverage.

- To view all findings related to the currently displayed audit step, or to create a new finding for the step, click the Findings button.

- To view all review notes related to the currently displayed audit step, or to create a new review note for the step, click the Review Notes button.

Entering Information in the Tabs

You create, edit and delete step information in the tabs that are included in the bottom portion of the screen. Detailed descriptions for each of these tabs can be found in the following sections:

- “The Main Tab”
- “The Sign-Offs Tab”
- “The Attachments Tab”

The Main Tab

The Main tab contains all step information, including the section of the audit program to which the step belongs, the step title, sequence number, description, status, and other buttons and checkboxes. When you first enter the Audit Program Collection screen, the Main tab is displayed by default, as shown in Figure 117.
How to Create New Audit Program Steps

To create a new set of audit program steps, the program’s cycle, subcycle, task, template, and auditor designations must preliminarily be defined in Module B, Project Set-up. See “The Program Set-up Tab” in Chapter 11: “Creating An Audit Project”.

Once the program is defined on the Project Set-up screen, to create audit procedures, perform the following steps:

1. In the Cycle scrolling list box, select the program for which you want to create steps.
Working With the Audit Program Collection

**Note:**
In Audit Leverage, audit programs are uniquely identified by a combination of the cycle, subcycle, task, template, and auditor fields.

2. Click on the **Main** tab.

   The Main tab displays as shown in Figure 118.

![Figure 118: Main Tab, no steps displayed](image)

3. If you plan to have many steps and want to divide the steps into program sections, type the first section name in the **Program Section** field. If not, leave it blank.

**Note:**
Use an alpha or numeric prefix with all program section names to ensure that the sections remain in the desired order. Sections
without prefixes are automatically sorted alphabetically by section name.

4. In the **Audit Step Title** field, type the title for the step. This is a required field.

5. In the **Sequence #** field, type a sequential number representing the order in which you want this step to appear.
   If you have more than 9 steps, use a leading zero.

**Note:**
If you use program sections, you may prefer to restart step numbering when you start a new section.

6. In the **Audit Step** field, type the step's procedure.

7. To create a new audit step within the same program section, click on the **new record** button on the Microsoft Access record navigator.

8. Repeat Step 4 through Step 7.

9. To create a new audit step in a new program section, repeat Step 3 through Step 8.

10. To create a new audit step for another program, repeat Step 1 through Step 9.

**How to Import Program Template Steps**

To create audit program steps by copying steps from a pre-defined audit program template, see “The Program Set-up Tab” in Chapter 11: “Creating An Audit Project”.

**How to Remove Template Steps From a Program**

Once template steps are imported, perform the following steps to indicate which steps should be performed for this audit:

1. In the **Cycle** scrolling list box, select the program for which template steps were imported.

2. Click on the **Main** tab.

3. Navigate to the step of interest using the record navigator.

4. Decide if the audit step should be performed for this audit. If not, either:
Working With the Audit Program Collection

a. Leave the audit step in the program but indicate that it should not be performed for this audit by deselecting the **Perform for this audit?** checkbox.

b. Or, click the **Delete Audit Step** button to permanently remove the step from this program.

How to Add Audit Program Steps

To add additional steps to the ones imported from the template, perform the following steps:

1. In the **Cycle** scrolling list box, select the program for which you want to create steps.

2. If you want to add audit steps to an existing program section, in the **Program Section Filter** scrolling list box, select the program section.
   
   Audit Leverage automatically populates the **Program Section field on the Main tab** with the section name selected.

3. Click on the **Main** tab.

4. If you want to create a new program section, type the section name in the **Program Section field**.

   **Note:**
   
   Use an alpha or numeric prefix with all program section names to ensure that the sections remain in the desired order. Sections without prefixes are automatically sorted alphabetically by section name.

5. In the **Audit Step Title** field, type the title for the step. This is a required field.

6. In the **Sequence #** field, type a sequential number representing the order in which you want this step to appear. If you have more than 9 steps, use a leading zero.

7. In the **Audit Step** field, type the step's procedure.
8. To create a new audit step within the same program section, click on the new record button on the Microsoft Access record navigator.

9. Repeat Step 5 through Step 8.

10. To create a new audit step in a new program section, repeat Step 4 through Step 9.

11. To create a new audit step for another program, repeat Step 1 through Step 10.

**How to Navigate Between Steps**

To navigate between audit steps, perform the following steps:

1. In the Cycle scrolling list box, select the program of interest.

2. If applicable, in the Program Section Filter scrolling list box, select a program section to examine.

3. Use the record navigator arrows to navigate back and forth between steps.

4. Repeat Step 1 through Step 3 as necessary to examine other programs, program sections, and/or steps.

**How to Delete an Audit Step**

To delete an audit step from a program, perform the following steps:

1. In the Cycle scrolling list box, select the program of interest.

2. If applicable, in the Program Section Filter scrolling list box, select a program section to examine.

3. Click on the Main tab.

4. Use the record navigator arrows to display the step of interest.

5. Click the Delete Audit Step button.

   The Delete Step confirmation box appears asking you to confirm deletion of the step.

6. Click Yes to delete the step.

**Note:**

If a step has no sign-offs applied, you can delete it if your user log-in name name matches one of the names designated as preparer or reviewer. If a step has sign-offs applied, you can delete it if your user
Working With the Audit Program Collection

log-in name matches one of the remaining signers who has not yet signed off, or, if there are no other reviewers assigned. In all other cases, if you attempt to delete the step, a message appears indicating that you are not allowed to delete the step.

Creating a Template from a Program

If you create an audit program specifically for an audit, and then decide to use this program as a template, you can copy the steps into a template to be stored in Audit Leverage’s Audit Program Template Library. You can also use the following procedure to update an existing template.

How to Create a Template From a Program

To make a template from an audit program, perform the following steps:

1. In the Cycle scrolling list box, select the program of interest.
2. Click on the Main tab.
3. Click the Create Template button.

The Audit Program Template Creation Wizard box appears, as shown in Figure 119.

4. If the template name already exists, select it from the To Template scrolling list box.
5. If the template name does not yet exist, click on the Add Template Name button.
6. Click OK to the message box.
The **Edit Audit Program Listing Table** screen appears in spreadsheet view. The cursor is positioned in the last empty row of the table, as shown in Figure 120.

![Audit Program Listing Table](image)

**Figure 120: Audit Program Listing Table for Templates**

7. Click **OK** to the message box.

8. In the last row of the spreadsheet, enter a name for the template in the **Audit Program ID** column.

9. In the **#** column, enter a sequence number to determine the position of this template name in the list of templates.

10. In the **Description** column, enter a description of the template.

**Note:**

On the Module B Project Set-up screen, users identify audit programs for a project. In doing so, they may select a template from
Working With the Audit Program Collection

which to copy steps. When a cycle is chosen on the Project Set-up screen, and the user clicks on the Template Name scrolling list box, only those templates with the same corresponding cycle, and templates with no entry for a cycle appear in the scrolling list box as suggested templates.

11. If applicable, in the Associated Cycle column, click the arrow to select a corresponding cycle for the template.

12. Click on another row in the spreadsheet to ensure that your entry is saved.

13. Click on the Close button to close the Edit Audit Program Listing Table screen.

14. In the Audit Program Template Creation Wizard box, click on the To Template scrolling list box.

15. Select the newly created template name.

16. Click the Create Template button.

   The Create Template? message box appears, prompting you to verify the creation of the template from the specified project and program cycle.

17. Click Yes.

18. Click OK to the Template Finished message.

19. Go to the Audit Program Template Library in Module C to find your newly created template.

Copying Steps Between Audit Projects

If you create an audit program specifically for an audit, and then decide the steps are appropriate for another audit, you can copy the steps to another project. The project and program to which you want to copy the steps must already exist before you attempt to copy the steps. Go to Module B, Audit Project Set-up, to create the project and the program's cycle, subcycle, task, template and auditor designations.

How to Copy Steps to Another Project

To copy audit steps to another project, perform the following steps:

1. In the Cycle scrolling list box, select the program of interest.

2. Click on the Main tab.

3. Navigate to the step, or one of the steps, of interest in the program.
4. Click the **Copy Steps** button.

The Audit Step Copy Wizard dialog box appears, as shown in Figure 121:

![Audit Step Copy Wizard](image)

**Figure 121: Audit Step Copy Wizard**

5. In the **Copy?** box, choose to copy either the step, or the entire cycle with all its steps, by selecting the appropriate radio button.

6. In the **To Project** scrolling list box, select the project to which you want to copy the step(s).

7. In the **Cycle/Subcycle/Task** scrolling list box, select the program to which you want to copy the step(s).

8. Click the **Include Work Performed?** checkbox if you want to copy the Work Performed field entry for each step.

   When you click the **Include Work Performed?** checkbox, the **Include Signoffs?** checkbox is enabled.

9. Click the **Include Signoffs?** checkbox if you want to copy signoffs with the step(s).

10. Click the **Copy!** button.

    The **Copy Step(s)?** message box appears, prompting you to verify copying step(s) from the cycle in the current project to the project and cycle you specified.

11. Click on the **Yes** button to confirm your choices.

    The **Finished!** message box appears, indicating the copying is complete.
12. Click the **OK** button.

13. In the **Audit Program Collection for** scrolling list box, select the other project to see the copied steps.

**The Sign-Offs Tab**

The Sign-Offs tab allows auditors to sign off indicating completion of work on an audit step. It also allows up to three reviewers to sign off after reviewing the work. This section describes the assignment of preparers and reviewers, and the preparer sign-off. For an explanation of the review process, see Chapter 23: “Review Notes”.

**How to Designate Preparers and Reviewers**

To assign a step's preparer and reviewers, perform the following steps:

1. In the **Cycle** scrolling list box, select the program for which you want to assign staff.

2. Click on the **Sign-Offs** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 122.
The Sign-Offs Tab

3. Use the record navigator to locate the step of interest.

4. In the Auditor scrolling list box above the Preparer’s Sign-Off button, select the name of the auditor who bears responsibility for performing this step.

5. In the Auditor scrolling list boxes above the Reviewer Sign-Off buttons, select the names of the auditors who you expect to review the auditor’s work performed.

How to Perform Audit Steps

As you perform an audit step, follow these steps to enter your work in Audit Leverage:

1. In the Cycle scrolling list box, select the program for which you want to perform work.

2. Click on the Main tab.
3. Use the record navigator to locate the step to be performed.

4. Read the **Audit Step** field containing the procedure description.

5. In the **Work Performed** field, enter details regarding how you accomplished the step.

6. If the performance of the audit step was problematic, check the **Problem?** checkbox.

7. Click on the **Attachments** tab.

8. If necessary, create file attachments to support your work as explained in “The Attachments Tab”.

9. When you complete all work for an audit step, apply your sign-off. For instructions on applying sign-off, as well as an explanation of the differences of high security mode, see Chapter 3: “The Sign-Offs Tab and Record-Level Security”.

---

**The Attachments Tab**

The **Attachments** tab allows you to associate supporting file attachments to individual audit steps. You can attach electronic files, or refer to the location of hard copy documents. Regardless of whether the files are electronic or hard copy, it is recommended that all associated workpapers be logged in Audit Leverage so that all information regarding the audit is stored in the software.

⚠️ **Important:**

The first attachment for a project must be created on the Attachments tab. Then, other attachments for the project can be created directly in the Attachment Index screen, if desired.

Click on the **Attachments** tab. The screen view changes to reflect the information shown on the tab, as shown in Figure 123.
Working with Attachments - Embedding vs. Linking

One important consideration when working with attachments is whether you should embed or link your attachments within Audit Leverage.

- **Embedding**—When you embed a file, the document is stored in the Audit Leverage database. Once inserted, Audit Leverage does not refer to the original document again. Changes to the embedded file in Audit Leverage do not affect the source file; likewise, changes in the original document are not reflected in the copy saved within Audit Leverage.

Embedding files causes the Audit Leverage database to grow, since it stores a full copy of the document in the database. If many documents are embedded, the database could become quite large. However, embedding files may be a good option if the files are to be accessed frequently by remote or offline users, such as traveling auditors, who may either have slow access to linked network files through a phone connection or no access at all. In
addition, sign-offs on embedded files make them read-only to all users other than designated preparers or reviewers who have not yet applied a sign-off. Finally, the original source file from which the embedded file was copied can be moved or deleted without affecting the embedded file in Audit Leverage.

• **Linking**—Linking files differs from embedding files in that the document itself is not stored in the Audit Leverage database. Audit Leverage uses the directory path or location of the document to find it. Updates to the linked file are reflected in the original source file, and changes to the source are recognized when the file is opened in Audit Leverage.

Linking files does not increase the size of the Audit Leverage database, since it only stores a pointer to the file location. This file may be located anywhere on the network as long as it is accessible to all users. That is, when the user wants to access the linked document, there must be a “live” connection to the file. However, if the network is inaccessible, or the file is moved, the file cannot be opened. Sign-offs on linked files do not provide read-only protection, since only the link path is stored in Audit Leverage, not the file itself.

**How to Add Attachments**

To add a file attachment to Audit Leverage, perform the following steps:

1. In the **Cycle** scrolling list box, select the program for which you want to perform work.
2. Use the record navigator to move a step to which you want to attach a file.

   **Note:**

   In order to successfully insert an attachment, the step must not have any sign-offs applied.

3. Click on the **Attachments** tab.
4. Vertically scroll, if necessary, to click on the new record row.
5. In the **Attachment ID** field, enter an alpha, numeric, or alphanumeric identification for the attachment that is unique within the project.
6. With the mouse over the **Doclink** field, right-click on your mouse.

   A pop-up menu appears.
7. Select **Insert Object** from the menu.

   The Insert Object dialog box appears, as shown in Figure 124.
8. Select either the **Create New** radio button to create the attachment from scratch using an application listed in the **Object Type** list box, or select the **Create from File** radio button to add the attachment using an existing file.

For detailed information about these procedures, refer to “How to Create a New Attachment” and “How to Create an Attachment from an Existing File”.

Once you have selected a method to attach the file, the dialog box closes, and the view returns to the **Attachments** tab.

9. In the **Attachment Title** field, enter a unique title to reference this file attachment.

10. If necessary, repeat Step 4 through Step 9 to add another electronic file attachment.

**Note:**
To create a reference to a hard copy document, skip Step 6 through Step 8 above, performing only Step 5 and Step 9.

**How to Create a New Attachment**

To create a new file to add as an attachment, perform the following steps in the **Insert Object** dialog box:

1. Select the **Create New** radio button.

2. In the **Object Type** list box, click on the application you want to use to create the file.

3. Ensure that the **Display as Icon** checkbox is selected.

4. Click the **Change Icon** box to change the icon and label for the file.
Working With the Audit Program Collection

5. Select the icon and type the new label.
6. Click OK to close the Change Icon dialog box.
7. Click OK in the Insert Object dialog box.
   The selected application opens on your desktop.
8. Create the document.
9. To save the document, embed it into Audit Leverage, and return to Audit Leverage use the menu path File > Exit.

Note:
The file is automatically embedded in Audit Leverage. For a description of linking and embedding files, see “Working with Attachments - Embedding vs. Linking”.

How to Create an Attachment from an Existing File

To add an attachment from an existing file, perform the following steps in the Insert Object dialog box:
1. Select the Create from File radio button.
2. Click on the Browse button to browse your local or network drives for the file.
3. Highlight the file name and click OK.
   The file can either be embedded in the Audit Leverage database or linked so that it is referenced from the disk. For a description of the benefits of each option, see “Working with Attachments - Embedding vs. Linking”.
4. To create a link to the file, ensure that the Link checkbox is selected. To embed the file, deselect the Link checkbox.
5. Ensure that the Display as Icon checkbox is selected.
6. Click the Change Icon button to change the icon and label for the file.
7. Select the icon and type the new label.
8. Click OK to close the Change Icon box.
9. Click OK to close the Insert Object box.
The Attachments Tab

The Attachment Index

The Attachment Index provides a log of all attachment references for a project, organized by cycle. Attachments can be created for a project either in the Audit Program Collection, or directly in the Attachment Index. The Attachment Index also provides a place to enter an attachment description, and perform preparer and reviewer sign-offs on workpapers.

Important:
The first attachment created for a project must be created on the Attachments tab of the Audit Program Collection screen. Then, subsequent attachments for the project can be created either there or directly in the Attachment Index.

How to Navigate to the Attachment Index

To navigate to the Attachment Index, perform the following steps:

1. From the Audit Program Collection screen, in the Cycle scrolling list box, select the program for which you want to view an attachment.
2. Use the record navigator to locate the step to which you want to view an attachment.
3. Click on the Attachments tab.
4. Next to an attachment of interest, click on the black arrow labeled More information on this attachment.

The Attachment Index screen appears, displaying information on the selected attachment, as shown in Figure 125.
Working With the Audit Program Collection

Note:
You also can navigate to the Attachment Index from the Main Module C screen, using button 2 - Attachment Index.

How to Enter Information in the Attachment Index

To enter information in the Attachment Index, perform the following steps:

1. In the Attachment Description field, enter a description of the electronic or hard copy file.
2. In the Auditor scrolling list box above the Preparer's Sign-Off button, select the name of the auditor who created this attachment.
3. In the Auditor scrolling list boxes above the Reviewer Sign-Off buttons, select the names of the auditors who you expect to review the attachment.
The Attachments Tab

How to Print Preview the Attachment Index

To print preview the attachment index entries, perform the following steps:

1. Click the **Print Preview Attachment Index** button.

The **Print Options Form** dialog box appears, as shown in Figure 126.

![Print Options Form](image)

**Figure 126: Print Options Form for Project 9830**

2. Select the desired print preview option by clicking on one of the radio buttons.

3. Click the **Preview** button.

   The print preview of the **Attachment Index Report** appears.

4. Click the printer button on the Access tool bar, or select **File > Print** to send the report to a printer.

How to Sign Off Attachments

When you complete all work for an attachment, perform the following steps:

1. Navigate to the **Attachment Index**.
2. If a project is not already selected, choose a project from the scrolling list box at the top of the screen.

3. In the **Cycles Audited** box, click on the gray box next to the cycle containing the attachment.

4. Use the record navigator to locate the attachment of interest.

5. Apply your sign-off. For instructions on applying sign-offs, as well as an explanation of the differences of high security mode, see Chapter 3: “The Sign-Offs Tab and Record-Level Security”.
Findings

Findings are the exceptions discovered during an audit—observations of activity that fall outside the expected norms or rules. Some of these findings are included in the final audit report, and some are handled in other ways. When you execute an audit program, findings inevitably result.

Audit Leverage allows you to capture the findings, recommendations and supporting information that eventually appear on the final audit report. In addition, Audit Leverage provides a place to capture findings to be handled outside of the audit report, such as by verbal discussion or a supplemental report to the auditee as well as those put on hold pending further audit work or deemed too insignificant to be communicated to the auditee. All of this detail is entered in the Findings area of Module C. This chapter describes how to view and enter findings for a specific project step, or in general.

This chapter contains the following sections:

• “Viewing Findings”
• “Drafting Findings”
• “Deleting Findings”
• “Copying Findings to a New Report”

Viewing Findings

Findings are generally accessed in two ways, from the Module C Main Screen or from the Audit Program Collection of Module C.
Findings

Note:
Although you most often access findings from Module C, they can also be accessed from the Audit Setup Screen in Module B and the Module D Main Screen.

Although you can create findings by navigating directly from the Module C Main Screen, navigating from the Program Collection Screen provides a direct link to finding for an audit program step. Therefore, IAD Solutions recommends that you use the Audit Program Collection Screen in Module C as the gateway to viewing findings if the finding is associated with a specific audit program step.

By clicking on the Findings button from the Program Collection Screen, when the Potential Audit Findings Screen appears, certain fields in the finding are populated automatically for you on these screens. These include the corresponding cycle, subcycle, task, and audit step title. Also, as findings are created, Audit Leverage maintains counters on the Program Collection screen for each audit step indicating the number of findings related to that step.

Alternately, you can go directly to findings, review notes and attachments from the main Module C screen. You can then associate that component back to the cycle, subcycle, task, and audit step to which it corresponds by making those entries manually. However, using this manual method leaves room for error.

How to View an Empty Findings Screen

To view the Findings screen from Module C, perform the following steps:

1. In the Module C Main Screen, click on the Findings button.

The Potential Audit Findings Screen appears as shown in Figure 130. Using this method, the screen does not include any values in the various fields and tabs.
Viewing Findings

Figure 127: Potential Audit Findings Screen

From this screen you can enter a new finding, modify existing findings, or delete a finding.

How to View Existing Findings for an Audit Step

To view existing findings for a populated audit step, perform the following steps:

1. In the Module C Main Screen, select a project from the Select Project scrolling list box.

   The value shown in the field to the right of the Findings buttons changes to display the number of findings related to the selected audit project, as shown in Figure 128.
Findings

Figure 128: Module C Main Screen with Audit Project Selected

2. Click on the Audit Program Collection button.

The Audit Program Collection Screen appears similar to that shown in Figure 129.
The Audit Program Collection screen appears, displaying the information for the audit steps created for that audit program. The field next to the **Findings** button at the top right of the screen indicates the number of findings related to the current audit step. Some audit steps may not have findings.

3. If necessary, in the **Cycle** scrolling list box, select a program.

**Note:**

If only one cycle exists for the selected audit program, it is automatically selected.

4. Using the Record Navigator, locate an audit program step that has associated findings.
5. Click on the **Findings** button.

The Potential Audit Findings Screen appears, similar to that shown in Figure 130.

![Figure 130: Potential Audit Findings Screen]

As Figure 130 shows, if a project and step is selected, the applicable fields are already populated with the corresponding data.

Since you entered the Potential Audit Findings screen from the Audit Program Collection screen for the specific program step, only the findings related to that step appear in the list.
Drafting Findings

During the course of the audit, you can draft findings which relate to specific audit steps, to a specific cycle, subcycle or task, or for the project in general.

How to Draft a Finding

To draft a finding for an audit program step, perform the following steps:

1. Navigate to the Potential Audit Findings screen using the steps found in “Viewing Findings”.

   Note:
   IAD Solutions recommends drafting a finding for a specific step from the Program Collection Screen with the audit program and step already selected in order to avoid confusion and potential errors. However, in some cases a finding may not pertain to a specific audit step.

   If you entered the Potential Audit Findings screen by navigation from a location other than the specific step in the Audit Program Collection you must manually associate the finding to a project, cycle, subcycle, task and program step. As described in the “Main Tab” section.

   If you enter through the Audit Program Collection screen, much of the information is pre-populated and many of these steps can be skipped.

2. If necessary, in the Project Number scrolling list box, select the project whose findings you want to create.

   When you select a project, the entity name and project name are displayed on the screen next to the Project Number scrolling list box.

3. If necessary, click on the Main tab.

   The view may change to display the fields on the Main tab.

4. In the Finding title field, enter the title you want to appear with the finding in Audit Leverage screens and in the audit report.

   The title that you entered in the Finding title field appears in all tabs of the Potential Audit Finding screen.

5. Enter information as necessary in the tabs of the Potential Audit Findings screen to complete the finding.
**Findings**

It is not necessary to enter information in every field. The tabs that can be found on the Potential Audit Finding Screen are:

- “Main Tab”
- “The Sign-Offs Tab”
- “Background Tab”
- “Criteria & Risk Tab”
- “Finding (Report Wording) Tab”
- “Recommendation Tab”
- “Management Responses Tab”
- “Synopsis Tab”

**Main Tab**

The **Main** tab contains the general information about the finding, including the finding text, recommendation text, and some information about the audit step to which the finding relates.
How to Populate the Main Tab

To enter information in the Main Tab, perform the following steps:

1. If you have not already done so, in the Finding title field, enter the title you want to appear with the finding in Audit Leverage screens and in the audit report.

   The title that you entered in the Finding title field appears in all tabs of the Potential Audit Finding screen.

   Audit Leverage provides the option of subdividing your findings within the cycles for presentation on the audit report.

2. If you want to subdivide your findings, enter a subdivision title in the Subheading field.

   You can also determine the order in which the findings appear on the report.
Findings

3. In the field just to the right of the **Subheading** field, enter a number, which determines the sequence in which the findings appear on the audit report.

   The value selected in the **How to Report** scrolling list box determines how the finding is handled for the final audit report. Only those findings with a value of 60 or greater—which corresponds to “Audit Report Approved” in the default values—appear on the Audit Leverage generated audit report.

4. In the **How to Report** scrolling list box, select the disposition value that you want to assign to this finding.

5. In the main text box on this screen, enter the finding text.

6. In the **Recommendation** text box, enter the text of the recommendation to remedy the finding.

   The **File attachments** field allows you to insert documents that are intended to accompany the final audit report. For example, attachments might include summary tables or graphs, exhibits, or appendices. For more information on working with attachments, refer to “The Attachment Index” in Chapter 11: “Creating An Audit Project”.

7. In the **File attachments (if any)** box, insert any attachments following the steps found in “How to Add Attachments”.

8. If necessary, change the value in the **Author of finding** scrolling list box.

   The value in the scrolling list box defaults to the name of the logged-in user. The list is populated with the names of all the audit staff members as entered in Module F: Human Resources.

9. If necessary, in the **Cycle** scrolling list box, select the appropriate cycle.
Changing a Finding’s Audit Step Association

When you enter the Potential Audit Findings screen from the Audit Program Collection, some data from the audit program step is automatically populated to help you trace the source of the finding.

However, sometimes unexpected or unrelated findings are discovered when executing an audit step. So, Audit Leverage allows you to change entries in the cycle, subcycle, task, and audit step fields. Even though the finding emerged from working on a particular audit program step related to a specific cycle subcycle and task, changing these fields might more accurately reflect the nature of the finding. Likewise, it may make more sense to associate the finding with an overall audit program rather than a specific step by removing the audit step value.

Changing these automatically populated fields, however, may make it more difficult to later determine which audit step generated the finding.

10. If necessary, in the Subcycle scrolling list box, select the appropriate subcycle for the selected cycle.

11. If necessary, in the Task scrolling list box, select the appropriate task for the selected subcycle.

Notes:

1. The cycle, subcycle, and task may be populated when you enter the Potential Audit Findings Screen, if you entered the screen from a specific step in the Audit Program Collection.

2. Not all cycles have associated subcycles. Likewise, not all subcycles have associated tasks. In these cases, you can set the values to N/A.

If the appropriate control issue is not available as an item in the list, you can enter a new value in the field. It is added to the list for future use. Control issues are associated to specific cycles.

12. If desired, in the Control Issue scrolling list box, select a control issue for the finding.

You can group similar findings by assigning them to a particular finding type. Finding types can be modified in Module G. For more information on how to modify values in Module G, refer to Chapter 27: “Module G: Table Settings”

13. If desired, in the Finding Type scrolling list box, select the finding type to which this finding belongs.
Findings

14. In the **Respondent** field, enter the name of the person at the auditee who should respond to the finding.

**Note:**
If multiple auditee departments or individuals should respond to a finding, enter the name of the person responsible for securing all auditee responses.

15. In the **Risk Severity Code** scrolling list box, select an appropriate risk severity to indicate the relative risk of inaction regarding the audit finding.

16. If necessary, in the **Financial Impact** field, enter the amount of cost impact as it relates to the implementation of the recommendation.

17. If desired, in the **Global vs. Specific** scrolling list box, select an entry from the drop-down list to indicate whether this finding has global, site-specific or external audit implications.

The **Audit Step** scrolling list box relates the finding to a particular audit step. If you entered the Potential Audit Findings screen from the Audit Program collection, the scrolling list box is already populated with the name of the step. otherwise, it may be blank. The selection list defaults to the steps for the selected audit program.

18. If necessary, in the **Audit Step** scrolling list box, select the appropriate audit step to associate with the finding.

Selecting the **Attachment # and Title** scrolling list box presents a list of file attachments for the project. If one of your attachments supports this finding, you can select it and the attachment number appears in the field. The attachment title is displayed to the right of this field.

19. If necessary, from the **Attachment # and Title** scrolling list box, select a file attachment that relates to this finding.

The values displayed in the **Management Responses: Open** and **Management Responses: Closed** fields indicate the number of open and closed management responses for this finding. These values are based on information from the Management Response Tab and are read-only.

20. If this finding has been documented in previous audit reports, ensure that the **Repeat finding?** checkbox is selected.
The Sign-Offs Tab

The Sign-Offs tab allows auditors to sign off indicating completion of work on a finding. It also allows up to three reviewers to sign off after reviewing the finding. For an explanation of sign-offs, see Chapter 3: “The Sign-Offs Tab and Record-Level Security”.

Click on the Sign-Offs tab. The view changes to display the fields of the tab, as shown in Figure 132.

How to Designate Preparers and Reviewers

To assign a step's preparer and reviewers, perform the following steps:

1. In the Auditor scrolling list box above the Preparer's Sign-Off button, select the name of the auditor who bears responsibility for performing this step.
Findings

2. In the Auditor scrolling list boxes above the Reviewer Sign-Off buttons, select the names of the auditors you expect to review the auditor’s work performed.

Note: Not all reviewer fields must be populated.

How to Sign Off Findings

When you complete all work for a finding, perform the following steps:

1. Click the Preparer’s Sign-off Button or Reviewer’s Sign-off Button directly below your name.

2. Click OK in the two information messages that appear.

Audit Leverage places the current date in the Sign-off Date field, and the user’s log-in name in the Electronic Signature field. It locks down the step data, as well. The fields are read-only to all users except any reviewers who have not yet signed off.

Background Tab

The Background tab allows you to capture background information about the audit issue for internal audit department records, such as in a department’s findings worksheet. However, the Audit Leverage-generated audit report can be customized to include this information. The Background tab is shown in Figure 133.
Figure 133: Potential Audit Findings Screen - Background Tab

How to Populate the Background Tab

To enter data in the **Background** tab, perform the following step:

1. If necessary, enter the background text in the **Background for this finding** text box.

   The finding title field on this tab is read-only.

Criteria & Risk Tab

The **Criteria & Risk** tab allows you to document criteria information for the finding, such as why the finding warrants mention in the audit report or a history of the issue or the company or regulatory standard applied in assessing the finding. You can also document any risk associated with failure to address the finding or implement the recommendation. The information on this tab is typically for internal audit department records, such as the department’s finding.
Findings

worksheet. However, the generated audit report can be customized to include this information. The **Criteria & Risk** tab is shown in Figure 134.

![Figure 134: Potential Audit Findings Screen - Criteria & Risk Tab](image)

**Note:** Although the word “risk” is used, this tab is unrelated to the Module A Risk Assessment functionality, described in Chapter 6: “Setting Up a Risk Assessment”.

**How to Enter Criteria and Risk Text**

To enter text about the criteria and risk for the finding, perform the following steps:

1. If desired, in the **Criteria** text box, enter an explanation of the finding.

   Such criteria may be, but is not limited to, information regarding why this finding warrants mention in the audit report, history of the issue, how this
finding relates to company or regulatory standards, detail of sensitive information, or political environment surrounding the issue.

2. In the **Risk Severity Code** scrolling list box, select an appropriate risk severity to indicate the relative risk of inaction regarding the audit finding.

⚠️ **Important:**

Entering or modifying the values in the **Risk Severity Code** scrolling list box also modifies the value on the **Main** tab.

3. In the **Discussion of Risk/Effect** scrolling list box, enter any risk exposure, implications or consequences if the recommendation of the finding is not implemented.

ℹ️ **Note:**

The finding’s title at the top of the tab is read-only and cannot be edited.

**Finding (Report Wording) Tab**

The **Finding (Report Wording)** tab allows you to view the entire text of the finding entry. The text displayed on this tab matches the text found on the **Main** tab. It also displays the finding title and the order in which you want this finding to appear on the audit report. The **Finding (Report Wording)** tab is shown in Figure 135.

This tab duplicates the finding text from the **Main** tab. You can create, edit or delete text here, and the change is reflected on the **Main** tab.
Findings

Figure 135: Potential Audit Findings Screen - Finding (Report Wording) Tab

How to Populate the Finding (Report Wording) Tab

To enter data in the Finding (Report Wording) tab, perform the following steps:

1. If necessary, enter or modify the title for the finding in the Finding title field.
2. If necessary, enter or modify the ordering number in the Order of appearance in report field.
3. If necessary, enter or modify the finding text in the large finding text box.

Important:
Entering or modifying the values in any of the fields on this tab also modifies the related values in the other tabs on the Potential Audit Findings screen.
Recommendation Tab

The **Recommendation** tab allows you to view the entire text of the recommendation entry. The text displayed on this tab matches the text found on the **Main** tab. If you create, edit or delete text here, and the change is reflected on the **Main** tab. It also displays the finding title. The **Recommendation** tab is shown in Figure 136.

![Image of Potential Audit Findings Screen - Recommendations Tab]

**Figure 136: Potential Audit Findings Screen - Recommendations Tab**

**How to Populate the Recommendation Tab**

To enter recommendation data, perform the following steps:

1. If necessary, enter or modify the finding text in the large finding text box.
Findings

Important:
Entering or modifying the values in the field on this tab also modifies the related value in the other tabs on the Potential Audit Findings screen.

Management Responses Tab

The Management Responses tab allows you to capture auditee management responses to your findings and recommendations. By using the Management Responses tab, communications between the auditors and auditees can be stored in the Audit Leverage. A dialogue between the auditors and the auditees can take place within Audit Leverage so that the entire dialogue is entered in the database. The Management Responses tab is shown in Figure 137.

Figure 137: Potential Audit Findings Screen - Management Responses Tab
For complete information on Management Responses, including entering information in the tab, refer to Chapter 21: “Management Responses and Follow-Up”.

Synopsis Tab

The Synopsis tab allows you to enter an executive level summary for an Audit Director’s Audit Summary Report in Module D. The Synopsis tab is shown in Figure 138.

![Figure 138: Potential Audit Findings Screen - Synopsis Tab](image)

**How to Populate the Synopsis Tab**

To enter data in the Synopsis tab, perform the following steps:

1. If necessary, enter or modify the finding text in the **Enter brief synopsis of the finding** text box.
Findings

You can also enter or modify the recommendation text if you want it to appear in the Audit Directors’ Summary Report in Module D.

Deleting Findings

You can delete a finding from Audit Leverage. Once you have deleted the finding, it is removed from the database and cannot be retrieved.

How to Delete Findings

To delete findings from an existing audit project, perform the following steps:
1. Navigate to the Potential Audit Findings screen using the steps found in “Viewing Findings”.
2. Ensure that the appropriate audit project is selected.
3. Using the Record Navigator, locate the appropriate finding.
4. From the Main tab, click on the Delete this Audit Finding button.

A message box appears prompting you to verify the deletion.
5. Click Yes to continue.

Note:
The delete procedure only deletes the selected finding. If you want to delete all findings for a project, you must repeat this procedure for all findings in the project.

Copying Findings to a New Report

Often, findings are duplicated from project to project and from year to year. Audit Leverage allows you to copy findings from one audit report to another.

How to Copy Findings from One Report to Another

To copy findings from an existing audit project to another, perform the following steps:
1. Ensure that the project you want to copy findings to exists.
2. Navigate to the Potential Audit Findings screen using the steps found in “Viewing Findings”.

3. Select the source audit project for the findings.

4. From the **Main** tab, click on the **Copy Findings to new project** button.

The Findings Copier Wizard appears as shown in Figure 139.

![Findings Copier Wizard](image)

*Figure 139: Findings Copier Wizard*

When the Findings Mover Wizard appears, the currently selected audit project ID is shown in the **From Project** scrolling list box. If this is not the correct project ID, you can select a different one.

5. In the **To Project** scrolling list box, select the Audit Project ID for the project you want to copy the findings into.

6. If you want to include the management responses associated with the findings for the source project, ensure that the **Include Management Responses?** checkbox is selected.

   If you select the **Include Management Responses?** checkbox, the **Include Auditor follow-up entries?** checkbox becomes active.

7. If you want to include any follow-up entries associated with the finding’s management responses, ensure that the **Include Auditor follow-up entries?** checkbox is selected.

8. Click on the **Copy Findings** button to initiate the copy procedure, or **Close** to exit without copying.

9. Click **OK** to the two message boxes that appear.
Findings
Management Responses and Follow-Up

Typically, once you have completed your findings and recommendations for an audit project, the auditee receives a draft or final report. Usually auditee management at the auditee site is required to respond in some form. Audit Leverage allows you to track auditee management responses within the software. You can also perform follow-up on each management response as necessary.

Audit Leverage supports multiple management responses for each finding, and multiple follow-up entries for each management response. For more information on findings, refer to Chapter 20: “Findings”.

This chapter documents the methods for entering management responses into Audit Leverage, how to track the status of management responses, how to enter follow-up entries, and track those follow-ups.

This chapter contains the following sections:
• “Creating Management Responses”
• “Creating Follow-Up Entries”
• “Tracking Responses and Auditor Follow-up Entries”

Creating Management Responses

Once a finding and recommendation is communicated to the auditee and responses have been received, these responses can be logged in Audit Leverage.

How to View the Management Responses Tab

To view the Management Responses tab, perform the following steps:
Management Responses and Follow-Up

1. Navigate to the Potential Audit Findings screen using the steps described in “Viewing Findings” of Chapter 20: “Findings”.

2. In the Project Number scrolling list box, select the desired project. Finding data for the project appears in the tabbed area.

3. Click on the Management Responses tab. The screen changes to reflect the fields on the tab, as shown in Figure 140.

![Figure 140: Potential Audit Findings Screen - Management Responses Tab](image)

4. Use the record navigator just below the management response listing to navigate through multiple management responses, if they exist.

**Note:**

When viewing the Management Response tab, you see two record navigator bars at the bottom of the screen. The innermost record navigator allows you to move from one management response to
Creating Management Responses

another, if multiple responses exist. The bottom record navigator allows you to move between findings.

How to Create a Management Response for a Finding

Management responses are populated when auditors copy auditee responses from electronic documents and paste them into the Management Response fields, or transcribe them from a hard copy document.

Note:
If your department provides a login account for managers at the auditee site, they can log in and enter management responses directly. You should consider the permissions and security implications of this option before implementing it.

To create one or more management responses for a finding, perform the following steps:

1. In the Management’s Response field, enter the auditee’s response to the finding and recommendation.
2. In the Management’s Action Plans field, enter the auditee’s plan to implement the recommendation or remedy the situation.
3. In the Agreed? scrolling list box, select an entry that represents the level of auditee agreement with the finding and recommendation.
4. In applicable, in the Explanation of Disagreement field, enter a description of the auditee’s disagreement.
5. If applicable, in the Auditor Rebuttal field, enter the auditor’s position on the disagreement.
6. In the Responsible Department scrolling list box, select the auditee department from which the response was received.
7. In the Responsible Person(s) field, enter the name(s) and position(s) of the auditee respondent(s).
8. In the Original Target Date field, enter the target date for completion of the auditee’s action plan.
9. In the Follow-up Status scrolling list box, select a follow-up status capturing the current state or need for auditor follow-up on the situation.
10. If desired, in the File Attachments doclink field, insert the source electronic document containing the auditee response.
Management Responses and Follow-Up

The source response document could be an e-mail text file, a Word document, or other electronic file. For steps on how to create a file attachment, see “How to Add Attachments” in Chapter 19: “Working With the Audit Program Collection”.

11. To create another management response for the same finding, click the new record button on the innermost record navigator.

12. Repeat Step 1 through Step 11 for each management response you need to create.

Creating Follow-Up Entries

Follow-up entries are notes from auditors regarding their attempts to contact the auditee and determine progress toward completing action plans. Follow-up entries can be created for every management response, if desired. The Follow-Up Entries screen can be accessed from the Management Response tab of the Findings screen, and also through the Module E main screen.

How to View Follow-Up Entries

To view the Audit Follow-Up Entries screen, perform the following steps:

1. On the Management Response tab of the Findings screen, use the record navigator to locate the desired management response.

2. Click the Go to Follow Up Entries button.

The Audit Follow-Up Entries screen appears, as shown in Figure 141.
Creating Follow-Up Entries

Figure 141: Audit Follow-Up Entries Screen

The follow-up entry area is at the bottom of the screen. The top of the screen contains the corresponding management response.

3. Use the innermost record navigator to move through multiple follow-up entries, if they exist.

Note:

When viewing the Audit Follow-up Entry screen, you see three record navigator bars at the bottom of the screen. The innermost record navigator allows you to move from one follow-up entry to another, if multiple follow-ups exist. The middle record navigator allows you to move from one management response to another, if multiple responses exist. The bottom record navigator allows you to move from finding to finding.
Management Responses and Follow-Up

How to Create a Follow-Up Entry

To create one or more follow-up entries for a management response, perform the following steps:

1. In the **Follow-up Date** field, enter the date of the follow-up.

2. In the **Mgmt’s Status Description** field, enter an explanation of the auditee’s status.

3. In the **Auditor’s Comments** field, enter comments as to the auditee’s progress and any new information obtained through the follow-up.

4. If necessary, in the **File Attachments** doclink field, insert an electronic file containing follow-up communications or other information.

   You can change the values of some of the management response fields at the top of the screen, including **Original (Current) Target**, **Revised Target**, **Actual Date**, **Change History**, and **Follow-up Status**. If you need to change any of the other management response fields, return to the Findings screen and click on the **Management Responses** tab.

5. If necessary, enter a **Revised Target** date.

6. If the auditee action plan is complete, enter an **Actual Date**.

7. In the **Change History** field enter an explanation of the revised target date, if applicable.

8. In the **Follow-up Status** scrolling list box, select a follow-up status capturing the current state or need for auditor follow-up on the situation.

9. To create another follow-up entry for the same management response, click the new record button on the innermost record navigator.

10. Repeat Step 1 through Step 9 for each follow-up entry you need to create for a management response.

**Note:**

Follow-up entries can be created to record data when follow-ups have taken place. They can also be created in advance as a reminder for future follow-ups. Create a new follow-up entry by populating the **Follow-up Date** field with a future date. Leave the remaining fields empty. Then, periodically use the Search Your Database tool to look for follow-up entries whose date is in the future. Performing this search on a regular basis helps in reminding auditors that follow-up communication should be arranged.
Tracking Responses and Auditor Follow-up Entries

Management response and auditor follow-up data is tracked in multiple ways, including the Search Your Database tool, and the Module E Outstanding Findings Report and Late Management Responses query.

Search Your Database

Management responses and follow-up entries are tracked through the Search Your Database tool, accessible from Modules B and D. Search Your Database has both a Management Responses tab and a Follow-up Entries tab. Every management response field and every follow-up entry field can be used independently or in combination with others to perform a database search.

Outstanding Findings Report

The Outstanding Findings Report in Module E displays finding, management response and follow-up entry data for all management responses without an actual completion date. The report includes the following fields:

- Project ID
- Finding title
- Recommendation text
- Person responsible
- Original target and actual completion dates
- Auditee management’s action plan
- Auditee management’s status
- Auditor follow-up comments

Late Management Responses Query

The Late Management Responses query in Module E displays a list of all open projects for which a final audit report has been issued, but no management responses have been received. To determine what projects appear on this report, Audit Leverage checks the Module B Project Set-up milestone dates. Therefore, project managers must frequently update the milestone dates to ensure the reliability of this query. Their updates to these fields depend, in part, on an awareness of when management responses exist in the database. All projects satisfying the following conditions are presented in the query.
Management Responses and Follow-Up

- The **Closed by Director** milestone date is empty.
- The **Report (final) Actual** milestone date contains an entry.
- The **Response Received Actual** milestone date is empty.

The query does not depend upon any data entered in the Management Response tab of Findings, or on the Audit Follow-Up Entry Screen.
Generating the Audit Report

From Module C, you can generate your Audit Report, including an optional cover memo. Audit Leverage provides a number of report formats within the software, and custom reports can also be created. Experiment with the formats provided to determine which one is closest to your department’s standard format.

Some report formats also contain a cover memo. Audit Leverage presents an input screen in which standard cover memo text is combined with data on the Project Set-up screen to create a letter specific to the project. From this input screen, you can edit most of the fields to further customize the cover memo for that specific project.

This chapter contains the following sections:

• “Creating a Cover Memo”
• “Modifying an Existing Cover Memo”
• “Printing and Exporting the Audit Report”
• “Customizing the Audit Report Cover Memo”

Creating a Cover Memo

Cover memos to be sent with the audit report are optional. If your audit report includes a cover memo, you must enter some information within Audit Leverage.

How to Create a Cover Memo

To create the optional cover memo, perform the following steps:

1. From the Workpapers Main Screen, in the Select Project scrolling list box, select the project for which you want to generate an audit report.
Generating the Audit Report

2. Click on the **Findings** button.

The Findings Screen appears, as shown in Figure 142.

![Figure 142: Findings Screen](image)

3. From the **Main** tab, click **Create or Edit Audit Report Cover Memo**.

The Select Report Format Screen appears, as shown in Figure 143.
Creating a Cover Memo

4. Select a report by clicking on the appropriate row.
   A black arrow appears in the gray box to the left of the item you select.
5. Click on the **New** button.

**Note:**
When you click the **New** button, Audit Leverage generates a new cover memo and audit report. Once a cover memo is initiated for a project, Audit Leverage saves this version of the cover memo. If you exit the cover memo, and want to return to edit it later, you should click the **Edit** button to retrieve the saved version. No matter which option you select, Audit Leverage regenerates the body of the report from the findings existing in the database at that time.
Generating the Audit Report

A message box appears, warning you that if you continue, any previous cover memo for this report is cleared and a new cover memo is created.

6. Click **Yes** to continue.

The cover memo input screen appears, as shown in Figure 144.

![Figure 144: Cover Memo Input Screen](image)

**Notes:**

1. If a format does not contain a cover memo, the input screen still appears, but paragraph labels indicate that they are not displayed.

2. Most of the audit report formats contain one cover memo. In the example shown in Figure 144, there are two cover memos. Regardless of whether a format contains one or two cover memos, the procedure for editing the cover is the same.
Creating a Cover Memo

On the left side, a cover memo from the audit director to the auditee, and on the right, another cover memo from the auditors to the audit director. The input screen for this format contains input fields for:

- CC: list
- Subject:
- Paragraphs

The To, From, and Date field values are read-only and are drawn from the locations described in Table 2.

<table>
<thead>
<tr>
<th>Field</th>
<th>Cover Memo to Auditee (left side)</th>
<th>Cover Memo to Audit Director (right side)</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Report Addressed To field from Project Set-up Main Tab</td>
<td>Audit Director field from Main Screen</td>
</tr>
<tr>
<td>From</td>
<td>Audit Director from Main Screen</td>
<td>Staffing Box from Project Set-up Main Tab</td>
</tr>
<tr>
<td>Date</td>
<td>Report Final Actual date from Project Set-up Milestones Tab</td>
<td>Report Final Actual date from Project Set-up Milestones Tab</td>
</tr>
</tbody>
</table>

The three paragraph fields contain the following:

- Default text for the cover memo.
- Field values from the Project Set-up screen, including audit staff names and milestone dates.

This information can be edited for this project only by modifying the text in the fields, or permanently modified to become the default values for every project in Module G.

7. If desired, add names to the CC: list by clicking in the list box, and entering the list of names.

8. If desired, enter a new subject line in the Subject: field.

9. If necessary, modify the text for each paragraph in the cover memo.

10. If desired, click the Spell Check button to check for spelling errors.

11. To print or export the report, see “Printing and Exporting the Audit Report”.

305
Generating the Audit Report

After you generate the initial cover memo, you can save it by closing the Cover Memo Input Screen.

Modifying an Existing Cover Memo

Once a cover memo is created, you can modify it at any time.

How to Modify a Cover Memo

To return to this previously generated cover memo and make modifications perform the following steps:

1. From the Main tab, click Create or Edit Audit Report Cover Memo.

The Select Report Format Screen appears, as shown in Figure 143.
2. Select the report option you used to generate the original cover.

Note:
If you select a different report option than the one you originally used, the cover memo does not work properly. If you want to change report options and abandon previous edits, refer to “Creating a Cover Memo”.

3. Click the Edit button.

4. If desired, add names to the CC: list by clicking in the list box, and entering the list of names.

5. If desired, enter a new subject line in the Subject: field.

6. If necessary, modify the text for each paragraph in the cover memo.
Generating the Audit Report

7. If desired, click the Spell Check button to check for spelling errors.

8. To print or export the report, see “Printing and Exporting the Audit Report”. After you edit the cover memo, you can save it by closing the Cover Memo Input Screen.

Printing and Exporting the Audit Report

Once you have checked the Audit Report and Cover Memo, you can then output it to your printer, or export it to Microsoft® Word for additional text formatting.

How to Print the Audit Report

To print the Audit Report and Cover Memo, perform the following steps:
1. Click the Print or View the Audit Report button

A print preview of the cover memo and the audit report appears.
2. Click on the arrows of the record navigation bar at the bottom of the screen to scroll through the pages in the cover memo and audit report.
3. Select File > Print or click the Print button to print the cover memo and audit report.

How to Export to Microsoft Word

To export the Audit Report and Cover Memo to Microsoft Word for additional formatting, perform the following steps:
1. Select Tools>Office Links>Publish It with MS Word or click on the Word icon in the Access toolbar.

The report appears in Microsoft Word, and can be edited and formatted within Word before printing.

Important: Once the report is exported, any changes to the exported document are not reflected in the Audit Leverage database. IAD Solutions
Customizing the Audit Report Cover

recommends that you make any edits to the auditing data in Audit Leverage before you export. Use the Word export to make formatting and layout changes only.

Customizing the Audit Report Cover Memo

Cover memos can be edited on a project-by-project basis by using the steps outlined in the sections “Creating a Cover Memo” and “Modifying an Existing Cover Memo”. Additionally, the cover memo default text and field references can be permanently changed for all projects in Module G. IAD Solutions recommends that if you want to change or add new field references, your Audit Leverage system administrator should contact support for assistance in identifying new fields.

The cover memo formatting can also be permanently changed. Only someone with Microsoft Access expertise should attempt this procedure. Since this is a front-end database change, any changes you make are overwritten when you upgrade. Therefore, you should save the changed form to an Access database file outside of Audit Leverage so you can import it into the software again after an upgrade. Any modified front-end database file must be redistributed to all machines for those changes to be available to all users.
Generating the Audit Report
Review Notes

Review notes store temporary communication between auditors. They are not intended for distribution outside the internal auditing department. Audit staff responsible for reviewing audit steps, file attachments, findings, and other audit-related work use review notes to record their comments. Auditors preparing audit work use review notes to receive feedback from reviewers, and respond to that feedback.

The Audit Leverage Review Notes screen allows auditors to enter review comments, responses and sign-offs. This chapter describes the steps to create, view, and modify review notes. This chapter contains the following sections:

- “The Review Notes Screen”
- “The Review Note Process”
- “Viewing and Tracking Options”

The Review Notes Screen

The Review Notes screen contains review note data, and filter fields for selecting review notes of interest.

To view the Review Notes screen, from the main Module C screen, click Review Notes.
Review Notes

Note:

You can also access the Review Notes screen from the Audit Program Collection screen for a particular project. For more information on this procedure, see Chapter 19: "Working With the Audit Program Collection".

The Review Notes Screen appears as shown in Figure 146.

Figure 146: Review Notes Screen

From this screen, you can create new review notes, examine existing review notes, search for review notes based on specified criteria, and delete review notes.

On the Review Notes screen, there are two main areas:

- The top section of the screen contains filter fields for searching your database of review notes. Review notes displayed are based on the filter field.
values you specify. The top area of the screen also contains buttons to print preview review notes and navigate to the Module C Workpapers main screen.

- The bottom section of the screen contains the actual review note data, displayed one note at a time, and has fields for entry or display of review note information.

The Review Note Process

The Review Note process consists of the following steps:

- The reviewer creates a review note.
- The recipient searches for review notes bearing his or her name.
- The recipient responds and signs off on the review note.
- The reviewer views the response and applies a final sign-off.

How to Create a Review Note

To create a review note, perform the following steps:

1. In the record navigator, click on the New Record button.

2. In the Title of Review Note and Date Created field, enter a title unique to this project.
   Audit Leverage automatically fills in the Date Created field with the current date.

3. Place the cursor in the Audit Project # field. The Audit Project # is the same as the Project ID.
   The Enter Parameter Value dialog box appears as shown in Figure 147.

Figure 147: Enter Parameter Value Dialog Box
Review Notes

4. To view the entire project list, leave the input field blank. To narrow down the selection, enter the first few characters of the entity name.

5. Click **OK**.

A list of audit project numbers and their related entities appears.

![Figure 148: Parameter Value List](image)

6. With your cursor, highlight and click on the project for which you want to create a review note.

   Once you select a project number, that number appears in the **Audit Project #** field. The associated entity name appears below the field.

The next several fields are used to associate the review note to an audit step. An audit step belongs to an audit program. Audit Leverage names a unique audit program with a combination of fields. The **cycle**, **subcycle**, and **task** fields are three labels used in combination to uniquely describe an audit program.

7. If your review note applies to an audit step within a specific program, use the **Cycle, Subcycle and Task** scrolling list boxes to choose the values that identify the program. Be sure to enter **N/A** in any fields for which you do not have a specific entry.

8. If a file attachment is being reviewed, in the **Attachment ID and Title** scrolling list box, select an attachment ID.

   Once the attachment is selected, Audit Leverage displays the attachment ID and title.

9. If applicable, in the **Audit Step Title** scrolling list box, select the audit step to which this review note pertains.

10. If applicable, in the **Finding Title** scrolling list box, select the finding title to which this review note pertains.
The Review Note Process

Review notes are flagged with a status based on the recipient’s response and the reviewer’s approval. The default entry status entry is “Awaiting recipient’s response.” This status is updated automatically when sign-offs occur. It can be set manually before sign-offs by selecting a status from the scrolling list box.

11. In the **Review Note Status** scrolling list box, choose a status.

   **Note:**
   The possible status choices are customizable in Module G. Only statuses numbered above 10 or under 30 should be created, edited or deleted. Audit Leverage uses the other numbered statuses as part of automatic status updates with sign-offs.

12. Enter the text of your review note in the **Review Note** field. Use the **Shift+F2** keys if necessary to zoom into this field for a larger display area.

The Review Notes screen contains a box in which the recipient and the author of the review note may each “sign-off”. As you write the review note, select the intended recipient’s name, then select your own name as the reviewer.

13. In the **Auditor** scrolling list box just below the **Recipient sign-off button**, select an auditor’s name to indicate the intended recipient of the review note.

14. In the **Auditor** scrolling list box just below the **Reviewer sign-off button**, select an auditor’s name to indicate the author of the review note.

When you complete these steps, the review note is ready for the recipient.

How to Search for Review Notes Bearing Your Name

To search for review notes bearing your name as the recipient, perform the following steps. For another way of finding review notes, see “Searching for Review Notes in the Project Status Query”

1. Ensure that the **Date created from** and **up to** fields contain the appropriate date range in which the review note was created.

2. Ensure that the **Work status from** and **up to** fields contain the review status range appropriate to the notes being searched.

   In the top section of the Review Notes screen, Audit Leverage defaults values into the **Date created from/up to** fields, and the **Work status from/up to** fields. These values may not be correct, depending on your time frame. Therefore, you should always check them.

3. In the **Recipient** scrolling list box, select your name.
Review Notes

When you select your name, the bottom part of the screen displays only those review notes for which you are the recipient. You may limit your search further by using other filter fields.

How to Respond and Sign Off on a Review Note

To respond and sign off on a review note, perform the following steps:

1. Enter a response and other comments in the **Recipient’s Response** field.
   
   Note that the **Review Comment** field is grayed-out, indicating that this field is not editable.

2. Create an electronic signature by clicking the **Recipient Sign-Off button**.

Microsoft Access checks to see if the name in the **Recipient** field matches the Audit Leverage login name of the current user. If there is a match, Audit Leverage places the user’s name in the **Electronic Signature** field and the date in the **Sign-off date** fields, respectively. If there is not a match, the system does not allow a sign-off to occur.

**Note:** Only the user whose name is associated with a sign-off can delete that sign-off using the **Delete sign-off** button. Deleting a sign-off changes the status back to its previous state, and unlocks fields as appropriate.

When the sign-off is complete, Audit Leverage automatically changes the **Review Note Status** field to reflect the new status. Once complete, the **Recipient’s Response** field appears grayed, and becomes read-only.

Once the recipient has completed the steps above, the review note is ready for final examination and sign-off by the reviewer.

How to Apply Final Reviewer Sign Off

To apply the final reviewer sign off, perform the following steps.

1. Find review notes ready for reviewer sign-off by performing the steps in “How to Search for Review Notes Bearing Your Name”. Instead of selecting your name in the **Recipient** field, select your name in the **Reviewer** field.

   For another way of finding review notes, see “Searching for Review Notes in the Project Status Query”

2. Create an electronic signature by clicking the **Reviewer Sign-Off button**.
Microsoft Access checks to see if the name in the **Author** field matches the Audit Leverage login name of the current user. If there is a match, Audit Leverage places the user’s name in the **Electronic Signature** field and the date in the **Sign-off date** fields, respectively. If there is not a match, the system does not allow a sign-off to occur.

**Note:**

Note: Only the user whose name is associated with a sign-off can delete that sign-off using the **Delete sign-off** button. Deleting a sign-off changes the status back to its previous state, and unlocks fields as appropriate.

When the sign-off is complete, Audit Leverage automatically changes the **Review Note Status** field to reflect the new status.

Once the reviewer has completed the steps above, the review note is complete. It can be retained in the database, or deleted using the **Delete this Review Note** button.

### Viewing and Tracking Options

#### Search for Review Notes with the Filter Fields

The top portion of the Review Notes screen allows you to search your database of review notes. You can search based upon any combination of 12 filter fields on the Review Notes screen:

- Date Created Range
- Work Status Range
- Project Number (same as Project ID)
- Cycle
- Subcycle
- Task
- Reviewer
- Recipient
- Recipient’s Office
- Attachment ID
- Audit Step Title

To execute a search, perform the following steps:

1. Use the scrolling list boxes in each filter field to select values by which to restrict the review notes displayed in the display area.
Review Notes

As you make changes to the filter field values, the bottom portion of the screen displays the new search results. With each change to the filter field values, the record navigator counter changes to reflect the number of review notes returned by the search.

2. To make your search less restrictive, delete one or more of your entries in the filter fields.

3. Press the Enter key to update the search results in the display area.

Searching for Review Notes in the Project Status Query

The Project Status query in Module C provides a quick way to search for review note data bearing your own name or that of another auditor. This query helps you find summary information about review notes for which you are responsible, and track the status of those review notes. The query can be filtered for a particular project, and for a particular staff person’s responsibilities.

To launch the Project Status tool, click the Project Status button on the main Module C screen. From the Project Status screen, you can search for a specific project’s review notes, or look at review notes across projects. You can also select the Filter? checkbox to narrow your search to only those review notes pertaining to a particular auditor. From the Project Status screen, you can highlight a review note entry, and press a button to navigate directly to the Review Notes screen to complete your work.

Perform Other Functions

The top portion of the screen also includes several other functions, including viewing review notes in spreadsheet view, and print previewing review notes.

How to Print A Review Note Report

To print a Review Note report, perform the following steps:

1. Press the Print Preview button.

The Print Options Form dialog box appears, as shown in Figure 149.
Viewing and Tracking Options

**Figure 149: Print Options Form dialog box**

2. Select an option from the dialog box.

3. Press the **Preview** button.

The Review Note report is displayed. An example Review Note report is shown in Figure 150.

**REVIEW NOTE(S)**

<table>
<thead>
<tr>
<th>Review Note #: 1 Title</th>
<th>Date Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>Math errors</td>
<td>7/21/99</td>
</tr>
</tbody>
</table>

**Audit Project #: 9030**
- **Entity Name:** Thailand Plant
- **Audit Title:** Lazarus Chemical (Thailand), Ltd
- **Audit Cycle:** Treasury
- **Task:** N/A

**Workpaper Number:** 700302
- **Workpaper Title:** Treasury
- **Audit Program Title:** Liquidity Requirements
- **Review Note Status:** Cleared by recipient

**Review Comment:**
Check your math on page 2 of your spreadsheet.

**Recipient’s Response to the Review Comment**
- **Fixed:**

**Figure 150: Sample Review Note Report**

4. Use **File > Print** or the print button on the toolbar to send the report to the printer.

5. Click the **Close** button or use **File > Close** to return to the Review Notes screen.

**How to View Review Notes in Spreadsheet View**

To view review notes in spreadsheet view, click the **Spreadsheet view** check box.
Review Notes

The bottom area of the screen changes from form view to spreadsheet view, displaying all review notes that satisfy the filter criteria entered in the filter fields. Deselect the checkbox to return to the regular Review Notes screen.
Section 5

Module D: Reporting, Searching, and Analysis
Module D Overview

Module D contains operations needed to perform reporting, searching and some data analysis on your database. Module D provides the ability to view findings, search the entire database and generate the Audit Director’s Summary Report.

To access the functions of Module D, from the Audit Leverage Main screen, click the Reporting, Searching, and Analysis button.

The Module D screen appears, as shown in Figure 151.
Module D Overview

The following selections are available in Module D:

- Findings for a Specific Audit Report
- Search Your Database
- Audit Director’s Summary Report

For complete information on Findings, refer to Chapter 20: “Findings”. For complete information on searching your database, refer to Chapter 12: “Working With Search Your Database”.

Audit Director’s Summary Report

The Audit Director’s Summary Report allows you to create a report containing a variety of information.
How to Create a Summary Report

To create an Audit Director’s Summary report, perform the following steps:

1. Click on Audit Director’s Summary Report.

   The Generate Audit Director’s Audit Summary Report dialog box appears, as shown in Figure 152.

![Figure 152: Generate Audit Director’s Audit Summary Report dialog box](image)

2. In the fields on the upper left side of the dialog box, enter any criteria that you want to include in the summary report.

3. Click on the right arrow to add the criteria to the Selected Search Parameters list box.

4. Repeat Step 2 and Step 3 until the desired parameters are selected.

5. Select the search type.

6. Determine the sort order by selecting values in the Sort selection list and clicking on the right arrow to move it to the Sort order list.

7. Repeat Step 6 as necessary until all the desired sorting selections have been chosen.

8. Use the up and down arrows to move the selected sorting selections as necessary.
Module D Overview

9. Click the Generate Report button to generate the report.

Note:
Clicking the Clr button clears all criteria from the associated list.
Section 6

Module E: Audit Follow-Up
Module E Overview

Module E contains operations used to perform follow-up on Findings and management responses.

To access the functions of Module E, from the Audit Leverage Main screen, click the **Audit Follow-up** button.

The Module E screen appears, as shown in Figure 153.
Module E Overview

The following selections are available in Module E:

- Late Management Responses
- Management Response Follow-up
- Outstanding Findings Report

For more information on the topics, refer to “Tracking Responses and Auditor Follow-up Entries”, “Late Management Responses Query”, and “Outstanding Findings Report” in Chapter 21: “Management Responses and Follow-Up”.

Figure 153: Module E Screen
Section 7
Module F: Human Resources
Module F Overview

Module F allows you to maintain a list of your department staff. You can track general information, addresses, phone numbers, skills, and more.

To access the functions of Module F, from the Audit Leverage Main screen, click the Human Resources button.

The Module F screen appears, as shown in Figure 154.
Module F Overview

The following selections are available in Module F:

- Audit Staff List
- Auditor Performance Evaluations
- Staff Summary Reports

Audit Staff List

The Audit Staff List screen allows you to enter primary information about your staff.

How to Enter Staff Information

To enter staff information, perform the following steps:

1. Click on Audit Staff List.
The Current Audit Staff screen appears, as shown in Figure 155.

2. In each field of the tab, enter the appropriate information.
3. Repeat Step 2 for each tab in the screen.

The information entered allows you to track your staff, as well as use the summary reports to view specific information about the staff as a whole.
Module F Overview
Section 8
Module G: Table Settings
Module G: Table Settings

Module G consists of a series of tabs representing each module within Audit Leverage. Shown on each tab is a list of the various lookup tables contained within each module. You can change these values as necessary to modify values throughout Audit Leverage. This chapter describes the types of data contained in the lookup tables and how to change the information contained in the tables.

This chapter contains the following sections:

• “Understanding Module G Lookup Tables”
• “Entry Creation Example”

Overview

When you select Module G from the Audit Leverage Main Screen, the Module G Main Screen appears, as shown in Figure 156.
Module G: Table Settings

Figure 156: Module G Main Screen

Each tab contains navigation buttons to tables where you can populate key data. Each time you click on a drop-down arrow on a scrolling list box in Audit Leverage, the selection list shows data drawn from one of these tables. Values for every scrolling list box in Audit Leverage, with the exception of the Gender field in the Audit Staff List can be customized.

For example, refer to Figure 157. This figure shows the Audit Entity Profile Screen in Module A. The Audit Office scrolling list box has been selected. A list appears with possible entries for this field. This is one of many selection lists that are driven by entries made in the tables in Module G.
Understanding Module G Lookup Tables

To effectively modify information contained in a lookup tables within Module G, you must understand what types of data are contained in the table and its intended purpose. An in-depth list of the lookup tables for each Audit Leverage module is contained in Appendix B: “Module G Lookup Tables”. Refer to this list before you make any modifications to the values listed in Module G.

Creating Entries in the Module G Lookup Tables

The procedure for adding or modifying data in any of the Module G tables is the same. The example that follows the general procedure describes adding data for a field in Module F. Similar steps can be used for all other fields throughout Audit Leverage.
Module G: Table Settings

How to Create Entries

To create an entry, perform the following steps:

1. From the Module G Main Screen click the tab which contains the tables for the values you want to create.
   The view changes to reflect the values for that tab.
2. Click on the button that relates to the values you want to create.
   The view changes to show the various data which is currently entered for this field.
   By default, when you enter the table, the cursor is positioned on the first record, in the first column.
3. Position your cursor in the first column in the last row of the table, which is next to the asterisk, and click.
4. For each column, enter the value that you want to add.
5. Click on any other row.
   Moving to another record automatically saves the record. You do not need to press the Save button.
6. Repeat Step 4 and Step 5 for each entry you want to add.
7. Select File > Close to return to the Module G screen.

Note:
If you want to modify an existing record, click in the first column of the existing entry row. Perform Step 4 and Step 5 for each value you want to modify.

Entry Creation Example

To create an entry for the Module F Audit Offices list, you perform the following steps:

1. From the Module G Main Screen click the Module F tab.
   The view changes to reflect the values for that tab. See Figure 158.
Creating Entries in the Module G Lookup

2. Click on the **Audit Offices** button.

   The view changes to show the various entries currently entered for this field. See Figure 159.
Module G: Table Settings

Figure 159 shows values for the Audit Offices table. By default, when you enter the table, the cursor is positioned on the first record, in the first column. In this example, there are seven entries. The # column determines the order in which these seven entries appear in the drop-down list when the field appears on a screen, as shown in Figure 160.

Figure 159: Audit Offices Lookup Table

Notice that the Audit Office entries appear in the order of the # field, and that field is displayed in the selection list.

Figure 160: Audit Office Field Drop-Down List
Creating Entries in the Module G Lookup

3. Position your cursor in the # column in the last row of the table, which is next to the asterisk, and click.

   The asterisk changed to a pencil. This indicates that Microsoft Access knows you are creating a new record.

4. In the # column, enter 4.5.

   Later when a drop-down selection list appears which references this table, the changed entry appears immediately after the fourth entry, since 4.5 is after 4, but before 5.

5. Enter the value “Environmental Auditors” in the Audit Office field.

6. Click on any other row.

   Moving to another record automatically saves the modified record. You do not need to hit the Save button.

Figure 161 illustrates the change that occurs on the screen.

7. Select File > Close to return to the Module F tab.

Viewing Modified Values

Once you have completed entering the values in Module G, they are immediately available in Audit Leverage. For example, if you performed the steps to modify the audit offices in the “Entry Creation Example”, you could view the modifications immediately.

How to View the Modified Values

To view the modified values within the Audit Leverage screen, preform the following steps:

1. Return to the Audit Leverage Main Screen.

2. Select Module A.
Module G: Table Settings

3. Click **Update the Audit Universe**.

   A screen similar to that shown in Figure 157 appears.

4. Click on the drop-down arrow next to the “Audit Office” field.

   The updated list appears, as shown in Figure 162.

<table>
<thead>
<tr>
<th>Audit Office</th>
<th>#</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Auditors</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>IS Auditors</td>
<td>2</td>
<td>Responsible for application reviews.</td>
</tr>
<tr>
<td>Inventory Control Auditors</td>
<td>3</td>
<td>Responsible for inventory observations.</td>
</tr>
<tr>
<td>Corporate Auditors</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Environmental Auditors</td>
<td>4.5</td>
<td></td>
</tr>
<tr>
<td>Chief Auditors</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Branch Auditors</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Financial Auditors</td>
<td>13</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 162: Audit Office Drop-Down Selection List with New Entry**

Note that the “Environmental Auditors” entry appears fifth in the list, between the “4” and “5” values.

The methods described in this chapter can be used to change any value in the Module G lookup tables.
Section 9

Appendices and Glossary
Conflicts, Errors and Synchronization

Errors and Conflicts in Audit Leverage and Microsoft® Access typically fall into the following categories:

• Conflicts: conflicts occur when two different people have edited the same existing record, either both working locally, or one working on the network database and one working locally.

• Data errors: data errors occur under a variety of circumstances:
  — a user deletes a record that other records reference
  — two people create the same record identified by the same primary key field(s)

• Lockout errors:
  — during synchronization, someone is working in a record that another user is trying to synchronize
  — two people attempt to work on the same record at the same time on the network database

• Corrupted records
  — data corruption has taken place in the record

• Design errors: design errors occur when something is changed about the database design—such as field format changes or table changes—which prevents data from conforming to the new database design.
Notes:

1. Microsoft Access 2000 treats all errors as conflicts.

2. Access 2000 identifies conflicts on a field-level basis while Access 97 identifies conflicts on a record-level basis.

When one of these errors or conflicts occurs, Access makes a decision about which piece of data to keep. Typically, you can then correct the discrepancy. However, in Access 97, your databases may diverge if you do not choose a record and synchronize the databases.

Conflicts

Conflicts occur when two different people have edited the same existing record, either both working locally, or one working on the network database and one working locally. Upon synchronization, Access detects that the same record now has two different sets of updates to perform. During the synchronization process, conflicts are propagated to all replicas.

Access 97

In Access 97, the databases may diverge if resolutions are not implemented in a timely manner. Access 97 identifies conflicts on a record-level basis.

In Access 97, conflicts should be resolved from the machine where the conflict occurred if possible.

Access 2000

In Access 2000, Access itself determines which record to keep, using a somewhat arbitrary method. The resolution process allows the user who entered the data to determine which record should actually be retained. Access 2000 identifies conflicts on a field-level basis.

Access 2000's Conflict Viewer may also display a conflict list which specifies a number of related conflicts, such as “1 tbl audit reports (with 4 related conflicts).” However, it does not identify the where the related conflicts are located.

Errors

Errors only occur in Access 97. When an error occurs, resolution should be performed from the machine that was involved in the error. During the
Conflict and Error Resolution

synchronization process, errors are propagated to all replicas. Your databases may diverge.

There are a number of error types which can occur in Access 97:

• Insert—A duplicate value was inserted
• Modify—Modification of an existing value causes a duplicate in the database
• Delete—A deleted value was referenced by another record in the database

**Note:**

After resolution, errors may still appear in the dialog box until all users have synchronized their database. You may need to synchronize twice to ensure all errors are removed.

Conflict and Error Resolution

If there are conflicts and errors in the data, they appear after you synchronize the database. A message box appears informing you that conflicts and errors should be resolved.

If an error or conflict is detected upon Audit Leverage's startup synchronization, the Welcome Screen appears. However, the conflict resolution screen is also active. Resolve the errors and conflicts by clicking on the appropriate button on the welcome screen.

**Note:**

If you find that your department seems to generate a large number of conflicts and errors, it may be a result of a process problem within the department. In the event of many repetitive errors or conflicts, you may want to review the process you use for entering and modifying data. Segregation of data entry responsibilities helps in minimizing conflicts and errors.

How to Resolve Conflicts and Errors

If conflicts or errors occur and require resolution, perform the following steps:

1. If a message box appears informing you that you have errors or conflicts, click **OK** in the message box to begin resolving errors and conflicts.
   
   The Conflict Resolver Menu appears, as shown in Figure 163.
Figure 163: Conflict Resolver Menu

In the screen are fields that display the number of conflicts and errors for the Local Database and the Synchronized Database. These buttons allow you to select a network and the local database to resolve the conflicts and errors. The network database selection defaults to the last database which was synchronized with the local RepBE. Fields at the bottom of the screen also display the number of conflicts and errors found in each database.

2. In the **Local Database** field, click on the **Open** button.

The local database back-end launches. The **Audit Leverage – [RepBE : Replica]** dialog box appears. Depending on the types of issues with the replica set—errors, conflicts, or both—a message appears asking you if you want to resolve the errors and conflicts.

3. Click **Yes**.
Conflict and Error Resolution

The following sections describe how to resolve conflicts and errors, depending on the type of problem and the version of Access that you are currently running.

**Conflict Resolution - Access 97**

The Resolve Replication Conflicts dialog box appears, as shown in Figure 164.

![Figure 164: Resolve Replication Conflicts dialog box](image)

The example dialog box shown in Figure 164 indicates that there is a conflict in the Audit Staff table.

**About Access 97 Conflicts**

Conflicts are the easier of the two replication problem types to understand and to handle. Any time two people update the same record on two different replicas of the database, a conflict occurs when those two replicas are synchronized. Access 97 cannot narrow conflicts down to a specific field rather than just a record.

When resolving a data conflict, Access, like a judge in a courtroom, chooses a winning record. It does so in a predictable but somewhat arbitrary fashion: Whichever of the two records was updated the most frequently is declared the “winner”; the losing replica’s data is changed; if both records have been updated the same number of times, Access chooses the winner randomly.

Only the losing database is notified, and Access places the losing record in a conflict table. The loser is then asked to either:

- Keep the existing record.
- Overwrite the existing record with the conflicting record.

**How to Resolve Conflicts in Access 97**

To resolve conflicts in Access 97, perform the following steps:

1. Click the **Resolve Conflicts** button.
The Resolve Replication Conflicts Table_Name dialog box appears, where Table_Name is the name of the table where the conflict occurred, as shown in Figure 165.

The information shown in the Existing Record column on the left is the record that “won” the conflict. This is the record Access chose to retain. The “losing” user is presented with the chance to override this decision and choose the record on the right, the Conflict Record. You also have other choices: you can edit either record, and then click the Keep Existing Record button to choose the record on the left, or click the Overwrite with Conflict Record button to choose the record on the right.

2. Click the button that reflects your decision.

A message box appears prompting you verify your decision.

3. Click Yes to verify.

A message box appears specifying that the conflict is resolved. This process is repeated until all conflicts are resolved.

4. Click OK to close the Resolve Replication Conflicts Table_Name dialog box.

⚠️ **Important:**
You should not arbitrarily resolve conflicts. If possible, discuss the correct resolution with the person who created the conflict.
Conflict and Error Resolution

The Resolve Replication Conflicts dialog box reappears. It should now list no conflicts in the window, as shown in Figure 166.

![Figure 166: Empty Resolve Replication Conflicts dialog box](image)

**Error Resolution - Access 97**

Error resolution is somewhat different than conflict resolution. When an error occurs, you must locate the record in your database that is causing the error and make manual changes. When there are errors to be resolved, the View Data Errors... button is active, as shown in Figure 167.

![Figure 167: Resolve Replication Conflicts dialog box with active Error button](image)

**How to Resolve Errors in Access 97**

To resolve errors in Access 97, perform the following steps:

1. Click the View Data Errors button.

The Replication Data Errors dialog box appears, similar to that shown in Figure 168.
The Replication Data Errors dialog box presents detailed information about each of the errors in your database. However, this information is read only, and cannot be modified from this dialog box. In the event that there are multiple errors, you can navigate between them using the record selection bar at the bottom of the dialog box. The information contained in this dialog box is as follows:

— The **Show me how to correct replication data errors** button allows you to view background information about correcting errors.

— The **Machine** field, as well as the **Path** and **UNC Path** fields below it describes the location of the error on the master network database.

— The information contained in the **Source Machine** field, as well as the **Path** and **UNC Path** fields below it refers to the location of the record in the local replica.

— The **Table Name** field displays the name of the table in both locations where the error occurred.

— The **Record ID** field displays a unique identifier for the record within the table. This ID number uniquely identifies that record from any other record within the database.

— The **Operation** field displays a description of the operation that led to the error.

— The **Reason** field describes the problem.
Note:
During error resolution you should keep both the network and local databases open. However, close both databases before performing synchronization.

About Access 97 Errors
Unlike conflicts, errors cannot be resolved by picking one version of a record over another. To solve a data error you must locate the record in your database that is causing the error, and either manually change the data or delete the record. Audit Leverage specifies which of the two databases is responsible for the specific error. In Figure 168, the database causing the error is found in the Path field under the field labeled Source Machine. The table containing the error is listed in the Table Name field.

Replication requires a method to uniquely identify each record in a replicated database such as Audit Leverage. The identifier is a system field called s_GUID (Globally Unique IDentifier) created by Access to guarantee uniqueness. An example s_GUID looks like this:

{A552E4E3-52A9-11D3-8B0E-B8DF25963D7A}

This identifier is found in this screen print in the field RecordID. The unique identifier is very long because the replication scheme of Access is entirely dependent on this number being unique for every record of every table. More characters increase the uniqueness factor.

2. Copy the value held in the RecordID field into the Windows clipboard.
3. Take note of the values of the Path field under the Source Machine field and the Table Name field.
4. From the Conflict Resolver Menu, click on the button corresponding to the database containing the error, either Local Database or Other Synchronized Database.

Access again indicates that this database has errors, and prompts you to determine if you want to see them.
5. Click No.
6. From the Tools menu, select Options.
7. In the View tab, ensure that the System Objects checkbox is selected.
8. Click OK.
9. In the Tables tab, double-click on the name of the table containing the error.
The selected table opens and displays its records, in a view similar to that shown in Figure 169. Depending on the table you select, the column headings may be different, since each table has different field names.

<table>
<thead>
<tr>
<th>GUID</th>
<th>Lineage</th>
<th>Surname</th>
<th>Firstname</th>
<th>Lastname</th>
<th>User</th>
<th>GUID</th>
<th>Lineage</th>
<th>Surname</th>
<th>Firstname</th>
<th>Lastname</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAeAFB7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>N/A</td>
<td>Please do not delete</td>
<td>Ms. Amy</td>
<td></td>
<td>BAeAFB7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>A. Fulgo</td>
<td>N/A</td>
<td>Ms. Amy</td>
<td></td>
</tr>
<tr>
<td>CE2E2E2E-7E3E-1105-A2E8-0010B5670C2</td>
<td>long binary string</td>
<td>Arnold</td>
<td>Piccolo</td>
<td>Piccolo</td>
<td>Mr. Arnold</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>019E3E-1105-A2E8-0010B5670C2</td>
<td>long binary string</td>
<td>Erin</td>
<td>Kollar</td>
<td>Kollar</td>
<td>Mr. Erin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFC1-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Jennifer</td>
<td>Jonasto</td>
<td>Jonasto</td>
<td>Ms. Jennifer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFCD-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Jim</td>
<td>Undegger</td>
<td>Undegger</td>
<td>Mr. Jim</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFC5-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Joe</td>
<td>Parker</td>
<td>Parker</td>
<td>Mr. Joe</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFC5-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Karen</td>
<td>Kellins</td>
<td>Kellins</td>
<td>Ms. Karen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFCA-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Kay</td>
<td>Rock</td>
<td>Rock</td>
<td>Ms. Kay</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFCA-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Kristin</td>
<td>Defling</td>
<td>Defling</td>
<td>Ms. Kristin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFCA-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Laura</td>
<td>Wilder</td>
<td>Wilder</td>
<td>Ms. Laura</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Lisa</td>
<td>Zeeb</td>
<td>Zeeb</td>
<td>Ms. Lisa</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Luisa</td>
<td>Rodriguez</td>
<td>Rodriguez</td>
<td>Ms. Luisa</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Martin</td>
<td>Wells</td>
<td>Wells</td>
<td>Mr. Martin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Melinda</td>
<td>Phillips</td>
<td>Phillips</td>
<td>Ms. Melinda</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Miki</td>
<td>Yokohama</td>
<td>Yokohama</td>
<td>Ms. Miki</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Mike</td>
<td>Awad</td>
<td>Awad</td>
<td>Mr. Mike</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Miki</td>
<td>Lee</td>
<td>Lee</td>
<td>Mr. Miki</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Natalie</td>
<td>Dumond</td>
<td>Dumond</td>
<td>Ms. Natalie</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Paul</td>
<td>Ching</td>
<td>Ching</td>
<td>Mr. Paul</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Patricia</td>
<td>Picard</td>
<td>Picard</td>
<td>Mr. Patricia</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Rafael</td>
<td>Madrigal</td>
<td>Madrigal</td>
<td>Mr. Rafael</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BAeAFD7-7743-1105-A20B-0010B5670C2</td>
<td>long binary string</td>
<td>Randy</td>
<td>Cowell</td>
<td>Cowell</td>
<td>Mr. Randy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 169: Table view with GUIDs shown

10. Select Records > Filter by Form or click on the Filter By Form button on the Access toolbar.

The record view disappears and one empty record appears on the screen.

11. Paste the value you copied from the RecordID field in Step 2 into the s_GUID field.

The result should look similar to Figure 170.
Conflict and Error Resolution

12. Select **Records > Apply Filter Sort** or click the **Filter** button on the Access toolbar.

By entering the GUID value and pressing the **Filter** button, you are instructing Access to find any records whose GUID matches the value you entered. The view changes to show the record containing the error.

13. Select the row by clicking on the record selection arrow.

14. Modify the data, or, if the data is corrupt, press the **Delete** key on your keyboard.

If you modify the data, you may be required to locate the record that generated the error. Access prompts you to verify the operation.
15. Click **Yes**.

16. Close this database.

   Access prompts you to verify if you want to save changes to the design of the table.

17. Click **No**, since you have only made data changes, not design changes.

18. Repeat Step 9 through Step 17 for each error in this database.

19. Repeat Step 4 through Step 18 for any errors which may be contained in the other database.

20. Close the Replication Data Errors dialog box.

21. Close the Resolve Replication Conflicts dialog box.

22. Close the database.

23. Close the Conflict Resolver Menu.

**Important:** Errors may still appear in the dialog box until all users have synchronized their database. You may need to synchronize a second time to remove the errors.

**Conflict Resolution - Access 2000**

The Microsoft Replication Conflict Viewer appears, as shown in Figure 171.
Conflict and Error Resolution

Figure 171: Microsoft Replication Conflicts Viewer

Note:
Access 2000’s Conflict Viewer may display a conflict list which specifies a number of related conflicts, such as “1 tbl audit reports (with 4 related conflicts).” However, it does not identify the where the related conflicts are located.

The example dialog box shown in Figure 164 indicates that there is a conflict in the Audit Staff table.

About Access 2000 Conflicts
Any time two people update the same record on two different replicas of the database, a conflict occurs when the replicas are synchronized. Unlike Access 97, Access 2000 narrows conflicts down to a specific field within the record.

Access 2000 then gives you four resolution choices. However IAD Solutions strongly recommends that you only consider two of them:

• Keep the existing record.
• Overwrite the existing record with the conflicting record.
How to Resolve Conflicts in Access 2000

To resolve conflicts in Access 2000, perform the following steps:

1. To begin the process of resolving the conflicts in the tables, click the View button.

The Replication Conflict Viewer for DB_Name - Table_Name dialog box appears, as shown in Figure 172.

![Figure 172: Replication Conflict Viewer for DB_Name - Table_Name dialog box](image)

The information shown in the left column is the existing record column, or the record that "won" the conflict, that is, the record Access chose to retain. The "losing" record is shown in the right column. The Reason for conflict: list box displays the reason that the records were determined to be in conflict. The Show Fields frame presents you with viewing options: you can either show only the conflicting fields in the record, or all fields in the record. You are also presented with a number of options for which set of data you want to keep. You can either keep the existing record, modify the existing record, overwrite with the conflicting record, or modify the conflicting record.

2. Ensure that the Show only fields with conflicts radio button is selected.
Conflict and Error Resolution

Depending on the choice that was previously selected, the view of the dialog box may change to display only the unique record ID, the Primary Key for the record and the conflicting fields. The Primary Key is a value that is used to uniquely identify the record from all other records in the table.

**Note:**
You may need to temporarily select the **Show All Fields** radio button to view data to decide which record should be kept.

3. Select the radio button that represents the data value that you want to use as the record, either **Keep exiting data**, or **Overwrite with conflicting data**.

**Important:**
Although Access provides the **Keep revised data** and **Overwrite with revised data** options, IAD Solutions **strongly recommends** that you do not use these options. Often, Access 2000 does not properly insert the revised data correctly and may result in unexpected errors and behavior.

The Conflict Viewer allows you to save details of this conflict in a log to view later.

4. Select the **Log the details of this conflict for later reference** checkbox if you want so save the conflict details.

5. Click **Resolve** to accept the option that you selected, or click **Postpone** to resolve this conflict later.

This process is repeated until all conflicts are resolved. Once you have completed resolving conflicts, the Microsoft Replication Conflict Viewer dialog box appears again, specifying that there are no conflicting tables, as shown in Figure 173.
Figure 173: Microsoft Replication Conflict Viewer showing no conflicts

6. Click Close.

The Resolve Replication Conflicts dialog box reappears. It should now have no conflicts listed in the window, as shown in Figure 173.

Occasionally, Access 2000 is unable to display the conflict. This typically occurs with “Delete” conflicts. In the event that this occurs, perform the following additional steps:

7. Select Tools > Options.

The Options dialog box appears.

8. In the View tab, ensure that the Hidden Objects checkbox is selected.

9. Open the table <table_name>_Conflicts.

10. Verify the information in the table.

11. If the information is correct, delete the information and the <table_name>_Conflicts table to resolve the conflict.

Synchronizing after Removing Conflicts and Errors

Once you have corrected all the conflicts and errors, you must synchronize the databases again.
Synchronizing after Removing Conflicts

How to Synchronize the Databases

To synchronize the databases, perform the following steps:

1. Ensure that both back-end databases are closed.
2. From the Audit Leverage Welcome Screen Administration tab, click on Synchronize Your Hard Drive Database button.
   The Synchronizer Menu dialog box appears
3. Click the Synchronize Direct button in the lower left corner of the screen.
   A message box appears informing you that you must choose the database with which to synchronize your local copy.
4. Click OK.
5. The Open dialog box appears.
6. Browse to the network drive and directory in which the Audit Leverage master network database resides and select albe(<access_version>)-<client_name>.mdb.
   Ensure that you can view program extensions so that you do not inadvertently select the database lock file. Once you have selected the database file, a message box appears informing you that synchronization is in progress. When the process completes, there should be no table errors or conflicts.

   **Note:**
   Although the message box may indicate that there are no conflicts or errors, some may still exist within the database. The message box refers only to the most recently completed synchronization, and does not take into account conflicts or errors that already exist.
7. Click OK.
8. Click Close on the Synchronizer Menu.
9. Double check the errors and conflicts by clicking the Resolve Conflicts button on the Welcome Screen.
10. Look at the Conflicts and Errors fields for both the “Local Database” and the “Other Synchronized Database” databases.
    All values should be zero. If there are other values, you may need to synchronize direct again to fully effect the removal of the error.
Important:
If your department has purchased indirect synchronization, a Synchronize Indirect button appears. Consult the Audit Leverage Administrator for your department for guidelines on when to use each button.
Module G Lookup Tables

The Purpose of Lookup Tables

The following chart explains each tab and each shortcut in Module G. This table provides:

• Column 1: The lookup table name
• Column 2: A description of the data in each lookup table – how each is typically used within Audit Leverage
• Column 3: If and how the table is populated when Audit Leverage is first installed:
  — The table is empty
  — The table is pre-populated with default values by Audit Leverage
  — The table is populated with your audit department’s data during the initial database setup. Your department fills out spreadsheets with your audit information, and supplies these to Audit Leverage support for import into your database.
• Column 4: If the data is populated with your department’s data during database setup, the “Spreadsheet Name” column indicates the name of the spreadsheet that your department populates and supplies to Audit Leverage prior to installation.
• Column 5: If the data is pre-populated by Audit Leverage, this column shows the default values supplied with the application.
• Column 6: This column holds the name of the underlying Audit Leverage database table (in Microsoft® Access) that holds the actual data.

It is important to understand that regardless of whether or how the tables are initially populated, the data can be changed, added to, or deleted at any time by
someone with the appropriate security rights. This makes Audit Leverage flexible and customizable to your department’s needs. In addition, your department can decide if and how it wants to use these fields. Only a few fields are required, since they contain key data that allows users to function in all areas of the application. These involve audit entities, audit staff, and if using the risk assessment module, risk criteria and audit frequencies.

As mentioned before, some of these tables are populated as part of the initial database setup, and others have Audit Leverage default values in them. Ideally, before rolling out Audit Leverage to your team, it is best to go through each of these tables and add data to those that are not populated by the initial installation process. Additionally, it is beneficial to check any default values and see if you need to change them to fit your needs. However, you may not know immediately how you want to handle all the fields until you have become more familiar with Audit Leverage. Note, however, that if you have the appropriate security permissions, you can change, add, or delete values in these lookup tables at any time. Refer to the following chapters for more information:

- Chapter 3: “The Sign-Offs Tab and Record-Level Security”
- Chapter 10: “Planning Projects and Budgets”
- Appendix C: “Appendix - Module A, B & C Fields”

When looking at the default values in the lookup tables in Module G, a number next to an entry designates the position where that entry appears in a drop-down list. In a few cases, this number is used for additional purposes. For example, audit status codes and finding disposition codes have numbers associated to them. This number signifies a progression in status or reporting level. Lower numbers indicate lower status or reporting level; higher numbers indicate higher status or reporting level. When a user searches for projects or findings within a certain status or reporting range, the application uses these numbers in the search.
Module A: Annual Audit Planning

Table 3: “Grouping Entities Together” Lookup Tables (Sheet 1 of 2)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Companies</td>
<td>List of legal entities—not auditable entities—within the overall parent company</td>
<td>Empty</td>
<td>N/A</td>
<td>N/A</td>
<td>tbl Companies</td>
</tr>
<tr>
<td>Entity Groupings</td>
<td>Individual departments or groups within the legal entity</td>
<td>Empty</td>
<td>N/A</td>
<td>N/A</td>
<td>tbl Level 0 Entity Grouping Codes</td>
</tr>
<tr>
<td>Entity Subgroupings</td>
<td>Subgroups within departments or groups</td>
<td>Empty</td>
<td>Empty</td>
<td>N/A</td>
<td>tbl Level 1 Entity Grouping Codes</td>
</tr>
<tr>
<td>Business Divisions</td>
<td>Where various entities fall within the business structure or within the lines of business or service For example, in the case of an insurance company, business divisions might include: Property and Casualty, Life, and Auto. In the case of a manufacturer, entries might include Plumbing, Industrial, and Electric.</td>
<td>Empty</td>
<td>Empty</td>
<td>N/A</td>
<td>tbl Business Divisions</td>
</tr>
<tr>
<td>Regions</td>
<td>Geographic regions of the state, country or world, in which entities reside</td>
<td>Populated via spreadsheets</td>
<td>Geographic Regions.xls</td>
<td>N/A</td>
<td>tbl Regions</td>
</tr>
</tbody>
</table>
**Table 3: “Grouping Entities Together” Lookup Tables (Sheet 2 of 2)**

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity Types</td>
<td>Refers to entity functions within the organization, i.e. plant, warehouse, sales office, administrative department, corporate headquarters, etc. This field is used in risk assessment to differentiate risk criteria.</td>
<td>Populated via spreadsheets</td>
<td>Audit Entity Types.xls</td>
<td>N/A</td>
<td>tbl Location Types</td>
</tr>
<tr>
<td>Entity Sizes</td>
<td>Relative sizes (by staff count, revenues, assets, etc.) of entities.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>Small Medium Large</td>
<td>tbl Location Sizes</td>
</tr>
<tr>
<td>States/Provinces</td>
<td>Various states and/or provinces in which entities reside</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>List of states and provinces in the United States and Canada</td>
<td>tbl States</td>
</tr>
</tbody>
</table>
### Table 4: "Risk Assessment" Lookup Tables (Sheet 1 of 5)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Assessment Criteria Groupings</td>
<td>If helpful to your department, you may organize your risk criteria into categories. Every entity type must have at least one overall risk criteria grouping.</td>
<td>Empty</td>
<td>N/A</td>
<td>N/A</td>
<td>tbl Location Risk Criteria Groups</td>
</tr>
<tr>
<td>Lookup Table</td>
<td>Data Description</td>
<td>Populated?</td>
<td>Spreadsheet Name</td>
<td>Default Values</td>
<td>Audit Leverage Table Name</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Risk Assessment Criteria Names</td>
<td>The risk criteria your department uses in performing an entity’s risk assessment. The set of risk assessment criteria names can be different for every entity type, if desired. Up to one risk assessment per entity and project type combination can be created per year. Note that you can change your risk criteria from one year to the next without affecting any historical data.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>• Annualized loss expectancy • Identification and valuation of assets at risk • Probability • Safeguard/controls cost • Safeguards/controls effectiveness • Threat occurrence frequency • Threat occurrence impact • Threats • Uncertainty • Vulnerabilities</td>
<td>tbl Location Risk Ranking Criteria</td>
</tr>
</tbody>
</table>

Table 4: "Risk Assessment" Lookup Tables [Sheet 2 of 5]
<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Assessment Severity Codes (Risk Scores)</td>
<td>Each risk criterion may have its own set of risk scores and explanations, or you may choose to have the same set of risk scores and explanations for all risk criteria. See Chapter 6: “Setting Up a Risk Assessment” for a full explanation on how to make these table entries appropriately. (Here is an example of criteria with different risk scores and explanations: If two of your criteria are “Changes in management” and “Employee morale,” and if your rating scale is from 1 to 5, then a rating of 4 can have different explanations for each of the criteria, such as “The entire management team has resigned in the past 6 months” (for “Changes in management”) and “All the employees are afraid of downsizing” (for “Employee morale”).</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1—Low risk 2—Low – Moderate risk 3—Moderate risk 4—Moderate – High risk 5—High risk</td>
<td>tbl Location Risk Assessment Severity Codes</td>
</tr>
</tbody>
</table>
### Table 4: “Risk Assessment” Lookup Tables (Sheet 4 of 5)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Frequencies</td>
<td>This field is used to allow the system to auto-calculate when the next audit should take place based on the entity’s risk rating and date of last audit report. If you wish to use this feature, you can indicate risk value range and the range of time in which the next audit should take place.a.</td>
<td>Pre-populated,b</td>
<td>N/A</td>
<td>Risk score Range:</td>
<td>tbl Audit Frequencies</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.6—32-26 mo.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2.5—28-32 mo.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3.4—24-28 mo.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4.3—20-24 mo.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5.2—16-20 mo.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6.1—12-16 mo.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7.0—8-12 mo.</td>
<td></td>
</tr>
<tr>
<td>Codes for “Place on Audit Plan?”</td>
<td>You may customize your own codes to indicate whether or not an entity should be on the audit plan for a given year. However, do not delete or rename the entity called “Yes.”</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>Yes</td>
<td>tbl Place on Audit Plan? Codes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Decide Late</td>
<td></td>
</tr>
</tbody>
</table>

*a* This must be an integer value. 
*b* If “Yes,” no aggregation is needed; it is calculated automatically.
Module A: Annual Audit Planning

Project Priority Codes

This field can be used to indicate the priority of this audit among others planned for the year. This will assist managers in scheduling and rescheduling audits as the year progresses, allowing postponement of low-priority audits as necessary.

Plan Year Sections

In Audit Project Setup, an audit project can be assigned to a particular month, quarter, or other time of year.

### Table 4: "Risk Assessment" Lookup Tables (Sheet 5 of 5)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Priority Codes</td>
<td>This field can be used to indicate the priority of this audit among others planned for the year. This will assist managers in scheduling and rescheduling audits as the year progresses, allowing postponement of low-priority audits as necessary.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1-High</td>
<td>tbl Project Priority Codes</td>
</tr>
<tr>
<td>Plan Year Sections</td>
<td>In Audit Project Setup, an audit project can be assigned to a particular month, quarter, or other time of year.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1-Jan. 2-Feb. 3-Mar. 4-Apr. 5-May 6-June 7-July 8-Aug. 9-Step 10-Oct. 11-Nov. 12-Dec.</td>
<td>tbl Plan Year Sections (Quarters or Months)</td>
</tr>
</tbody>
</table>

---

a. Note that there are separate fields for “beginning of range” and “end of range.” In calculating the next recommended audit date, the system uses the midpoint. For example, for an audit frequency of 32-36 months, the system uses 34 months.

b. It should be noted that the system suggestions have no meaning if they do not match your audit methodology.
Table 5: “Entity Background Info” Lookup Tables

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Audit Requirement Codes</td>
<td>If your department must coordinate with external auditors (auditing firms or regulatory agencies), you can indicate their requirements for each entity. This value appears in the definition of the entity.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1—Full Scope Audit 2—Limited Scope Audit 3—Timely, Statutory Audit 4—Non-timely Statutory Audit 5—Limited Review 6—No Audit</td>
<td>tbl External Audit Requirement Codes</td>
</tr>
</tbody>
</table>

Table 6: “Specific Visits” Lookup Tables

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branches Facilities Locations</td>
<td>A sub-entity visited while auditing the main entity that is the focus of an audit project. Depending on the nature of the entity, sub-entities may be physical locations, subdepartments or responsibility centers visited during the main entity's audit. Branch, facility and location fields can be used alone or in combination to reflect a sub-entity hierarchy.</td>
<td>Empty</td>
<td>N/A</td>
<td>N/A</td>
<td>tblBranches tblFacilities tblLocations</td>
</tr>
</tbody>
</table>
### Module B: Staffing, Scheduling, and Time Tracking

#### Table 7: Module B Lookup Tables (Sheet 1 of 2)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Types</td>
<td>Indicate the various types of audits conducted for entities (examples might include financial, operational, fraud investigation, etc.).</td>
<td>Populated via spreadsheets</td>
<td>Audit Project Type.xls</td>
<td>N/A</td>
<td>tbl COSO Categories</td>
</tr>
<tr>
<td>Project Status Codes</td>
<td>The various statuses which can be assigned to an audit project at varying points along the project timeline</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>10-no action yet 20-postponed 30-cancelled 40-confirmed with auditee 50-staff and dates assigned 55-planning in progress 60-fieldwork in progress 65-completed; no report to be issued 70-report in progress 80-report issued 90-follow-up in progress 100-closed</td>
<td>tbl Audit Status Codes</td>
</tr>
<tr>
<td>Lookup Table</td>
<td>Data Description</td>
<td>Populated?</td>
<td>Spreadsheet Name</td>
<td>Default Values</td>
<td>Audit Leverage Table Name</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Project Rating Codes</td>
<td>Codes for the overall risk severity of the results of an audit report, as well as the results (or assessed risk during planning) of each audit program within a project.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1-Satisfactory 2-Satisfactory Except For 3-Less than Satisfactory 4- Unsatisfactory 5-Not rated</td>
<td>tbl Audit Rating Codes</td>
</tr>
<tr>
<td>Project Phases</td>
<td>Often used in the budgeting process to allocate auditor hours to various phases in the project. Also, when auditors charge time to a project number, they may choose to charge it to a specific phase of that project.</td>
<td>Pre-populated, but these values can be overwritten through your spreadsheets</td>
<td>Audit Phases.xls</td>
<td>1. Planning 2. Fieldwork 3. Reporting 4. Supervision 5. Follow-up 6. Administration 7. Other 8. Travel</td>
<td>tbl Phases</td>
</tr>
<tr>
<td>Project Sources</td>
<td>The party requesting the audit, or the process determining the necessity for the audit. For example, audit committee, annual rotation, special request, risk assessment, etc.</td>
<td>Empty</td>
<td>N/A</td>
<td>N/A</td>
<td>tbl_Project_Source</td>
</tr>
<tr>
<td>Customize Engagement Letter Selections</td>
<td>Allows you to edit the standard text in the engagement letter formats.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>See system</td>
<td>Customize Engagement Letter</td>
</tr>
</tbody>
</table>
## Module C: Workpapers

### Table 8: Module C Lookup Tables (Sheet 1 of 4)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Cycle Names</td>
<td>The cycle field is used to describe the area or process to be covered by an audit program. It is also used in identifying or naming a program within a project. This table is also used to categorize specific findings, workpapers, and review notes. Despite the use of the word “cycle,” this table can be used to record things other than traditional accounting cycles such as Payroll or Fixed Assets.</td>
<td>Populated via spreadsheet</td>
<td>Audit Areas or Cycles.xls</td>
<td>N/A</td>
<td>tbl Cycle Names</td>
</tr>
<tr>
<td>Subcycles</td>
<td>A second level of description for a particular audit program. If the cycle name is not specific enough, you can choose to enter a subcycle to further describe and name it. For example, if one of your cycles is Product Delivery, two subcycles might be “Planning &amp; Scheduling” and “Procurement.”</td>
<td>Empty</td>
<td>N/A</td>
<td>N/A</td>
<td>tbl Subcycle Names</td>
</tr>
</tbody>
</table>
### Table 8: Module C Lookup Tables (Sheet 2 of 4)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Names</td>
<td>A third level of description for a particular audit program; it is essentially a “sub-subcycle.” If necessary, you can further describe subcycles by their discrete components. For example, a subcycle of “Procurement” might have two tasks called: “Receiving” and “Competitive Bidding.” Note: Task does <em>not</em> mean “audit step.” Task is the third-level name for the program.</td>
<td>Empty</td>
<td>N/A</td>
<td>N/A</td>
<td>tbl Task Names</td>
</tr>
<tr>
<td>Audit Program Templates</td>
<td>Before a template of audit steps can be used in an audit project, an entry for it must be made in this table. However, you can use the Module C: Audit Program Templates interface to enter this data via the Audit Leverage screens, instead of entering data in this table.</td>
<td>Populated via spreadsheet</td>
<td>Audit Programs.xls</td>
<td>N/A</td>
<td>tbl Audit Program Listing</td>
</tr>
</tbody>
</table>
As the audit progresses, you may capture the progress of work performed on each step. The system defaults to whichever status code is numbered 10.\(^\text{a}\)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Step Status Codes</td>
<td>As the audit progresses, you may capture the progress of work performed on each step. The system defaults to whichever status code is numbered 10.(^\text{a})</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>10-Not yet started 20-Work progressing 30-Work halted; waiting for client 40-Ready for review 50-Approved by first reviewer 60-Approved by second reviewer tbl Audit Step Status Codes</td>
</tr>
<tr>
<td>Workpaper Status Codes</td>
<td>In Audit Leverage, each workpaper must be labeled with a workpaper status code. This is a required field.(^\text{a})</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>10-Not yet started 20-Work progressing 30-Work halted; waiting for information 40-Ready for review 50-Approved by first reviewer 60-Approved by second reviewer 70-Approved by third reviewer tbl Workpaper Status Codes</td>
</tr>
</tbody>
</table>
Table 8: Module C Lookup Tables (Sheet 4 of 4)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
</table>
| Review Note Status Codes | Review notes also have status codes, similar to audit steps and workpapers.\(^a\) | Pre-populated | N/A              | 10-Awaiting recipient's response  
20-Recipient's response in progress  
30-Cleared by recipient  
40-Cleared by first reviewer  
50-Cleared by second reviewer | tbl Review Note Status Codes |
| Finding Status Codes | Findings also have status codes, similar to review notes.\(^a\)                  | Pre-populated | N/A              | 10-Unlocked  
20-Work progressing  
30-Work halted, waiting for client  
40-Ready for Review  
50-Approved by 1st Reviewer  
60-Approved by 2nd Reviewer  
70-Approved by 3rd Reviewer | tblFindingsStatusCodes |

\(^a\) Changing these values is not recommended, since Audit Leverage attaches special significance to the codes as delivered. Please contact Audit Leverage support if you are considering changing these codes or descriptions.
## Module D: Audit Findings

### Table 9: Module D Lookup Tables (Sheet 1 of 2)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finding Disposition Codes</td>
<td>The field to which these values correspond is called the “How to Report” field on the Audit Findings Screen. This field provides choices on how the finding will be handled, including whether or not it will appear on the final audit report.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>10-Pending 20-Not significant 30-Verbal discussion 40-Supplemental report 50-Audit report (pending approval) 60-Audit report (approved)</td>
<td>tbl Exception Disposition Codes</td>
</tr>
<tr>
<td>Finding Severity Codes</td>
<td>You can designate quantifiable risk severity codes to indicate the relative risk of inaction regarding various audit findings in your system. These finding severity codes have no correlation to the risk severity codes in the risk assessment module (Module A). Note that whether or not a finding’s rating is shared with the auditee, it is useful both for the auditors’ own communication with each other, as well as for statistical averaging and trend analysis.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>5-High 4-Medium-High 3-Medium 2-Low-Medium 1-Low 0-Not yet assigned a risk score</td>
<td>tbl Risk Severity Codes</td>
</tr>
</tbody>
</table>
**Finding Types**
This provides a way to categorize a finding as to the type of risk it covers.

- Internal Control
- Operational
- Efficiency
- System Control

Pre-populated

Finding Types.xls

**Finding Scopes**
Certain clients have asked for a field on the Findings screen that indicates if a particular finding has global, site-specific or external auditing implications. You may not see this field appear on your Audit Findings screen, but if requested, we can customize your application to include this field.

- Global
- Site-specific
- External Auditor

Pre-populated

N/A

**Customize Audit Report Selections**
Allows you to edit the standard text in the audit report cover letter and audit report.

Pre-populated

N/A

See the system

ZstblReportInformation

---

*a.* Only those audit findings with a “How to Report” level of “Audit report (approved) and above are listed on the final audit report.

*b.* These values can be overwritten through your spreadsheets.
## Module E: Audit Follow-up

### Table 10: Module E Lookup Tables

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow-up Status Codes for Findings</td>
<td>Management responses can be flagged with specific follow-up codes, if necessary.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>10-No follow-up needed 15-Follow-up may be needed 20-Pending further response 30-Open 40-Completed by auditee 50-Check at a future date 60-Closed</td>
<td>tbl Follow-up status codes</td>
</tr>
<tr>
<td>Management Agreement Codes</td>
<td>Codes to indicate the level of auditee management agreement with the finding</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1-Agree 2-Partially Agree 3-Disagree</td>
<td>tbl Management Agreement Codes</td>
</tr>
<tr>
<td>Auditee Departments (For Management Responses)</td>
<td>Auditee departments that can be tied to management responses. These entries are used in the &quot;Responsible Department&quot; field on the Management Response tab of the Potential Audit Findings screen.</td>
<td>Empty</td>
<td>N/A</td>
<td>N/A</td>
<td>tbl GL Numbers to Departments</td>
</tr>
</tbody>
</table>
Module F: Human Resources

Table 11: Module F Lookup Tables (Sheet 1 of 4)

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Staff List</td>
<td>Clicking on the audit staff list button takes you inside the Audit Leverage screen for entering audit staff. You must enter audit staff either through this button in Module G, or through the same Audit Staff List button in Module F (Human Resources) in order for your staff to be able to charge time, or to sign off on audit steps, workpapers, time approvals, etc. It is important to note that the field &quot;Audit Leverage Log-in Name&quot; must be populated exactly as the person's name was entered in the system.mdw file (the Audit Leverage permissions file). Otherwise, Audit Leverage will not permit the user to enter time, or sign off on anything.</td>
<td>Populated via spreadsheet</td>
<td>Audit Staff.xls</td>
<td>“Michael Awad” is a default staff member in your database. This record serves as an example of how to set up staff members.</td>
<td>tbl Audit Staff</td>
</tr>
</tbody>
</table>

"Michael Awad" is a default staff member in your database. This record serves as an example of how to set up staff members.
### Module F: Human Resources

#### Audit Offices

This table is intended to list the various audit teams within your department. This information appears both in the HR module (to assign an auditor to an office) and in other Audit Leverage screens such as the Audit Entity definition screen. There, the “typical” audit office that handles audits for that entity can be entered. 

Populated via spreadsheet Auditor Offices.xls N/A tbl Audit Offices

#### Job Titles

You may enter your department’s job title designations here. The “#” field in this table is important. Audit Leverage considers all job titles designated with a number of 3 or less to be potential audit project managers. In other words, when a user searches the database of projects for those managed by a particular staff member, the drop-down list of possible choices will only include those staff whose job titles are identified as a 3 or less.

Pre-populated N/A 1-Director 2-Manager 3-Senior Auditor 4-Staff Auditor 5-Other tbl Staff Roles

---

**Table 11: Module F Lookup Tables (Sheet 2 of 4)**

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Offices</td>
<td>This table is intended to list the various audit teams within your department. This information appears both in the HR module (to assign an auditor to an office) and in other Audit Leverage screens such as the Audit Entity definition screen. There, the “typical” audit office that handles audits for that entity can be entered.</td>
<td>Populated via spreadsheet Auditor Offices.xls</td>
<td>N/A</td>
<td>tbl Audit Offices</td>
<td></td>
</tr>
<tr>
<td>Job Titles</td>
<td>You may enter your department’s job title designations here. The “#” field in this table is important. Audit Leverage considers all job titles designated with a number of 3 or less to be potential audit project managers. In other words, when a user searches the database of projects for those managed by a particular staff member, the drop-down list of possible choices will only include those staff whose job titles are identified as a 3 or less.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1-Director 2-Manager 3-Senior Auditor 4-Staff Auditor 5-Other</td>
<td>tbl Staff Roles</td>
</tr>
</tbody>
</table>
You may wish to create general categorizations of skills here so as to log auditor skills in the HR module. The field populated with this data appears as “Skill Type” on the Skills Inventory tab in the HR module.

Enter the specific skills your auditors might possess, which you would like to track.

When attributing a skill to a staff member, you may wish to indicate a proficiency level.
### Table 11: Module F Lookup Tables [Sheet 4 of 4]

<table>
<thead>
<tr>
<th>Lookup Table</th>
<th>Data Description</th>
<th>Populated?</th>
<th>Spreadsheet Name</th>
<th>Default Values</th>
<th>Audit Leverage Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethnic Group Names</td>
<td>If you are required by the EEOC to track Equal Employment hiring statistics, you may wish to enter various ethnicities in this table, and then assign each auditor an ethnicity when creating their profile in Module F.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1-Caucasian</td>
<td>tbl Ethnicity Names</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2-African American</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3-Asian</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4-Native American</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5-Latino</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6-Other</td>
<td></td>
</tr>
<tr>
<td>Auditor Performance Criteria</td>
<td>In Module F, Human Resources, you can create auditor performance evaluations. Much like the risk assessment criteria in Module A, you can enter auditor performance criteria here so they can be used when creating an actual performance evaluation.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>1-Communication Skills</td>
<td>tbl Auditor Performance Criteria</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2-Investigative Skills</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3-Persuasiveness</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4-Technical Competence</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5-Teamwork</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6-Professional Skepticism</td>
<td></td>
</tr>
<tr>
<td>Auditor Performance Ratings</td>
<td>Enter all possible ratings for auditor performance criteria in this table.</td>
<td>Pre-populated</td>
<td>N/A</td>
<td>Excellent – 5</td>
<td>tbl Auditor Performance Ratings</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Very Good – 4</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Good – 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Fair – 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Poor – 1</td>
<td></td>
</tr>
</tbody>
</table>

*There must be at least one default entry in this field to signify the entire department. Some departments may choose to divide their auditors into functional groups, such as "Operational Auditors," "Compliance Auditors," etc. Others may use geographic distinction if their auditors are based in multiple sites, such as "New York auditors," "London auditors," etc.*
Appendix - Module A, B & C Fields

Module A - Fields on the Auditable Entity Profile Screen

The following sections cover the fields on the Auditable Entity Profile screen. For a further analysis of these fields, see Appendix B: “Module G Lookup Tables”.

The Top Area of the Entity Screen

The top area of the screen contains the two required fields for defining an entity.

Required Fields

- **Entity number**—Every entity must have a unique number. The number, and sequencing of entity numbers, does not have to have any inherent meaning. Audit Leverage uses the entity number to uniquely identify the entity.

- **Entity name**—Each entity must have a unique name. The entity name is the way Audit Leverage commonly references the entity on other screens. The user is prompted for the entity name when searching for projects and related audit components.

All of the fields on the tabs are optional. Your department must evaluate which, if any, of these fields to use.

The Main Tab

If the Main tab is not currently displayed, click on the Main tab. The screen view changes to reflect the tab's fields, as shown in Figure 174.
Main Tab Scrolling List Boxes

The following scrolling list box fields are present on the Main tab. All possible entries necessary to describe entities must be entered in the corresponding Module G tables before they can appear when the user clicks the arrow in the scrolling list box:

- **Company, Group, and Subgroup**—This three-field hierarchy is designed to represent the tiers of the upper organizational structure to which the entity belongs. **Company** represents the highest level and is often used to capture the legal entity within the overall parent organization to which the auditable entity relates. **Group** and **subgroup** represent levels one and two below **company**. For example, the group field can represent a division or department within the legal entity. **Subgroup** can be used to capture subgroups within departments or groups.
Module A - Fields on the Auditable Entity

Note:
If you use the company field, it should not be used to capture the name of the parent company or organization to which every entity belongs. Using it incorrectly in this way renders data analysis on the field ineffective, because no differentiation exists in the company entries for each entity in the audit universe. Instead, the possible company values should reflect those parts of the organization just below the top level.

- **Region**—Geographic region to which the entity belongs
- **State**—State or province where the entity resides
- **Audit Office**—Auditor group within the audit department that most typically audits the entity. If your department has auditor groups that focus on specialized areas, these audit offices should be defined. Examples include operational auditors, I.T. auditors, financial auditors, etc. If your department does not segregate its auditors in this way, you should define at least one audit office in Module G that represents the entire department.
- **Typical Project Type**—Type of project most typically conducted for the entity.
- **Business Division**—Line of business or service to which the entity relates. The business division is independent of the company-group-subgroup hierarchy and can cut across them.
- **Entity Type**—This field serves to group entities together according to similar characteristics based on how the entity functions within the organization. Example entity types include plant, warehouse, sales office, administrative department, corporate headquarters, etc. The entity type field is crucial in Audit Leverage's risk assessment model. This field can be used to differentiate risk factors based on the entity being assessed. If desired, each entity type can have a different set of risk criteria. See Chapter 6: “Setting Up a Risk Assessment” and Chapter 7: “Risk Assessments” for a full explanation of the role of the entity type field in the risk assessment tool.
- **Hours Typically Needed for Full Scope**—this table is designed to hold information on the audit offices required for a full scope audit, and the number of hours required of each audit office. Audit Leverage sums the total audit hours required and displays the sum below the table.
Main Tab Text Boxes

• **Entity Long Name**—intended to hold a longer, more descriptive name for the entity. The entity long name appears on some of the Audit Leverage-generated engagement letters and audit report cover memos.

• **Country, physical address, city, postal code**—these fields hold the address information for the entity.

• **Primary Contact**—your department’s primary contact person at the entity.

• **Description**—holds any detailed descriptive information on the nature of the entity and what is typically audited there.

• **History of External Reviews**—holds the month, year, external reviewer, comments, attached files related to external audits.

Main Tab Checkboxes

• **Still Active?**—A check indicates the entity is still actively audited.

The Comments Tab

Click on the Comments tab. The screen view changes to reflect the tab’s fields, as shown in Figure 175.
Module A - Fields on the Auditable Entity

Comments Tab Text Boxes

- **Comments**—intended to hold any comments not captured on the other tabs. Information entered can include, for example, software applications in use by the entity, etc.

The Attachments Tab

Click on the **Attachments** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 176.
The Attachments tab is designed to house the entity’s permanent file attachments, or reference documents, sometimes known as the “perm file.” The entity’s organizational chart, driving directions, biographies of key managers, etc. are examples of files typically stored on the Attachments tab.

Hard copy documents can also be referenced. Leave the doclink field blank and use the title and description fields to indicate the nature of the document and its physical location.

Note:

The tab is not designed to hold a particular audit’s workpapers. Creating audit workpapers is covered in Chapter 19: “Working With the Audit Program Collection”.

Attachments Tab Doclink Fields

- Attached file—box that holds linked or embedded files.
Attachment Tab Text Boxes

- **Title**—Title for the file attachment
- **Description**—Description of the file attachment.

The History Tab

Click on the **History** tab. The screen view changes to reflect the tab's fields, as shown in Figure 177.

![Figure 177: Auditable Entity Profile Screen, History Tab](image)

The **History** tab contains read-only information related to the audit history of the entity. Information is drawn from the Module B Project Set-up screen and displayed in spreadsheet view. If you do not have any audit history in your Audit Leverage database, the tab is blank.

Your department does not have to make any decisions regarding use of fields on the History tab.
The Miscellaneous Tab

Click on the **Miscellaneous** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 178.

![Figure 178: Auditable Entity Profile Screen, Miscellaneous Tab](image)

**Miscellaneous Tab Scrolling List Boxes**

- **Entity Size**—relative size of the entity as compared to others in your audit universe
- **External Audit Requirement**—designed to hold information indicating the scope of an external audit when conducted on the entity

**Miscellaneous Tab Text Boxes**

- **Revenues**—annual revenues generated by the entity
Module B - Fields on the Project Set-up

- **Phone Number, Fax Number, E-mail Address**—contact information for the entity
- **I.T. Contact, Site/General Manager**—key staff at the entity

**Module B - Fields on the Project Set-up Screen**

The following sections cover the fields on the Audit Project Set-up screen. For a further analysis of these fields, see Appendix B: “Module G Lookup Tables”.

**The Main Tab**

If the **Main** tab is not currently displayed, click on the **Main** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 179.

![Figure 179: Audit Project Set-up Screen, Main Tab](image)

The top area of the Main tab contains the two required fields for defining a project.
Required Fields

- **Project ID**—Every project must have a unique ID. The ID field is alphanumeric, so you can identify your projects with any combination of letters and/or numbers. Most audit departments use a convention of the last two digits of the plan year, a hyphen, and a sequential number representing the sequence of the audit on the plan. For non-audit administrative projects, most departments use the alpha name of the activity, like Training, Vacation, Sick Time, etc.

- **Plan Year**—Every project must have an associated plan year.

All of the remaining fields on the tabs are optional. Your department must evaluate which, if any, of these fields to use.

Main Tab Scrolling List Boxes

The following scrolling list box fields are present on the **Main** tab. All possible entries necessary to describe projects must be entered in the corresponding Module G tables before they can appear when the user clicks the arrow in the scrolling list box:

- **Auditable entity**—the entity being audited. When the user clicks the scrolling list box, a list of all entities defined in the audit universe is displayed.

- **Business division**—when the auditable entity is selected, the business division to which it is assigned on the Auditable Entity Profile screen appears. If no entry was made in the business division field on that screen, the field is blank. When the user clicks the scrolling list box, a list of all business divisions defined in Module G, Tab A appears. Users can overwrite the automatic entry with a different business division if necessary.

- **Project type**—when the auditable entity is selected, the typical project type populated on the Auditable Entity Profile screen appears. If no entry was made in the typical project type field on that screen, the field is blank. When the user clicks the scrolling list box, a list of all business divisions defined in Module G, Tab A appears. Users can overwrite the automatic entry with a different project type if necessary.

- **Project status**—represents the status or state of the audit at a particular point in time. Project managers should frequently update this field as the audit progresses in order for the field value to be meaningful.

- **Overall rating**—typically used at the end of the audit to give the audit an overall score summarizing the severity of findings.
Module B - Fields on the Project Set-up

- **Project source**—represents the process that determined the necessity for the audit, or the party who requested the audit. Examples include the audit committee, rotation plan, and annual risk assessment.

- **Project priority**—represents the priority of this audit as contrasted to all other planned audits for the year. If the project was created as part of the risk assessment and annual audit planning process in Module A, if the **project priority** was specified, it is automatically populated here. Users can overwrite the automatic entry with a different project priority if necessary.

- **Planned time of year**—represents the month, quarter, or other time of year in which the audit is scheduled. If the project was created as part of the risk assessment and annual audit planning process in Module A, if the **planned time of year** was specified, it is automatically populated here. Users can overwrite the automatic entry with a different **planned time of year** if necessary.

**Main Tab Text Boxes**

- **Audit title**—holds the title of the audit as it should appear in the engagement letter and audit report. When the auditable entity is selected for the project, the **entity long name** field value as populated on the Auditable Entity Profile screen appears. If no entry was made in the **entity long name** field on that screen, the field is blank. Users can overwrite the automatic entry with a different **audit title** if necessary.

- **Report addressed to**—holds the individual name(s) of individuals at the auditee who should receive the audit report.

- **Project source description**—holds a detailed explanation of the project source entry

- **Comments**—holds any miscellaneous comments about the project.

**Main Tab Attachment Fields**

- **File attachments, if any**—holds file one or more file attachments related to the project. If the audit report is generated or exported outside of Audit Leverage, it is a good idea to attach it into this field. This field is not designed to hold audit workpapers, which are stored in a Module C, File Attachment Index.

**The Staffing Tab**

Click on the **Staffing** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 180.
Staffing Tab Scrolling List Boxes

- **Name**—auditor name assigned to the project. The list displayed includes all auditors in the audit staff table, Module F.
- **Role**—role of the auditor on the project. This list is pre-set and is not customizable in Module G.
- **Site**—the location where the auditor works

Staffing Tab Text Boxes

- **Begin date**—the start date of the auditor’s assignment to the project.
- **End date**—the end date of the auditor’s assignment to the project.
Module B - Fields on the Project Set-up

The Sign-offs Tab

Click on the **Sign-offs** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 181.

![Audit Project Set-up Screen, Sign-offs Tab](image)

**Figure 181: Audit Project Set-up Screen, Sign-offs Tab**

**Sign-off Tab Scrolling List Boxes**

- **Auditor**—the name of the auditor assigned as either preparer or reviewer of the project. Only auditors without a departure date in the Module F audit staff table are displayed in the scrolling list box.

**Sign-offs Tab Text Boxes**

- **Reviewer Comments**—holds any comments reviewers enter about the project prior to applying their sign-offs.
The Program Set-up Tab

Click on the Program Set-up tab. The screen view changes to reflect the tab’s fields, as shown in Figure 182.

![Figure 182: Audit Project Set-up Screen, Program Set-up Tab](image)

The Program Set-up tab contains three smaller tabs—Program, Details, and Sign-Offs.

The Program Tab

If the Program tab is not currently displayed, click on the Program tab. The screen view changes to reflect the tab’s fields, as shown in Figure 183.
Module B - Fields on the Project Set-up

Figure 183: Audit Project Set-up Screen, Program Set-up Tab - Program Tab

Scrolling List Boxes

- **Cycle, Subcycle, Task**—A three-part naming convention for audit programs within a project. One, two, or all three fields can be used to name the program and describe the exact area or process being audited.

  The cycle field is used to describe the area or process to be covered by an audit program. In describing the audit program, it serves as the name of the program. A subcycle is a second level of description and naming for a program. If the cycle name is not specific enough, you can choose to enter a subcycle to further describe it. A task is a third level of description for an audit program; essentially a sub-subcycle. It is the third level of the three-part naming convention. Despite its name, the task field does not hold specific audit step information. It is the third part of the name of the program.
For example, imagine you have two distinct audit programs that deal with product delivery. One deals with planning and scheduling, and the other, procurement. The two programs' steps are different, so you want to keep them in separate programs while still indicating that they both relate to product delivery.

- The first program is identified by the cycle *product delivery*, subcycle *planning and scheduling*.
- The second program is identified by the cycle *product delivery*, subcycle *procurement*.
- In both cases, the task field is populated with an N/A, because the task field is not needed to further describe each program.
- In each case, the cycle-subcycle-task field combination creates a “name” for the program.
- All findings, workpapers, and review notes that emerge from performing audit steps in the program are categorized by the cycle, subcycle and task fields. Therefore, you can perform aggregate data analysis on audit history based on cycle, subcycle and task.

- **Template Name**—refers to the audit program template to be copied and used for the program described by the cycle-subcycle-task field combination. Templates are stored in Module C, Program Template Library.
- **Risk Rating**—can be used either pre- or post-audit. Used pre-audit, the risk rating can signify the anticipated risk exposure in the area or process described by the cycle-subcycle-task field combination. Used post-audit, the risk rating field captures the risk exposure observed in that area or process during the audit. The entries in this scrolling list box come from the same table as the project overall rating field on the Main tab of Project Set-up.
- **Auditor**—the name of the auditor primarily in charge of performing or overseeing the performance of the audit program during the project. Only auditors without a departure date in the Module F audit staff table are displayed in the scrolling list box.

**Text Boxes**

- **Order**—designed to hold a number signifying the order of the program in the list of programs to be performed during the audit. In some cases, the order field affects the order in which findings are displayed on the audit report.
- **Comments**—holds any comments an auditor or project manager may want to enter.
Module B - Fields on the Project Set-up

Details Tab

Click on the Details tab. The screen view changes to reflect the tab’s fields, as shown in Figure 184.

Figure 184: Audit Project Set-up Screen, Program Set-up Tab - Details Tab

Text Boxes

- **Pre-fieldwork assessment**—If your department conducts project-level risk assessment, this field can hold the results of risk analysis performed for every area or process described by the cycle-subcycle-task field combination.

- **Post-fieldwork assessment**—This field can hold text describing the actual risks observed when auditing the area or process described by the cycle-subcycle-task field combination.
Sign-offs Tab

Click on the **Sign-offs** tab. The screen view changes to reflect the tab's fields, as shown in Figure 185.

![Figure 185: Audit Project Set-up Screen, Program Set-up Tab - Sign-Offs Tab](image)

**Scrolling List Boxes**

- **Auditor**—the name of the auditor assigned as either preparer or reviewer of the project. Only auditors without a departure date in the Module F audit staff table are displayed in the scrolling list box.

**Text Boxes**

- **Reviewer Comments**—holds any comments reviewers enter about the project prior to applying their sign-offs.
Module B - Fields on the Project Set-up

The Milestones Tab

Click on the Milestones tab. The screen view changes to reflect the tab’s fields, as shown in Figure 186.

Milestones Tab Text Boxes

Each of the fields on the Milestones tab is designed to hold the date on which the project milestone is either planned or reached. Certain date fields hold additional significance in Audit Leverage:

- **The Engagement Letter - actual** date appears in some engagement letter formats, as well as in the Module B Project Status Summary report.
- **The Entrance Conference** date appears in the Module B Project Status Summary report.
• The **Start of Field Work planned** date appears in some engagement letter formats. The **Start of Field Work actual** date appears in the Module B Project Status Summary report.

• The **End of Field Work planned** date appears in some engagement letter formats. The **End of Field Work actual** date appears in the Module B Project Status Summary report.

• The **Exit Conference** date appears in the Module B Project Status Summary report.

• The **Report (draft) actual** date appears in the Module B Project Status Summary report.

• The **Manager Review (final)** date appears in the Module B Project Status Summary report.

• The presence of a **Report (final) actual** date causes findings to become read-only - findings can no longer be created, edited, or deleted.

• The **Report (final) actual** date appears in the Module B Project Status Summary.

• The **Response Received planned** date appears in the Module B Project Status Summary report.

• The **Response Received actual** date appears in the Module B Project Status Summary report.

• A date in the **Closed by Director** field means auditors can no longer charge time to the project.

• If a project has a **Report (final) actual** date, but has no entries in the **Response Received (actual)** and **Closed by Director** fields, the project appears in the Late Management Response query in Module E.

**The Background Tab**

Click on the **Background** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 187.
Module B - Fields on the Project Set-up

Figure 187: Audit Project Set-up Screen, Background Tab

Background Tab Text Boxes

The Background tab text box holds background information on the overall audit, such as reasons why the department felt it important to conduct the audit. The Background tab can be used to provide helpful information to the audit team members, such as specific directions to team members or other “FYI” information.

The Objective Tab

Click on the Objective tab. The screen view changes to reflect the tab’s fields, as shown in Figure 188.
Objective Tab Text Boxes

The Objective tab text box holds general statements capturing the goals and desired accomplishments of the audit as a whole, across all cycles or processes examined and all audit programs conducted.

The Scope Tab

Click on the Scope tab. The screen view changes to reflect the tab's fields, as shown in Figure 189.
Module B - Fields on the Project Set-up

Figure 189: Audit Project Set-up Screen, Scope Tab

Scope Tab Text Boxes

The Scope tab text box holds an explanation of the boundaries of the audit as a whole, including areas to be reviewed, procedures to be conducted and the time period under review.

The Branches Visited Tab

Click on the Branches Visited tab. The screen view changes to reflect the tab’s fields, as shown in Figure 190.
The Branches Visited tab allows you to further break down a complex entity involving multiple sub-entities. Depending on the nature of the entity, sub-entities may be physical locations, subdepartments, or responsibility centers.

While the entity is the focus of the audit report, some audit departments also keep track of the sub-entities visited or examined during the audit. Designating the sub-entities helps in tracking the frequency with which they are included in audits. Reporting on Branches Visited is available through the Branches Visited query. This query can be generated from either the main Module B screen, or through the Search Your Database (SYD) tool.

**Branches Visited Scrolling List Boxes**

- **Company**—The Company column allows you to associate the sub-entity to the part of the organizational hierarchy to which it belongs.
Module C - Fields on the Audit Program

- **Branch, Facility, Location**—The **Branch**, **Facility**, and **Location** scrolling list boxes are used to represent the sub-entities. These values can be used in a hierarchical fashion or can be used independently. One paradigm involves viewing the **Branch** as the sub-entity, the **Facility** as an organization within the Branch, and the **Location** as a specific person, place, or function within the facility. One, two or all three fields can be used depending on the detail and reporting requirements of the audit department. Ultimately, the interpretation and meaning of these columns is up to the audit department to determine within its own audit universe.

**Branches Visited Tab Text Boxes**

- **Comments**—The comments field holds any auditor comments related to the portion of the audit conducted at the branch-facility-location.

Module C - Fields on the Audit Program Collection Screen

The following sections cover the fields on the **Audit Program Collection** screen. For a further analysis of these fields, see **Appendix B: “Module G Lookup Tables”**.

**The Top Area of the Audit Program Collection Screen**

The top area of the screen contains fields for selecting and identifying the program for which you want to view audit steps. It also includes filtering checkboxes, a print button, and shortcuts to findings and review notes, as shown in Figure 191.
### Scrolling List Boxes

- **Audit Program Collection For**—Used to select the Project ID for which you want to view or create program steps.
- **Cycle**—Used to select the cycle/subcycle/task combination representing the program whose steps are displayed in the tabbed area of the screen.
- **Program Section Filter**—Used to filter the tabbed area to display only those steps belonging to a certain section of the audit program.

### Checkboxes

- **Show included steps only?**—If certain program steps have the *Perform for this audit* checkbox left unchecked, this filter can be used to remove them from the display.
- **Show spreadsheet view?**—When checked, the view switches to spreadsheet view; when unchecked, the view returns to the tabbed view.
Module C - Fields on the Audit Program

The remaining fields are contained on three tabs—Main, Sign-Offs and Attachments.

The Main Tab

If the Main tab is not currently displayed, click on the tab. The screen view changes to reflect the tab's fields, as shown in Figure 191.

Main Tab Required Fields

- **Audit Step Title**—Title for the audit step

Main Tab Scrolling List Boxes

- **Audit Step Status**—Captures the work status of the audit step. Statuses can be set manually, and some are updated automatically upon preparer and reviewer sign-offs.

Main Tab Text Boxes

- **Program Section**—Allows you to separate program steps into sections. Useful for longer audit programs whose steps fall into logical categories.

- **Sequence #**—Numerical sequence of the audit step in the program or program section. If more than nine steps are used within the program or program section, the sequence number should begin with a leading zero (0). You can restart step numbering within each program section, or continue sequential numbering across sections.

- **Audit Step**—Captures the explanation of the audit procedure.

- **Work Performed**—Used by the auditor to explain how he or she carried out the audit step and satisfied the procedural requirements.

Main Tab Checkboxes

- **Perform for this audit?**—When unchecked, this checkbox signifies that the particular audit step is not used in the audit. This is useful when audit program template steps are imported into a project, but not all imported steps are necessary for the particular audit.

- **Problem?**—Used to signify that some difficulty arose in the execution of the audit step, making it impossible for the auditor to fully satisfy the audit procedure requirements.
Sign-Offs Tab

Click on the Sign-Offs tab. The screen view changes to reflect the tab's fields, as shown in Figure 192.

![Audit Program Collection Screen, Sign-Offs Tab](image)

Figure 192: Audit Program Collection Screen, Sign-Offs Tab

Several fields repeat on the Sign-Offs tab, including Program Section, Audit Step Title, Audit Step Status, and Sequence #. Fields unique to this tab include the following:

**Sign-offs Tab Scrolling List Boxes**

- **Auditor**—the name of the auditor assigned as either preparer or reviewer of the project. Only auditors without a departure date in the Module F audit staff table are displayed in the scrolling list box.
Sign-offs Tab Text Boxes

- **Additional Comments from Reviewer**—holds any comments reviewers enter about the project prior to applying their sign-offs.

Attachments Tab

Click on the **Attachments** tab. The screen view changes to reflect the tab's fields, as shown in Figure 193.

![Audit Program Collection Screen, Attachments Tab](image)

**Figure 193: Audit Program Collection Screen, Attachments Tab**

Several fields repeat on the Sign-Offs tab, including **Program Section**, **Audit Step Title**, **Audit Step Status**, and **Sequence #**. Fields unique to this tab include the following:
Attachment Tab Required Fields

- **Attachment ID**—Holds a unique alphabetic, numeric, or alphanumerical identifier for the attachment. This value must be unique within the project.

- **Attachment Status**—Captures the work status of the attachment. Statuses can be set manually, and some are updated automatically upon preparer and reviewer sign-offs.

Attachment Tab Text Fields

- **Attachment Title**—Descriptive title for the attachment. If a hard copy document is referenced, the title field can include the physical location of the hard copy.

Attachment Tab Doclink Fields

- **Doclink**—Field into which the electronic file is linked or embedded. If a hard copy document is referenced, the doclink field should be left empty.

Module C - Fields on the Attachment Index Screen

The following sections cover the fields on the Attachment Index screen. For a further analysis of these fields, see Appendix B: “Module G Lookup Tables”. The Attachment Index screen is shown in Figure 194.
Module C - Fields on the Attachment

The Top Area of the Attachment Index Screen

The top area of the screen contains fields for selecting a project, and selecting the cycles for which you want to view attachments. It also includes a print button and an option to view attachments in spreadsheet view.

Scrolling List Boxes

- **Project quick search**—Used to select the project for which you want to view attachments.
- **Cycles Audited**—Read-only fields listing the cycles for which attachments exist. Click on the gray box to the left of the cycle for which you want to view or create attachments.
The Bottom Area of the Attachment Index Screen

Required Fields

• **Attachment ID**—Holds a unique alphabetic, numeric, or alphanumeric identifier for the attachment. This value must be unique within the project.

• **Attachment Status**—Captures the work status of the attachment. Statuses can be set manually, and some are updated automatically upon preparer and reviewer sign-offs.

Scrolling List Boxes

• **Cycle, Subcycle, Task**—Associated fields connecting the file attachment back to the audit program to which it belongs.

• **Audit Program Template**—The original program template from which steps were copied into the project.

• **Audit Step Title**—The title of the audit step to which the file attachment relates.

Text Fields

• **Attachment Title**—Descriptive title for the attachment. If a hard copy document is referenced, the title field can include the physical location of the hard copy.

• **Attachment Description**—Text field into which a detailed description of the attachment can be entered.

Doclink Field

• **Attachment doclink**—Field into which the electronic file is linked or embedded. If a hard copy document is referenced, the doclink field should be left empty.

Sign-Off Fields

• **Auditor scrolling list box**—the name of the auditor assigned as either preparer or reviewer of the project. Only auditors without a departure date in the Module F audit staff table are displayed in the scrolling list box.

Module C - Fields on the Findings Screen

The following sections cover the fields on the Findings screen. For a further analysis of these fields, see Appendix B: “Module G Lookup Tables”.  

422
Module C - Fields on the Findings Screen

The Top Area of the Findings Screen

The top area of the screen contains a project number scrolling list box, and a scrolling list box that allows you to filter out findings based on disposition, or reporting, status.

Required Fields

To create a unique finding, you must type or enter a value in any of the finding fields. After you begin data entry, you must also populate the **Follow-up status** on the **Management Response** tab.

All of the remaining fields on the tabs are optional. Your department must evaluate which, if any, of these fields to use.

The Main Tab

If the **Main** tab is not currently displayed, click on the **Main** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 195.
Main Tab Text Fields

- **Subheading**—You can group your findings together in the audit report by populating the Subheading field.

- **Finding sequence number**—Enter a number representing the sequence in which you wish the finding to appear in the audit report.

- **Finding title**—Title for the finding, which can appear in the Audit Leverage-generated audit report.

- **Finding text**—Explanation of the finding.

- **Recommendation**—Recommended corrective action or remedy.

- **Respondent**—Primary auditee staff responsible for responding to the internal audit department regarding implementation of the recommendation.
Module C - Fields on the Findings Screen

- **Financial Impact**—Dollar value representing the impact of implementing the proposed recommendation.

**Main Tab Scrolling List Boxes**

- **How to report**—Captures how the finding is communicated to the auditee. Default entries include dispositions such as verbal discussion, supplemental report, or final audit report. Findings must be set to the **how to report** status with the code number 60 or above in order to appear on Audit Leverage-generated audit reports.

- **Author of finding**—Audit staff member who authored the finding.

- **Cycle, Subcycle, Task**—Associated fields connecting the finding back to the audit program executed when the finding was discovered.

- **Control issue**—Audit control area to which the finding pertains. Entries in this scrolling list box can be made directly in the field. Audit Leverage adds the new entry to the list displayed when you click on the arrow.

- **Finding type**—Used to group findings into similar categories, such as operational, internal control, efficiency, system control, and others.

- **Risk severity code**—Numerical value corresponding to the degree of risk exposure associated with the finding.

- **Global vs. specific**—Used to indicate whether the finding has limited impact to a localized site or process, or to the company or organization as a whole.

- **Audit step**—Title of the audit step from which the finding emerged.

- **Attachment # and title**—Attachment ID of a workpaper file containing supporting evidence for the finding.

**Main Tab Checkboxes**

- **Repeat Finding?** Used to flag a finding if it is a recurring finding from previous audits of the entity.

**Main Tab Doclink Fields**

- **File attachments (if any), such as a chart**—Used to link or embed a summary document that supports the finding. The summary document might include information gathered from one or more file attachments or workpapers.
Sign-Offs Tab

Click on the **Sign-Offs** tab. The screen view changes to reflect the tab's fields, as shown in Figure 196.

![Figure 196: Findings Screen, Sign-Offs Tab](image)

Several fields repeat on the Sign-Offs tab, including **subheading**, **finding sequence number**, **work status**, and **finding title**. Fields unique to this tab include the following:

**Sign-offs Tab Scrolling List Boxes**

- **Auditor**—the name of the auditor assigned as either preparer or reviewer of the project. Only auditors without a departure date in the Module F audit staff table are displayed in the scrolling list box.
Module C - Fields on the Findings Screen

Sign-offs Tab Text Boxes

- **Reviewer's Comments**—holds any comments reviewers enter about the project prior to applying their sign-offs.

Background Tab

Click on the **Background** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 197.

![Figure 197: Findings Screen, Background Tab](image)

- **Background for this finding**—Explanation of the context or other background information for the finding.

Criteria & Risk Tab

Click on the **Criteria & Risk** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 198.

427
Criteria & Risk Tab Scrolling List Boxes

- Risk severity code—This is the same field that appears on the Main tab representing the degree of risk exposure associated with the finding. Updating this field updates the same field on the Main tab, and vice versa.

Criteria & Risk Tab Text Boxes

- Criteria—Explanation of the organizational or regulatory standard that applies to the finding.
- Discussion of Risk/Effect—Explanation of the implications that could result if the recommendation or remedy is not implemented.

Finding (report wording) Tab and Recommendation Tab

The fields on these tabs are the same fields as those found on the Main Tab. Updating fields on either tab updates the fields on the other tabs.
Management Responses Tab

Click on the **Management Responses** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 199.

**Figure 199: Findings Screen, Management Response Tab**

**Management Response Tab Scrolling List Boxes**

- **Agreed?**—Level of auditee agreement with the auditor’s finding and recommendation.
- **Responsible department**—Auditee department responsible for implementation of the recommendation and action plan.
- **Follow-up status**—Status of auditor follow-up required.
Management Response Tab Text Boxes

- **Management's response**—Response from the auditee management regarding the finding and recommendation.
- **Management's action plans**—Auditee management plans to remedy the situation revealed in the finding.
- **Responsible person(s)**—Name or names of those auditee staff responsible for action plan implementation.
- **Explanation of disagreement**—Nature of the auditee's disagreement with the finding and recommendation, if applicable.
- **Auditor rebuttal**—Auditor’s response to the auditee’s disagreement, if applicable.
- **Original target**—Original target date for implementation of the action plan.
- **Revised target**—Revised target date for action plan implementation, if applicable.
- **Actual date**—Actual date of completion of action plan by auditee.
- **Change history**—Detailed tracking of revised targets and reasons for revisions.

Management Response Tab Doclink Fields

- **File attachments**—Used to link or embed the document containing auditee management's response, or other reference document.

Synopsis Tab

Click on the **Synopsis** tab. The screen view changes to reflect the tab’s fields, as shown in Figure 200.
Module C - Fields on the Review Notes

Synopsis Tab Text Fields

- Brief synopsis of the finding—a summary of the finding and recommendation for population into the Audit Director’s Audit Summary report in Module D.

Module C - Fields on the Review Notes Screen

The following sections cover the fields on the Review Notes screen. For a further analysis of these fields, see Appendix B: “Module G Lookup Tables”.

The Module C Review Notes screen contains two segments. The top area of the screen contains scrolling list boxes that, when populated, filter the review note data displayed on the bottom of the screen. The bottom area of the screen contains fields for creating and viewing review notes, as shown in Figure 201.
### Scrolling List Boxes

- **Audit Project #**—Project to which the review note pertains
- **Cycle, Subcycle, Task**—Associated fields connecting the file attachment back to the audit program to which it belongs.
- **Attachment ID**—The file attachment to which the review note pertains, if applicable.
- **Audit Step Title**—The audit step to which the review note pertains, if applicable.
- **Finding Title**—The finding to which the review note pertains, if applicable.
- **Review Note Status**—Captures the work status of the review note. Statuses can be set manually, and some are updated automatically upon reviewer and recipient sign-offs.
Module C - Fields on the Review Notes

Text Boxes

• **Review Note**—Text of the message from the reviewer to the recipient regarding the review of the audit step, file attachment or finding.

• **Recipient’s response to the review note**—Recipients comments regarding the review and any action completed to answer the reviewer’s requests.

Sign-Offs

• **Auditor**—the name of the auditor assigned as either preparer or reviewer of the project. Only auditors without a departure date in the Module F audit staff table are displayed in the scrolling list box.
Glossary

Back-end database

The back-end database contains all the raw data that your department has added to Audit Leverage. It has no user interface and looks like any other Access database. The back-end database should be opened only by your department’s Audit Leverage administrator (except to resolve data conflicts and errors). Regular users should instead access the data via the front-end database.

Design Master

The design master is a back-end database which is just like any other full replica. There is only one design master, which is maintained on a computer at IAD Solutions. The only difference between the design master and a regular replica is that the design master is the only place where design changes (also known as schema changes) can be made to the back-end. Such design changes include adding new tables, adding new fields to an existing table, or changing the field size.

It should be noted that because only the back-end, not the front-end, is replicable, there is no such thing as a design master for the front-end. For this reason, you can make any design changes in any copy of the front-end (if your administrator has given the appropriate permissions to your Audit Leverage user name), but these changes cannot be synchronized with other copies of the front-end.

The front-end does not typically contain any permanent data, but if you want to create an additional table, you must do so in the front-end rather than in the back-end. Also, you can create additional objects in the front-end, such as your own custom queries, reports, and forms.

Dial-up

User is connected via a modem to the Network.
The important distinction is whether or not a user is connected through the LAN. LAN connection allows two things:

direct synchronization between your hard drive and the unmanaged back-end on the network.
direct “live” linking to the unmanaged back end on the network. If you are connected to the network in a way other than a WAN, you must connect to Local hard drive database and perform an indirect synchronization (if available). If you are not connected to the network at all, you must work on your local hard drive database and cannot synchronize.

**Direct synchronization**

Synchronization that occurs while both parties (central database and replicated database) are “live” and available to communicate to one another. In Microsoft Access, direct synchronization is most reliable when the central database and the replicated database are connected on the same local area network (LAN). Phone dial-up connections and wide area network connections (WANs) are not reliable for direct synchronizations of Access applications and can cause data corruption. Note also that not the entire database is sent over the communication line; rather, only those specific records of data that have been added, changed, or deleted since those two specific replicas were last synchronized.

**Drop box**

This is a publicly shared directory associated with the synchronizer, used for indirect synchronization. All incoming and outgoing changes from the database are sent to and received from the drop box. Similar to a regular mail box.

**External Schedule**

Microsoft Replication Manager provides a graphical interface that enables the user to set synchronization schedules. The external schedule is the scheduled synchronizations between the managed replicas of that manager and an accessible unmanaged replica. Intervals can be up to every 15 minutes 24x7.

**Farm**

The farm resides on the server only. The farm is a term used for a pool of replicas that are “managed” by the server’s synchronizer. When Audit Leverage is installed, it generally sets up a farm with three replicas. The farm is used for indirect replication from a remote user to the network. Also, the farm has a self-correcting feature, so that if one of the three replicas becomes unavailable for synchronization, the other two replicas can “fix” the first replica.
synchronizer which manages the farm’s three replicas can have two types of schedules:

- one “internal schedule,” which determines when and how frequently the three farm replicas synchronize with one another
- an external schedule, which determines when and how frequently the farm (collectively) synchronizes with the unmanaged network database.

**Finding**

Exceptions and all other associated information, such as a recommendation, criteria and risk, management responses, and other related data that result from an audit program.

**Front-end database**

The front-end contains Audit Leverage’s graphical user interface, the program logic, and security settings. The front-end itself contains almost no actual audit department data (unless you add your own custom tables there); rather, the front-end “talks” to (i.e., is linked to) the back-end, where the raw data resides.

**Indirect synchronization**

Synchronization which occurs without direct connection between the parties (central database and replicated database). Rather, the exchange occurs between the two synchronizers: the Microsoft Jet Synchronizer that manages the first database, and the Microsoft Jet Synchronizer that manages the second database. (There is one Microsoft Jet Synchronizer on each Audit Leverage machine, whether that machine is a laptop, desktop, or network server.)

When an indirect synchronization is initiated by a remote user, for example, the new and changed data from his or her replica is sent to the Microsoft Jet Synchronizer on that laptop. That synchronizer then communicates with the network server’s synchronizer at the next available opportunity (i.e., either when the remote user dials in to the network, or when the remote user returns to the office and connects to the LAN). During that exchange, the laptop sends new and changed data to the server, and the server sends data which the laptop has not yet received in a previous synchronization.

**Internal Schedule**

Microsoft Replication Manager provides a graphical interface that enables the user to set synchronization schedules. Each synchronizer which manages more than one replica has an internal schedule. For Audit Leverage, this schedule determines how often the farm replicas are synchronized with each other.
Synchronization intervals can be up to every 15 minutes, 24 hours/day, 7 days/week.

**LAN**

Local Area Network

**Latency**

Time delay between data updates. Mainly refers to indirect synchronization. Maximum latency can be represented by

\[ S_I + S = L_m \]

where \( L_m \) is the maximum latency, \( S_I \) is the internal synchronization frequency of the farm in Replication Manager and \( S \) is the synchronization frequency between the farm and the unmanaged network back-end.

In the following example, the three farm replicas synchronize with each other every 15 minutes (the “internal schedule”), and the farm synchronizes with the unmanaged replica every one hour on the hour (the “external schedule”).

Alice, performing an audit at a remote site, makes a change to an audit finding, dials in to the network with her laptop, and initiates an indirect synchronization which is completed at 12:05 p.m. At this point, only one of the three replicas in the forms knows about the change. At 12:15 p.m., the internal schedule kicks in, so that all three of the replicas know about the change. Bob, another remote user, dials in to the network at 12:20 and performs an indirect synchronization. He sees all of Alice’s changes.

A third auditor, Kevin, is in the office all day and has decided to be directly connected to the unmanaged network database all day. Kevin does not learn of either Alice’s or Bob’s work until the next scheduled synchronization between the farm and the unmanaged network back-end, which is 1:00 p.m.

**Local Hard Drive back-end database**

This file, which is called “RepBE.mdb” and resides in a directory called RepBE, is a replica of the unmanaged network back-end. It allows the user to work from his or her hard drive vs. the network drive. This is a MUST when not directly connected to the Network over a LAN. Also, if the network is very slow, a user can choose to work locally, even if he or she is connected to the network. The disadvantage is that changes are not reflected in the network database until both of the following occur:

- The user performs an on-demand indirect synchronization (using the Synchronize button from the Welcome Screen)
• After this indirect synchronization, the farm’s data is up-to-date, but any users connected to the network’s unmanaged replica do not see the new data until the next scheduled synchronization between the farm and the unmanaged replica, which can be set by your system administrator and is typically every 15 minutes (see Latency).

**Manual synchronization**

Synchronization process initiated by the user (via the Synchronize button on the Welcome Screen). In contrast, an automatic synchronization (direct) is performed by Audit Leverage automatically (up to once per day) when a user connects to the Network back-end database.

**Microsoft® Jet**


**Offline**

User machine is not connected to the network in any way.

**Online**

User machine is connected to the network via a LAN.

**Permissions**

There are two types of permissions:

• Network permissions: Access rights of a particular network user (or network group of users) to perform certain operations in a shared directory (see Shares). Such access rights can include read-only, read-write, create, execute, and several combinations thereof. Network permissions are relevant to Audit Leverage in part because each auditor must have read-write permissions to certain directories on the network in order for Audit Leverage to function properly.

• Database permissions: Access rights of a particularly Audit Leverage user name (or Audit Leverage group of users) to see and do various objects comprising the Audit Leverage database. Tables, queries, forms, reports, and even the database itself all have permissions. Such access rights for a table, for example, can include read, change, insert, and delete. Each Microsoft Access database, including Audit Leverage, contains its own permissions; unlike user names and passwords, they are not stored in the system.mdw file. In the case of Audit Leverage, database permissions are determined by your Audit Leverage administrator and are completely unrelated to network permissions.
Registry keys

The registry keys can be accessed through an executable file called Regedit.exe. The keys are a way that Windows and other applications keep track of programs installed and their settings.

⚠️ Important:

You should never change registry values unless you are experienced with using the Windows registry. Incorrectly changing registry values can cause unpredictable results and may cause your applications or machine to crash.

Remote

User is not connected to the LAN, and may or may not be connected via a WAN or dial-in.

Replica

Any copy of the back-end database. See Replication.

Replica Set

A replica set contains all the databases that are replicas “spun off” from one Design Master.

Replication

The process of making one or more copies of an application’s central database for distribution to local computers. This process is usually employed when the database is not accessible at all times by all users, or this accessibility is hindered by poor connection speeds. Users who are not connected to the master network database can work on their local replicated copy to display, create, add or delete records. These copies can also serve as back-ups.

Replication Manager

Microsoft replication manager is a tool that helps in creating/moving and synchronizing replicas. It also helps in scheduling synchronizations.

Server

The network server is where the unmanaged back-end database resides and also (in the case of indirect synchronization) where the farm resides and where Microsoft Replication Manager is installed. If your audit department chooses to utilize the features of indirect replication, then Windows NT is required, rather than Novell Netware or other networking software.
Shares

Network directories that are set up by your I.T. department with permissions for specific users and/or groups to be able to access them over the network. Although shares usually exist on the network, you can also create a share on your hard drive for use in a networked environment. For example, Audit Leverage creates and utilizes a shared directory on your hard drive called C:\dropbox, which the network server uses during an indirect synchronization.

Synchronization

When a user has been working with a replicated copy of a database, he or she should periodically link to the central database to send and receive updated information. This linking, called “synchronization,” allows both databases to exchange data created, changed or deleted since the original replication. Once synchronization is complete, both databases once again contain the same information.

Synchronizer

A copy of the Microsoft Jet Synchronizer is installed on each Audit Leverage machine, whether it is a laptop, desktop, or network server. Audit Leverage uses the synchronizer to perform indirect synchronization. Microsoft Replication Manager uses the synchronizer for both direct and indirect synchronization. Replication Manager uses the synchronizer for the direct syncs that involve the farm, but not for on-demand direct syncs or automatic direct syncs, right? (Direct synchronization can be executed programmatically without requiring the Synchronizer.)

System.mdw

An encrypted file created by Microsoft Access which contains all user names, passwords, groups, and group memberships. This file does not contain the Audit Leverage permissions, which are stored as part of the front-end database.

Topology

Your company’s Network architecture and layout and, subsequently, the architecture of the various Audit Leverage back-end replicas and how they are connected together.

Unmanaged network back-end database

The unmanaged replica resides on the server but is not managed by any synchronizer; it is a replica of the back-end database that resides in the “farm” (see above). This unmanaged database serves the purpose of allowing locally connected users (LAN only, not WAN or dial-up) to connect and work from this
database. (Users should never connect the front-end directly to any of the farm replicas.)

Users can connect their front-end either to the "RepBE" replica on the hard drive, or to the unmanaged replica on the server. The advantage to using the unmanaged replica is that all data changes/additions are immediate and can be seen immediately by other users. A disadvantage of using the unmanaged replica is that it can be slow, depending on network traffic, network speed, and the number of concurrent Audit Leverage users.

**Virtual locks / Locking file**

Whenever a network or hard drive replica is being used (whether it is open directly or via a link to the front-end), Microsoft Access creates a temporary “locking file” with an .ldb extension. The locking file stores information about which users are in the process of making changes to which specific table records, so that other users are prevented from making changes to any of those same table records until the first user is finished.

The locking file is automatically deleted by Microsoft Access when that back-end database is no longer being used by anyone. On some occasions, particularly when users do not exit Audit Leverage properly by using the Exit button on the Welcome Screen, the .ldb file is not deleted, which can cause problems during certain file operations such as compacting. If this occurs, then deleting the .ldb file manually can sometimes solve the problem.

**Windows NT / Novell Netware**

Types of networking software that run servers. If your audit department utilizes the indirect synchronization features of Audit Leverage, then Windows NT is required. However, if you are using only direct replication (such as, for example, if your auditors do very little traveling), then any networking software can be used.
Index

A
Adding an attachment 262
Adding audit program steps 252
AND/OR searches in SYD 148
Approving timesheets 194, 196
Architecture 16
Attachment index 265
Attachments
   adding 262
   attachment index 265
   embedding versus linking 261
Audit director's summary report 324
Audit entities
   creating 83
   entering data 85
Audit Leverage main screen 29
Audit Program Collection
   importing steps 251
   searching for projects 243
   viewing existing steps 243
   viewing only included steps 245
Audit program collection
   audit program steps 252
   copying steps between projects 256
   creating a template from a program 254
   deleting audit steps 253
   entering information 248
   printing 247
   removing a program's template steps 251
Audit program library
   searching for templates 231
   viewing existing program steps 232
Audit program steps
   importing 127
Audit program template library 229
Audit program templates
   creating new 235
   creating steps 237
   printing 234
Audit programs
   deleting 128
   entering data 248
Audit projects
   creating 112
Audit report
   creating a cover memo 301
   customizing the cover memo 309
   exporting 308
   modifying a cover memo 306
   planning 224
   printing 308
Audit staff list 334

B
Back-end defined 16
Branches visited 139
Branches visited searches 152
Budgets
   changing 205
   creating 207
   modifying 205
   planning 99, 101
   printing 211
   searching for projects with 205
Budget-to-Actual Hours
   viewing 192

C
Changing a budget 205
Choosing a database at startup 29
Closing audit projects 141
Comparing budgeted versus actual hours 192
Comprehensive searching 146
Conducting branches visited searches 152
Conducting entity searches 150
Conducting findings searches 157
Conducting follow-up entry searches 169
Conducting management response searches 166
Conducting project searches 154
Conflict resolution 351
Conflicts
   defined 350
Conventions
   planning 46, 226
Copying a risk assessment 77
Copying findings between reports 290
Copying program steps between projects 256
Cover memos
   creating 301
   modifying 306
Creating a budget 207
Creating a new audit program template 235
Creating a review note 313
Creating a template from an audit program 254
Creating an Audit Entity 83
Creating an Audit Project 112
Creating an audit report cover memo 301
Creating an engagement letter 116
Creating audit program template steps 237
Creating audit project program steps 125
Creating management response follow-up entries 298
Creating management responses 295
Creating risk assessments 63
Creating time entries 187
Customizing the audit report cover memo 309

D
Data analysis
   planning 105
Data analysis planning 46, 225
Defining budgets 99, 101
Defining projects 98, 100
Defining risk assessment information 50
Deleting a risk assessment 76
Deleting an audit program 128
Deleting audit program steps 253
Deleting audit projects 119
Deleting findings 290
Deleting time entries 191
Deleting timesheet approvals 196
Department conventions
   planning 46, 106, 226
Determining audit frequencies 57
Drafting findings 275

E
Editing an engagement letter 119
Editing time entries 190
Effect of sign-offs 33
Embedding an attachment 261
Engagement letter
   creating 116
   editing 119
   planning 104
Entering audit program information 248
Entering audit project milestone dates 133
Entering project set-up information 112
Entering risk assessment data 65
Entering time 187
Entities
   planning 42
Entity searches 150
Error resolution 351
Errors
   defined 350
Exporting the audit report 308

F
Field names used in steps 19
Field type descriptions 19
File Attachments See Attachments
Findings
   copying between reports 290
   defined 220
   deleting 290
   drafting 275
   outstanding findings report 299
   planning 220
   searches 157
   sign-offs 281
   viewing existing 271
   viewing the screen 270
Follow-up entry searches 169
Front-end defined 16
Functionality overview 15
H
High Security
differences 34

I
Importing audit program steps 251
Index of attachments 265

L
Late management responses 299
Linking an attachment 261
Logging in at startup 21

M
Main Screen 29
Management response searches 166
Management responses
creating 295
creating follow-up entries 298
defined 222
late management response query 299
planning 222
tracking 299
tracking follow-up entries 299
viewing 293
viewing follow-up entries 296
Modem detection at startup 23
Modifying a budget 205
Modifying an audit report cover memo 306
Module G lookup tables 341
creating entries in 342
entry example 342
modifying entries in 342

N
No master database detected at startup 26

O
Outstanding findings report 299
Overview of functionality 15

P
Planning
audit frequency 57
audit reports 224
budgets 99, 101
data analysis 46, 225
defining entities 42
defining risk assessment information 50
department conventions 46, 106, 226
engagement letters 104
entity types related to risk assessment 51
findings 220
management responses 222
projects 98, 100
reporting 46, 225
reporting and data analysis 105
risk assessment scores 55
risk criteria 51
risk criteria grouping 52
risk criteria weights 55
sign-offs 103
workpaper component statuses 218
Planning budgets 99, 101
Planning projects 98, 100
Populating risk assessments 65
Printing
audit program templates 234
audit programs 247
review notes 318
search your database search criteria 149
Visual Scheduler 182
Printing a budget 211
Printing the audit report 308
Printing timesheets 200
Project
planning 98, 100
Project searches 154
Project set-up
branches visited 139
closing projects 141
creating an engagement letter 116
deleting audit programs 128
deleting projects 119
editing an engagement letter 119
entering information 112
importing program steps 127
milestones 133
program steps 125
viewing information 111
Visual Scheduler data 173

Removing template steps from a program 251
Replica 16
defined 16
Reporting 105
planning considerations 46, 225
Responding to review notes 316
Review notes 313
printing 318
responding 316
searching for 317
searching for by name 315
signing off 316
spreadsheet view 319
viewing 311
Risk assessments 65
audit frequencies 57
copying 77
defining information 50
deleting 76
entering data 65
reviewing entities 51
risk criteria grouping 52
risk criteria usage 51
risk criteria weights 55
scores 55
viewing 62
viewing summary information 75
Risk criteria grouping 52
Risk criteria usage 51
Risk criteria weights 55
Rules of sign-offs 34

S
Search for existing library templates 231
Search Your Database 143
AND/OR searches 148
branches visited searches 152
comprehensive searching 146
creating 145
entering parameters 145
entity searches 150
findings searches 157
follow-up entry searches 169
limiting entries 147
management response searches 166
multi-tab searching 146
printing 149
project searches 154
searching for blank entries 146
Searching Audit Leverage 143
Searching for a budget 205
Searching for a project with time charges 205
Searching for review notes 317
Searching for review notes by name 315
Signing off findings 281
Signing off review notes 316
Sign-off effects 33
Sign-off options 33
Sign-offs 31
findings 281
options and effect 33
planning 103
rules 34
security mode differences 34
Startup 29
choosing a database 29
if modem detected 23
if no modem detected 25
logging in 21
no master database detected 26
synchronizing 27
Summary risk assessment information 75
SYD See Search Your Database
Synchronization
after removing conflicts and errors 364
defined 18
Synchronizing at startup 27
System architecture 16

T
Time entries
creating 187
deleting 191
editing 190
Time summaries
types 198
viewing 198
Timekeeping
approving timesheets 194, 196
creating entries 187
deleting entries 191
deleting timesheet approvals 196
editing entries 190
timesheet approval restrictions 194
viewing budget-to-actual hours 192
viewing time summaries 198
Timesheets
approval restrictions 194
approving 194, 196
deleting approvals 196
printing 200
Tracking follow-up entries 299
Tracking management responses 299
Types of fields 19
Types of time summaries 198

V
Viewing budget-to-actual hours 192
Viewing existing audit program steps 232
Viewing existing findings 271
Viewing included program steps 245
Viewing late management responses 299
Viewing management response follow-up entries 296
Viewing management responses 293
Viewing program steps 243
Viewing project set-up information 111
Viewing review notes 311
Viewing risk assessments 62
Viewing the findings screen 270
Viewing time summaries 198
Visual Scheduler 171
    adding assignments 177
    modifying assignments 179
    moving assignments 179
    printing 182
    setting view options 181
    Site/Place labels 173
    source of data 173
    viewing 171

W
Work method choices 17
Working with attachments
Workpaper component status planning 218